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1 Introduction

As one of the various functions of the Qurm Environmental Information Center (QEIC), it is
expected that the QEIC would be a center for training programmes related to mangrove
ecosystem conservation.

The targeted trainees will be the staff of the QEIC (Qurm Environmental Information Center),
the Ministry of Environment and Climate Affairs (MECA), research organizations, schools,
NGOs, local communities and private sectors.

Since the training course will consist of various topics and target groups, the trainers (i.e.
lecturers) would be not only the QEIC staff but also be recruited from available local human
resources (e.g. university professor, expert from other ministries).

The contents of the training course, therefore, shall be shared within the trainers to
understand the contents of the training course. This material was prepared based on the
viewpoint mentioned above.

Each training course consists of several modules, and information regarding each training

course are described through following.

- List of training courses: general information about the training course, including the

course title, target group, learning goal, location, duration,

number of module and lecturer

- List of module and material of each training course: break down of each training course,

including the contents of each module, location duration and

contents of training material

- Outline of training course: outline of the training course

- Trainer's manual: procedures and methods of the training course, which are referred by

the trainer

- List of training material: list of document materials to be used by trainer to explain the

details on the training course
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2 List of training course 

Traning courses are listed in the Table 1, including the course title, target group, learning goal, location, duration, number of module and lecturer. 

Table 1 List of training course 

Category Course title 

Target Group 

Learning Goals 

Location 
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Field
 

I General 

1. Function of QEIC x x x x x x 
To introduce activities, facilities and equipment of QEIC, as well as 

case studies of similar institutions. 
x  1.5 6 Q 

2. Introduction on mangrove ecosystem  x x x x x x 
To obtain a basic understanding on mangrove ecosystem, 

importance of conservation and the various threats.  
x x 1.0 2 Q 

II Monitoring 

1. Introduction on Mangrove Ecosystem 

Monitoring Program 
x  x x x 

To learn how to monitor and assess the status of mangrove 

ecosystem.  
x x 4.0 4 Q, E 

2. Introduction on mangrove health assessment 

using remote sensing 
x  x   

To learn how to monitor and assess mangrove forest health with 

remote sensing technology. 
x x 3.0 3 Q, E 

3. Introduction on Transplanted-seedling 

Monitoring Program  
x  x x x 

To learn how to monitor the growth and health status of transplanted 

seedling. 
x x 1.0 2 Q 

III Plantation 1. Method of mangrove tree plantation x   x x x 

To learn necessary processes for mangrove tree plantation such as 

site selection, seed collection/treatment, nursery operation and 

transplanting procedure. The course also covers landownership issues 

for plantation. 

x x 3.0 4 Q 

IV Protection 
1. Introduction on mangrove ecosystem 

protection 
x   x x x 

To learn practical and regulatory measures to protect mangrove 

ecosystem. 
x  0.5 1 Q 

V Database 1. Introduction of QEIC database x      To learn the structure and how to use QEIC database. x  0.5 1 Q 

VI Education 
1. Producing education materials x   x   To learn how to produce education materials. x  2.0 7 Q 

2. Implementing education programs x   x   To learn how to implement education programs. x x 1.0 2 Q 

VII Exhibition 1. Introduction of QEIC exhibition x   x   

To learn about the QEIC exhibition, as well as methods to enhance 

visitors understanding. The course also introduces examples of other 

similar exhibitions.  

x  0.5 3 Q, E 

E: Expert from outs E: Expert from outside organization, Q: QEIC staff (incl. MECA staff) 

Prepared by JICA Expert Team 
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3 List of module and material of each training course 

List of module and material of each training course is shown in Table 2. Break down of each training course, including the 

contents of each module, location duration and contents of training material are summarized in the table. 

Table 2 List of module and material of each training course 

 

Category Course title 

Module Lo
catio

n
 

D
u

ra
tio

n
 (d

ay) 

C
o

n
ten

ts o
f th

e
 

m
aterial 

No Mode Contents 

I General 

1. Function of QEIC 

1 
Lecture   Introduction of QEIC functions and 

activities 
Lecture room 0.2 PPT 

2 
Lecture  Introduction of case studies of similar 

institutions in the world 
Lecture room 0.3 PPT 

3 Lecture Introduction of facilities of QEIC Lecture room 0.2 PPT 

4 
Quick tour:  Visual tour of facilities, mangrove nursery 

and Qurm Nature Reserve 
QEIC, QNR 0.3 DM 

5 

Tour Laboratory tour 

Lecture room,  

laboratory 
0.2 PPT 

Lecture Detailed introduction of the laboratory, 

equipment and available parameters, 

necessary maintenance 

6 

Tour Introduction of field equipment 

Lecture room, storage 0.3 PPT Lecture:  Detailed introduction of the field 

equipment, necessary maintenance 

2. Introduction on 

mangrove ecosystem 

1 Lecture Introduction on mangrove ecosystem Lecture room 0.5 PPT 

2 Field visit Observation of mangrove ecosystem Field 0.5 DM 

II Monitoring 

1. Introduction on 

mangrove ecosystem 

monitoring program 

1 
Lecture Introduction on mangrove ecosystem 

monitoring program 
Lecture room 0.5 PPT 

2 Practice Monitoring of mangrove Field & Lecture room 0.5 GL 

3 Practice Monitoring of fauna Field & Lecture room 1.5 GL 

4 Practice Monitoring of environmental condition Field & Lecture room 1.5 GL 

2. Introduction on mangrove 

health assessment using 

remote sensing 

1 
Lecture Introduction on mangrove health 

assessment using remote sensing 
Lecture room 0.5 PPT 

2 
Practice Mangrove health assessment using image 

processing software 
Lecture room 2.0 GL 

3 Practice Field verification Lecture room 0.5 GL 

3. Introduction on 
“Transplanted-seedling 
Monitoring Program” 

1 
Lecture Introduction on “Transplanted-seedling 

Monitoring Program” 
Lecture room 0.5 PPT 

2 Practice Monitoring of seedling growth and health Field & Lecture room 0.5 GL 

III Plantation 
1.  Method of mangrove tree 

plantation 

1 
Lecture Significance of mangrove plantation and 

selection of suitable site 
Lecture room 1.0 PPT, GL 

2 
Lecture & 

practice 

Seed collection methods and treatment of 

collected seeds 
Field & Lecture room 0.5 DM, PPT. GL 

3 
Lecture & 

practice 

Operation of nursery for proper seedling 

production 
Field & Lecture room 0.5 DM, PPT, GL 

4 
Lecture & 

practice 

Transplanting procedure and maintenance 

of planted trees 
Field & Lecture room 1.0 DM, PPT, GL 

IV Protection 
1. Introduction on mangrove 

ecosystem protection 
1 Lecture 

Introduction on mangrove ecosystem 

protection 
Lecture room 0.5 PPT, GL 

V Database 
1. Introduction of QEIC 

database 
1 Lecture 

Introduction of database available in the 

QEIC 
Lecture room 0.5 PPT 

VI Education  1. Producing education 1 Lecture Different type of education materials Lecture room 0.2 PPT 
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Category Course title 

Module Lo
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n
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aterial 

No Mode Contents 

materials 
2 

Lecture & 

discussion 

Necessary contents of education materials 

for environment education of mangroves 

and mangrove ecosystem 

Lecture room 0.4 PPT, discussion 

3 
Lecture & 

practice 

Preparation of education materials 
Lecture room 0.4 practice 

4 
Lecture Factors to be considered in designing 

education programs 
Lecture room 0.2 PPT 

5 
Lecture Goals of education programs and suitable 

education materials to be used 
Lecture room 0.2 PPT 

6 
Lecture and 

Practice 

Preparing activity sheet of the education 

program 
Lecture room 0.4 practice 

7 
Lecture and 

Practice 

Evaluation of the education program 
Lecture room 0.2 PPT, practice 

2. Implementing education 

programs 

1 
Lecture & 

practice 

How to use education materials to 

implement education programs 
Lecture room 0.3 PPT, practice 

2 
Lecture & 

practice 

How to implement education programs 

based on the activity sheet 
Lecture room 0.7 practice 

VII Exhibition 
1. Introduction of QEIC 

exhibition 

1 
Lecture Importance of story line in designing 

exhibition plan 
Lecture room 0.2 PPT 

2 
Lecture & 

practice 

Preparing work sheet on exhibition articles 
Lecture room 0.2 PPT, practice 

3 
Lecture & 

discussion 

Lessons learnt from other organization 
Lecture room 0.1 PPT, discussion 

 

Note: PPT: Microsoft Power Point material, DM: Document material, GL: Guideline 
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4 Outline of training program

Outline of each training course, including the course title, objectives of the training, expected

output, expected participants, trainers, syllabus (training modules), schedule and necessary

equipment, are summarized in a table respectively.
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Outline of Training Course
1. Course Title:

Function of QEIC

2. Objectives of the Course

This training course aims to introduce the trainees of activities and function of the QEIC, case studies of

similar institutions in the world and to introduce facilities of QEIC, including laboratory, equipment,

mangrove nursery and Qurm Nature Reserve.

3. Expected Output (skills to be acquired by participants)

By the end of this training course, participants should;

 understand the functions and activities of the QEIC,

 understand world trend of similar institutions, and thus grasp brief idea for nature

conservation for further dissemination to those who are interested.

 understand world trend of similar institutions, and thus grasp brief idea for nature

conservation for further dissemination to those who are interested.

 understand facilities in QEIC, Qurm Nature Reserve, function of the laboratory, available field

and laboratory equipment, and necessary maintenance of the equipment

4. Expected Participants (minimum required level for entry if any)

All targeted groups

5. Trainers

QEIC Staff

6. Syllabus

Module 1

Module 2

Module 3

Module 4

Module 5

Module 6

Lecture : Introduction of QEIC functions and activities (0.2day)

Lecture : Introduction of case studies of similar institutions in the world (0.3day)

Lecture : Introduction of facilities of QEIC

Quick tour: Visual tour of facilities, mangrove nursery and Qurm Nature Reserve

Tour: Laboratory tour

Lecture: Detailed introduction of the laboratory, equipment and available parameters,

necessary maintenance

Tour: Introduction of field equipment

Lecture: Detailed introduction of the field equipment, necessary maintenance

7. Schedule

Module 1 : anytime (duration: 0.2 day)

Module 2 : anytime (duration: 0.3 day), however, the course title "Function of QEIC" shall be conducted

in advance.

Module 3: anytime (duration: 0.2day)

Module 4: anytime (duration: 0.3day)



Technical Document 1  Training plan and materials

I-1 Function of QEIC

7

Module 5: anytime (duration: 0.2 day)

Module 6: anytime (duration: 0.3 day)

8. Equipment prepared or brought by participants (if any)
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Outline of Training Course
1. Course Title:

Introduction on mangrove ecosystem

2. Objectives of the Course

To obtain a basic understanding on mangrove ecosystems

3. Expected Output (skills to be acquired by participants)

By the end of the course, participants should understand;

 Mangrove diversity and distribution

 How mangroves are adapted to saline and anoxic conditions

 About Avicennia marina

 Reproduction strategies of mangroves

 Common fauna in mangrove ecosystem including their habitat, diet

 Food chain of mangrove ecosystem

 The importance of mangrove ecosystem

 Threats to mangrove ecosystem

4. Expected Participants (minimum required level for entry if any)

All target groups

5. Trainers

QEIC staff

6. Syllabus

Module 1 Lecture : Introduction on mangrove ecosystem (0.5 day)

Module 2 Field visit : Observation of mangrove ecosystem (0.5 day)

7. Schedule

Duration: 1 day, Frequency: 1-2/year (preferably during bird migratory season)

8. Equipment prepared or brought by participants (if any)

Clothes for suitable for field observation
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Outline of Training Course
1. Course Title:

Introduction on Mangrove Ecosystem Monitoring Program

2. Objectives of the Course

To understand the monitoring methods of mangrove ecosystems

3. Expected Output (skills to be acquired by participants)

By the end of the course, participants should understand;

 The objective of monitoring

 How to monitor and assess the health of mangrove tree

 How to collect and identify fauna and monitor indicator species

 How to monitor environmental conditions (water quality, soil quality, topography, water level)

 To understand common natural and human threats to mangrove ecosystem

 How to manage monitoring data

4. Expected Participants (minimum required level for entry if any)

QEIC/MECA staff, students, NGO, local community

5. Trainers

QEIC staff

6. Syllabus

Module 1 Lecture : Introduction on mangrove ecosystem monitoring program (0.5 day)

Module 2 Practice: Monitoring of mangrove (0.5 day)

Module 3 Practice: Monitoring of fauna (1.5 day)

Module 4 Practice: Monitoring of environmental condition (1.5 day)

7. Schedule

Duration: 4 days, Frequency: 1/year (preferably during winter)

8. Equipment prepared or brought by participants (if any)

Clothes suitable for field work
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Outline of Training Course
1. Course Title:

Introduction on mangrove health assessment using remote sensing

2. Objectives of the Course

To learn how to monitor and assess mangrove forest health with remote sensing technology.

3. Expected Output (skills to be acquired by participants)

By the end of the course, participants should understand;

 How to delineate and estimate surface area of mangrove forest

 How to calculate NDVI values of mangrove forest

 How to calculate changes in NDVI values of mangrove forest

 How to interpret the results through field verification

4. Expected Participants (minimum required level for entry if any)

QEIC/MECA staff, students (have basic skills in using image processing software such as ENVI)

5. Trainers

QEIC staff, Remote sensing expert

6. Syllabus

Module 1 Lecture : Introduction on mangrove health assessment using remote sensing (0.5 day)

Module 2 Practice: Mangrove health assessment using image processing software (2 days)

Module 3 Practice: Field verification (0.5 day)

7. Schedule

Duration: 3 days, Frequency: 1/year

8. Equipment prepared or brought by participants (if any)

Clothes suitable for field work
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Outline of Training Course
1. Course Title:

Introduction on “Transplanted-seedling Monitoring Program”

2. Objectives of the Course

To understand monitoring methods of transplanted seedling

3. Expected Output (skills to be acquired by participants)

By the end of the course, participants should understand;

 The objective of monitoring

 How to measure seedling growth

 How to monitor seedling health

 Potential factors that could affect seedling growth and health

4. Expected Participants (minimum required level for entry if any)

MECA staff, students, NGO, local community

5. Trainers

QEIC staff

6. Syllabus

Module 1 Lecture : Introduction on “Transplanted-seedling Monitoring Program” (0.5 day)

Module 2 Practice: Monitoring of seedling growth and health (0.5 day)

7. Schedule

1 day, preferably during transplantation season

8. Equipment prepared or brought by participants (if any)

Clothes suitable for field work
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Outline of Training Course
1. Course Title:

Method of Mangrove Tree Plantation

2. Objectives of the Course

This training course is prepared for the practical mangrove plantation procedures in the field level

including seed collection and treatment, seedling production and transplanting in the selected

locations.

3. Expected Output (skills to be acquired by participants)

By the end of this training course, participants should;

 understand the significance and present situation of mangrove plantation and the suitable

criteria for the selection of general plantation site and specific planting area,

 understand the general characteristics of mangrove seeds and the method of seed collection

along with the treatment and storage method of collected seeds,

 understand the preparation of pot and sowing method along with the nursery design and

irrigation system for proper seedling production, and

 understand the procedure for transplanting of produced seedlings and the maintenance of

planted trees.

4. Expected Participants (minimum required level for entry if any)

QEIC/MECA Staff and selected NGO members

5. Trainers

QEIC Staff

6. Syllabus

Module 1 Lecture : Significance of mangrove plantation and selection of suitable site (1 day)

Module 2 Lecture and Practice : Seed collection methods and treatment of collected seeds (0.5

day)

Module 3 Lecture and Practice : Operation of nursery for proper seedling production (0.5 day)

Module 4 Lecture and Practice : Transplanting procedure and maintenance of planted trees (1 day)

7. Schedule

Duration: 3 days in total, Frequency: 1/year

Module 1: 1 day before seed production period (June/July)

Module 2+3 : 1 day during seed production period (August/September)

Module 4 : 1 day during transplanting period (January/February)

8. Equipment prepared or brought by participants (if any)

Mangrove Plantation Guideline
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Outline of Training Course
1. Course Title:

Introduction on mangrove ecosystem protection

2. Objectives of the Course

To learn practical and regulatory measures to protect mangrove ecosystem

3. Expected Output (skills to be acquired by participants)

By the end of the course, participants should understand;

 Legal framework for mangrove protection

 The various natural and human threats to mangrove ecosystem

 Possible protective measures against the threats

4. Expected Participants (minimum required level for entry if any)

QEIC/MECA staff, NGOs, local community, private sector

5. Trainers

QEIC staff

6. Syllabus

Module 1 Lecture : Introduction on mangrove ecosystem protection (0.5 day)

7. Schedule

Duration: 0.5 day

8. Equipment prepared or brought by participants (if any)
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Outline of Training Course
1. Course Title:

Introduction of QEIC database

2. Objectives of the Course

This training course aims to introduce the available database in the QEIC and the structure of each

database.

3. Expected Output (skills to be acquired by participants)

By the end of this training course, participants should;

 understand the kind of database available in the QEIC,

 understand the database structure of monitoring data,

 understand the database structure of mangrove site,

 understand the database structure of mangrove fauna

4. Expected Participants (minimum required level for entry if any)

QEIC/MECA Staff and Research Organizations

5. Trainers

QEIC Staff

6. Syllabus

Module 1 Lecture : Introduction of database available in the QEIC (0.5day)

7. Schedule

Module 1 : anytime (duration: 0.5 day)

8. Equipment prepared or brought by participants (if any)
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Outline of Training Course
1. Course Title:

Producing education materials

2. Objectives of the Course

This training course is prepared to learn how to prepare education materials to achieve respective

learning goals and objectives and to learn how to design education programs regarding mangroves and

mangrove ecosystem.

3. Expected Output (skills to be acquired by participants)

By the end of this training course, participants should;

 understand type of education materials for environment education of mangroves and

mangrove ecosystem,

 understand necessary contents of education materials for environment education of

mangroves and mangrove ecosystem,

 prepare education materials based on the above-mentioned contents; such as quiz, puzzle,

bingo card, and etc.

 understand factors to be considered in designing education programs,

 understand goals of education programs and suitable education materials to be used,

 understand how to prepare activity sheet of the education program, and

 understand how to evaluate the education program.

4. Expected Participants (minimum required level for entry if any)

QEIC/MECA Staff and selected NGO members

5. Trainers

QEIC Staff

6. Syllabus

Module 1 Lecture : Different type of education materials

Module 2 Lecture and Discussion : Necessary contents of education materials for environment

education of mangroves and mangrove ecosystem

Module 3 Lecture and Practice: Preparation of education materials

Module 4

Module 5

Module 6

Module 7

Lecture : Factors to be considered in designing education programs

Lecture : Goals of education programs and suitable education materials to be used

Lecture and Practice : Preparing activity sheet of the education program

Lecture and Practice : Evaluation of the education program

7. Schedule

Duration: 2 days

Module 1: 0.2 day

Module 2: 0.4 day
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Module 3: 0.4 day

Module 4: 0.2 day

Module 5: 0.2 day

Module 6: 0.4 day

Module 7: 0.2 day

8. Equipment prepared or brought by participants (if any)
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Outline of Training Course
1. Course Title:

Implementing education programs

2. Objectives of the Course

This training course is prepared to learn how to implement education programs regarding mangroves

and mangrove ecosystem.

3. Expected Output (skills to be acquired by participants)

By the end of this training course, participants should;

 understand how to use education materials to implement education programs effectively,

and

 understand how to implement education programs based on activity sheet of the program.

4. Expected Participants (minimum required level for entry if any)

QEIC/MECA Staff and selected NGO members

5. Trainers

QEIC Staff

6. Syllabus

Module 1 Lecture and Practice : how to use education materials to implement education programs

Module 2 Lecture and Practice : how to implement education programs based on the activity sheet

7. Schedule

Duration: 1 day

(Module 1: 0.3 day, Module 2: 0.7 day)

8. Equipment prepared or brought by participants (if any)
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Outline of Training Course
1. Course Title:

Introduction of the exhibition

2. Objectives of the Course

This training course is prepared to learn basic idea on exhibition plan for QEIC regarding mangroves and

mangrove ecosystem.

3. Expected Output (skills to be acquired by participants)

By the end of this training course, participants should;

 understand the contents of exhibition plan for QEIC,

 understand how to prepare worksheet on exhibition articles in order to enhance visitors’

understanding on the articles, and

 understand lessons learnt from other organizations

4. Expected Participants (minimum required level for entry if any)

QEIC/MECA Staff and selected NGO members

5. Trainers

QEIC Staff

6. Syllabus

Module 1 Lecture : Contents of exhibition plan for QEIC

Module 2 Lecture and practice:  Preparing worksheet on exhibition articles

Module 3 Lecture and discussion: Lessons learnt from other organizations

7. Schedule

Duration: 0.5 day

(Module 1: 0.2 day, Module 2: 0.2 day, Module 3: 0.1 day)

8. Equipment prepared or brought by participants (if any)
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5 Trainers' manual

To conduct the training program effectively, procedure, method, necessary materials, point to

be cared as a trainer is specified for each training module.
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Module 1

Title: Introduction of QEIC functions and activities

Venue: QEIC lecture room

Method: Power point presentation

Duration: 1 hour lecture

Procedure:

 Explain major functions of the QEIC (Slide No. 1 - 2)

 Explain major activities of the QEIC (Slide No. 3 - 22)

 Explain major publications, web site and exhibition (Slide No. 23 - 25)

 Explain annual schedule of the activities of the QEIC (Slide No. 26)

 Explain organizational structure of the QEIC(Slide No. 27)

Module 2

Title: Introduction of case studies of similar institutions in the world

Venue: QEIC lecture room

Method: Power point presentation

Duration: 1.5 hours

Contents:

 Explain outline of similar case study in the world (slide No.1 - 2)

 Explain case studies in the world (slide No. 3 - 16)

 Explain difference of activities between QEIC (slide No. 17)

Module 3

Title: Introduction of facilities of the QEIC

Venue: QEIC lecture room

Method: Power point presentation

Duration: 1 hour

Contents:

 Explain facilities in the QEIC (slide No. 1 - 9)

 Explain QNR and facilities such as board walk, observation hut (slide No. 10 - 12)
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Module 4

Title: Visual tour of facilities, mangrove nursery and Qurm Nature Reserve

Venue: QEIC, QNR

Method: Tour

Duration: 1.5 hours

Procedure:

Step Activity
Necessary

material/equipment
Venue Reference

1 Explain facilities in QEIC Training material I-1-3-2 QEIC Manual for trainer I-3-1

2 Show QNR from the top of the

QEIC

Training material I-1-3-2

Satellite image of QNR

QEIC

3 Show the nursery, board walk

and mangrove transplanted

site

Training material I-1-3-2 QNR

Module 5

Title: Laboratory tour

Venue: QEIC lecture room, QEIC lab

Method: Lecture and tour

Duration: 1 hour

Procedure:

Step Activity
Necessary

material/equipment
Venue Reference

1 Explain the laboratory and

available parameters

Training material I-1-3-3 QEIC Manual for trainer I-3-1

2 Show the laboratory and

equipment

Training material I-1-3-3 QEIC

3 Explain necessary

maintenance for the

equipment

Training material I-1-3-3 QEIC
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Module 6

Title: Introduction of field equipment

Venue: QEIC lecture room, QEIC equipment storage

Method: Lecture and tour

Duration: 1.5 hours

Procedure:

Step Activity Necessary material/equipment Venue Reference

1 Explain the field

equipment laboratory and

available parameters

Training material I-1-3-4 QEIC Manual for trainer

I-3-1

2 Show the equipment

storage and equipment

Training material I-1-3-4 QEIC

3 Explain necessary

maintenance for the

equipment

Training material I-1-3-4 QEIC
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Module 1

Title: Introduction on mangrove ecosystem

Venue: QEIC lecture room

Lecturer: QEIC staff

Method: Power point presentation

Duration: 0.5 day

Contents:

Explain the following:

 Mangrove diversity and distribution

 How mangroves are adapted to saline and anoxic conditions

 About Avicennia marina

 Reproduction strategies of mangroves

 Common fauna in mangrove ecosystem including their habitat, diet

 Food chain of mangrove ecosystem

 The importance of mangrove ecosystem

 Threats to mangrove ecosystem

Module 2

Title: Observation of mangrove ecosystem

Venue: QNR

Lecturer: QEIC staff

Method: Field observation of mangrove and fauna

Duration: 0.5 day

Procedure:

Step Activity Necessary equipment Venue

1 Observe the aerial roots, leaf,

flower, seed of mangrove

- QNR boardwalk

2 Observe different types of crabs

and shells found along the

boardwalk and mudflat

- QNR boardwalk,

mudflat area

3 Observe fish by collecting with fish

cage

Fish cage QNR boardwalk

4 Observe birds along the mudflats Binoculars and scope Mudflat area
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Module 1

Title: Introduction on mangrove ecosystem monitoring program

Venue: QEIC lecture room

Lecturer: QEIC staff

Method: Power point presentation

Duration: 0.5 day

Contents:

 Explain objective, concept and procedure of mangrove ecosystem monitoring program

Module 2

Title: Monitoring of mangrove tree

Venue: QNR, QEIC

Lecturer: QEIC staff

Method: Field practice

Duration: 0.5 day

Procedure:

Step Activity Necessary equipment Venue Reference

1 Explain the basic monitoring

procedure

QNR Mangrove Monitoring

Guideline 2.1.1

2 Show how to select

monitoring site and tree

Stake, tape measure (100 m),

marker tape, GPS,

clipboard/field sheet

QNR Mangrove Monitoring

Guideline Section 2.1.2

3 Show how to measure tree

height and trunk

circumference

Measuring rod, tape measure

(2 m), tree tag, clipboard/field

sheet

QNR Mangrove Monitoring

Guideline Section 2.1.3

4 Show how to assess tree

health

Clipboard/field sheet,

camera

QNR Mangrove Monitoring

Guideline Section 2.1.4

5 Show how to manage

collected data

Computer, database format QEIC Mangrove Monitoring

Guideline Section 2.1.7
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Module 3

Title: Monitoring of fauna

Venue: QNR, QEIC

Lecturer: QEIC staff, Bird expert, Staff from MSFC

Method: Field practice

Duration: 1.5 days

Procedure:

Day 1 (1 day)
Step Activity Necessary equipment Venue Reference

1 Explain the basic monitoring
procedure

QNR Mangrove Monitoring
Guideline Section 3.1

2 Show fauna collection
methods with net and cage

Seine net, fish cage, small
hand net, bucket, glass jars

QNR Mangrove Monitoring
Guideline Section 3.2.1

3 Show fauna collection
methods by digging

Shovel, scoop, sieve, glass jars QNR Mangrove Monitoring
Guideline Section 3.2.1

4 Show how to take live photos
and preserve the collected
fauna

Camera, aquarium, small hand
net, labels, waterproof
markers, jars,
ethanol/formalin solution,
water, cooler box

QNR Mangrove Monitoring
Guideline Section 3.2.1

5 Show how to identify and
make basic size
measurements of the
collected fauna
Lecturer: Staff of MSFC

Ruler, camera, board, pin,
identification guidebooks,
clipboard/field sheet

QEIC Mangrove Monitoring
Guideline Section 3.2.2

6 Show how to manage
collected data

Computer, database format QEIC Mangrove Monitoring
Guideline Section 3.2.1

Day 2 (0.5 day)
Step Activity Necessary equipment Venue Reference

1 Show how to survey and
identify birds
Lecturer: Bird expert

Telescope, binoculars, camera,
GPS

QNR Mangrove Monitoring
Guideline Section 3.3

2 Show example of how to
monitor indicator species

Stake, tape measure (100 m),
quadrat, clipboard/field sheet

QNR Mangrove Monitoring
Guideline Section 3.5
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Module 4

Title: Monitoring of environmental condition

Venue: QNR, QEIC lab, QEIC computer room

Method: Field practice

Duration: 1.5 days

Procedure:
Step Activity Necessary material/equipment Venue Reference

1 Show how to collect
water samples and
measure water quality

Water quality meter (pH, salinity, DO),
water sampler/bucket, sampling
bottle, clipboard/field sheet,
thermometer, cooler box/ice, GPS,
portable depth sounder, labels and
waterproof markers

QNR Mangrove
Monitoring
Guideline Section 4.2

2 Show how to collect soil
samples and measure soil
quality

Soil sampler, ORP meter, soil-color
chart, water quality meter (pH,
salinity, DO), distilled water,
measuring cylinder, spoon, sampling
bottle, clipboard/field sheet,
thermometer, cooler box/ice, GPS,
labels and waterproof markers

QNR Mangrove
Monitoring
Guideline Section 4.3

3 Show how to conduct
topography and water
level monitoring

Stake, measure, camera, GPS QNR Mangrove
Monitoring
Guideline Section 4.4
& 4.5

4 Show how to analyze COD
and nutrients

Analysis equipment (colorimeter,
reagents, distilled water etc.)

QEIC Mangrove
Monitoring
Guideline Section
Appendix 3

5 Show how to manage
collected data

Computer, database format QEIC



Technical Document 1  Training plan and materials

Trainer’s manual
Course title: Introduction on mangrove health assessment using remote sensing

27

Module 1

Title: Introduction on mangrove health assessment using remote sensing

Venue: QEIC lecture room

Lecturer: QEIC staff, remote sensing expert

Method: Power point presentation

Duration: 0.5 day

Contents:

 Explain objective, concept and procedure of mangrove health assessment using remote sensing

Module 2

Title: Mangrove health assessment using image processing software

Venue: QEIC computer room

Lecturer: QEIC staff, remote sensing expert

Method: Practice

Duration: 2 days

Procedure:

Step Activity Necessary equipment Venue Reference

1 Show how to georeference

satellite image

Computer, satellite image,

image processing software

QEIC Remote sensing

guideline Section 4.2

2 Show how to delineate and

estimate surface area of

mangrove forest

Computer, satellite image,

image processing software

QEIC Remote sensing

guideline Section 4.3

3 Show how to calculate NDVI

values of mangrove forest

Computer, satellite image,

image processing software

QEIC Remote sensing

guideline Section 4.4

4 Show how to calculate

changes in NDVI values of

mangrove forest

Computer, satellite image,

image processing software

QEIC Mangrove Monitoring

Guideline Section 4.5
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Module 3

Title: Field verification

Venue: QNR

Lecturer: QEIC staff, remote sensing expert

Method: Practice

Duration: 0.5 day

Procedure:

Step Activity Necessary equipment Venue Reference

1 Verify the results of NDVI

through field reconnaissance

Leaf spectrophotometer QNR
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Module 1

Title: Introduction on Transplanted-seedling Monitoring Program

Venue: QEIC

Method: Power point presentation

Duration: 0.5 day

Contents:

 Explain objective, concept and procedure of Transplanted-seedling Monitoring Program

Module 2

Title: Monitoring of seedling growth and health

Venue: QNR, QEIC

Method: Field practice

Duration: 0.5 day

Procedure:

Step Activity Necessary equipment Venue Reference

2 Show how to select

monitoring seedling

Stake, tape measure (100 m),

marker tape, GPS,

clipboard/field sheet, tree tag

QNR Mangrove Monitoring

Guideline Chapter 3,

Section 2.1

3 Show how to measure

seedling growth

Tape measure, caliper,

clipboard/field sheet

QNR Mangrove Monitoring

Guideline Chapter 3,

Section 2.2

4 Show how to estimate ratio of

unhealthy seedling

Clipboard/field sheet,

camera

QNR Mangrove Monitoring

Guideline Chapter 3,

Section 2.3

5 Show how to manage

collected data

Computer, database format QEIC Mangrove Monitoring

Guideline Chapter 3,

Section 2.5
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Module 1

Title: Significance of mangrove plantation and selection of suitable site

Venue: QEIC lecture room and QNR

Method: Power point presentation and field training

Duration: 2 hours lecture and 3 hours field training

Procedure:

 Explain significance of mangrove plantation and selection of suitable site by using PPT in lecture room

 Shift to QNR for field training

Step Activity
Necessary

material/equipment
Venue Reference

1 Visit to one cadidate location

for mangrove plantation

QNR

2 Explain the contents of

checklist

Checklist for site selection QNR Checklist for site

selection

3 Evaluate the conditions

according to the checklist

Refractometer, Binocular,

Clinometer, Scoop

QNR Checklist for site

selection

4 Visit to another location for

mangrove plantation and

repeat the evaluation

Refractometer, Binocular,

Clinometer, Scoop

QNR Checklist for site

selection

5 Show how to enter and

analyze collected data

Computer, Data sheet QEIC
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Module 2+3

Title: Seed collection methods and treatment of collected seeds/Operation of nursery for proper seedling

production

Venue: QEIC lecture room and QNR nursery

Method: Power point presentation and field training

Duration: 2 hours lecture and 2 hours field training (1st day) and 4 hours field training (2nd day)

Procedure:

 Explain seed collection methods and treatment of collected seeds by using PPT in lecture room (1 hour)

 Explain operation of nursery for proper seedling production by using PPT in lecture room (1 hour)

 Shift to QNR Nursery for field training

Step Activity
Necessary

material/equipment
Venue Reference

1 Explain general structure of

the nursery with the principle

of tidal irrigation

QNR

Nursery

Mangrove Plantation

Guideline Section 3.1

2 Explain general flow of seed

collection, treatment and

plantation

QNR

Nursery

Mangrove Plantation

Guideline Section 3.1

3 Show how to collect matured

seeds from mangrove trees

Small bucket or plastic bag QNR

4 Show how to soak collected

seeds in large container and

keep the container overnight

Large container of about 100

liter and seawater

QNR

Nursery

 Visit to QNR Nursery in the next day to continue the field training

Step Activity
Necessary

material/equipment
Venue Reference

5 Show how to remove bug

infested seeds and pericarp to

obtain healthy naked seeds

Small bucket, Large container

and Seawater

QNR

Nursery

6 Show how to prepare a pot by

filling sand for sowing

Plastic pots, Sand, Scoop QNR

Nursery

7 Show how to arrange the pots

in the nursery bed

QNR

Nursery

8 Show how to sow seeds in the

pots arranged

QNR

Nursery
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Module 4

Title: Transplanting procedure and maintenance of planted trees

Venue: QEIC lecture room and QNR

Method: Power point presentation and field training

Duration: 2 hours lecture and 3 hours field training

Procedure:

 Explain transplanting procedure and maintenance of planted trees using PPT in lecture room

 Shift to QNR for field training

Step Activity
Necessary

material/equipment
Venue Reference

1 Explain general flow of

transplanting method

QNR

Nursery

Mangrove Plantation

Guideline Section 3.3

2 Explain how to select

suitable location for

transplanting

QNR

selected

site

Mangrove Plantation

Guideline Section 3.3

3 Show how to prepare the

planting holes and distribute

the seedlings

Measuring tapes, Shovels,

Wheel barrows

QNR

selected

site

4 Show how to transplant

seedlings at the holes

prepared

Cutter for plastic bag, Scoop QNR

selected

site

Trasplanting brochure

5 Show how to measure the

planted area by GPS

GPS QNR

selected

site

6 Show how to obtain data

from GPS, plot on satellite

image and measure the area

Computer, Satellite image QEIC
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Module 1

Title: Introduction on mangrove ecosystem protection

Venue: QEIC lecture room

Lecturer: QEIC staff

Method: Power point presentation

Duration: 0.5 day

Contents:

Explain the following:

 Legal framework for mangrove protection

 The various natural and human threats to mangrove ecosystem

 Possible protective measures against the threats
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Module 1

Title: Different type of education materials

Venue: QEIC lecture room

Method: Power point presentation + Samples of Education Materials

Duration: 1 hour lecture

Procedure:

 Explain different type of education materials by using PPT in lecture room

 Show samples of education materials

Step Activity
Necessary

material/equipment
Venue Reference

1 Explain different type of

education materials

QEIC Guideline for

environmental

education program

2 Show samples of education

materials

Samples of education

materials

QEIC

Module 2

Title: Contents of education materials for environmental education of mangroves

Venue: QEIC lecture room

Method: Power point presentation and group discussion

Duration: 15 minutes lecture and 1 hour group discussion/presentation

Procedure:

 Suggest possible contents of education materials by using PPT in lecture room

 Discuss necessary contents of education materials by group discussion

 Present results of the group discussion

Step Activity
Necessary

material/equipment
Venue Reference

1 Suggest possible contents of

education materials

QEIC Guideline for

environmental

education program

2 Discuss necessary contents of

education materials

Pen and stick-back card QEIC

3 Present results of the group

discussion

QEIC
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Module 3

Title: Preparing education materials

Venue: QEIC lecture room

Method: Practice by participants

Duration: 2 hours practice

Procedure:

Step Activity
Necessary

material/equipment
Venue Reference

1 Remind possible contents of

education materials for

mangrove

QEIC Guideline for

environmental education

program

2 Practice 1: producing card

puzzle

Photo of birds, cutter, and

ruler

QEIC

3 Practice 2: producing

mangrove quiz

A4 paper and pen QEIC

4 Practice 3: producing field

bingo card

A4 paper and pen

5 Presentation of the results

by participants
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Module 4+5

Title: Factors to be considered in designing education programs + Designing environmental education programs

Venue: QEIC lecture room

Method: Power point presentation

Duration: 2 hours lecture

Procedure:

 Explain factors to be considered in designing education programs by using PPT in lecture room

 Explain goals of education programs and suitable education materials to be used

 Explain how to design environmental education programs using activity sheet

Step Activity
Necessary

material/equipment
Venue Reference

1 Explain factors to be considered

in designing education

programs

QEIC Guideline for

environmental

education program

2 Explain goals of education

programs and suitable

education materials to be used

QEIC

3 Explain how to design

environmental education

programs

Activity sheet of

environmental education

program

QEIC
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Module 6

Title: Preparing activity sheet of environmental education program

Venue: QEIC lecture room

Method: Practice by participants

Duration: 10 minutes lecture and 2 hours practice/presentation

Procedure:

 Remind the method of education program designing by preparing activity sheet

 Practice to design education program (determine target people and goal of program, and design a program)

 Present prepared education program by participants

Step Activity
Necessary

material/equipment
Venue Reference

1 Remind the method of

education program designing

QEIC

2 Practice to design education

program

Activity sheet QEIC

3 Present prepared education

program by participants

QEIC

Module 7

Title: Evaluation of environmental education program

Venue: QEIC lecture room

Method: Power point presentation + Samples of evaluation

Duration: 30 minutes lecture

Procedure:

 Explain purpose and method of program evaluation in lecture room

 Show examples of program evaluation

Step Activity
Necessary

material/equipment
Venue Reference

1 Explain purpose and method

of program evaluation

QEIC

2 Show examples of program

evaluation

Evaluation sheet, case study

of program evaluation

QEIC
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Module 1

Title: Implementing environmental education program (lecture)

Venue: QEIC lecture room

Method: Power point presentation

Duration: 20 minutes lecture

Procedure:

Step Activity
Necessary

material/equipment
Venue Reference

1 Explain timetable and

contents of the trial education

program

QEIC Guideline for

environmental

education program

2 Explain education materials to

be used

Education materials such as

poster, brochure, photo list,

and feedback sheet

QEIC

Module 2

Title: Implementing environmental education program (practice)

Venue: QNR

Method: Field training

Duration: 3 hours

Procedure:

Step Activity
Necessary

material/equipment
Venue Reference

1 Explain mangroves and

mangrove forests in Oman

Poster: Mangrove forests in

Oman

QNR

2 Explain food chain in

mangrove ecosystem

Poster: Food chain,

Brochure: Mangrove

ecosystem

QNR

3 Visit the mangrove nursery QNR

4 Observe mangrove forest

through the board walk

Photo list of animals in

mangrove forests

QNR

5 Bird watching Photo list and telescope QNR

6 Feedback Feedback sheet QNR
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Module 1

Title: Contents of exhibition plan for QEIC

Venue: QEIC lecture room

Method: Power point presentation

Duration: 1 hour lecture

Procedure:

 Explain contents of exhibition plan for QEIC by using PPT in lecture room

Step Activity
Necessary

material/equipment
Venue Reference

1 Explain the contents of

exhibition plan

QEIC Exhibition plan for

QEIC

2 Explain permanent exhibition

and special exhibition

QEIC Exhibition plan for

QEIC

3 Explain floor plan of the

exhibition

QEIC Exhibition plan for

QEIC

Module 2

Title: Utilization of worksheet and learning book

Venue: QEIC lecture room

Method: Power point presentation

Duration: 1 hour lecture and practice

Procedure:

 Explain worksheet and learning book by using PPT in lecture room (20 minutes)

 Practice to produce worksheet by the participants in lecture room (40 minutes)

Step Activity
Necessary

material/equipment
Venue Reference

1 Explain what is worksheet and

learning book

QEIC Example of worksheet

and learning book

2 Practice to produce worksheet

by the participants

QEIC

3 Presentation of results of the

practice

QEIC
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Module 3

Title: Lessons learnt from other nature centers

Venue: QEIC lecture room

Method: Power point presentation

Duration: 30 minutes lecture

Procedure:

 Explain lessons learnt from other nature centers using PPT in lecture room

Step Activity
Necessary

material/equipment
Venue Reference

1 Explain lessons learnt from

other nature centers

QEIC Exhibition plan for QEIC

2 Explain lessons learnt from

EXPO 2012 in Korea

QEIC Exhibition plan for QEIC
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6 List of materials
 Materials to be used on the training, such as powerpoint presentation, document and guideline, are isted in Table 3.
 Soft copy of the materials are stored in the attached CD (refer to the "Material" column for the file name).

Table 3 List of training materials

No Mode Contents

1 Lecture Introduction of QEIC functions
and activities

PPT I-1-1 Function of QEIC.pptx

2 Lecture Introduction of case studies of
similar institutions in the world

PPT I-1-2 Case study.pptx

3 Lecture Introduction of facilities of QEIC PPT I-1-3 Introduction of facility.pptx

4 Quick tour:
Visual tour of facilities, mangrove
nursery and Qurm Nature
Reserve

DM I-1-4 Quick Tour.docx

Tour Laboratory tour

Lecture

Detailed introduction of the
laboratory, equipment and
available parameters, necessary
maintenance

Tour Introduction of field equipment

Lecture:
Detailed introduction of the field
equipment, necessary
maintenance

1 Lecture Introduction on mangrove
ecosystem

PPT I-2-1 Introduction on mangrove
ecosystem.pptx

2 Field visit
Observation of mangrove
ecosystem

DM I-2-2 Observaion of QNR.docx

1 Lecture
Introduction on mangrove
ecosystem monitoring program

PPT
II-1 Introduction on Mangrove
Ecosystem Monitoring Program.pptx

2 Practice Monitoring of mangrove GL
3 Practice Monitoring of fauna GL

4 Practice
Monitoring of environmental
condition

GL

Category Course title
Module

Material format

PPT

1. Function of QEIC

General
5 PPT

6

2. Introduction on
mangrove
ecosystem

I

II Monitoring

1. Introduction on
Mangrove
Ecosystem
Monitoring
Program

2. Introduction on
mangrove health
assessment using
remote sensing

Material

I-1-5 Laboratory.pptx

I-1-5 Laboratory.pptx

-

41

4 Practice
Monitoring of environmental
condition

GL

1 Lecture
Introduction on mangrove health
assessment using remote sensing

PPT
II-2 Introduction on mangrove health
assessment using remote sensing.ppt

2 Practice
Mangrove health assessment
using image processing software

GL

3 Practice Field verification GL

1 Lecture
Introduction on “Transplanted-
seedling Monitoring Program”

PPT
II-3 Introduction on Transplanted-
seedling Monitoring Program.pptx

2 Prctice
Monitoring of seedling growth
and health

GL -

1 Lecture
Significance of mangrove
plantation and selection of
suitable site

PPT, GL III-1-1 Significance Plantation.pptx

2 Lecture &
practice

Seed collection methods and
treatment of collected seeds

DM, PPT. GL III-1-2 Seed collection.pptx

3 Lecture &
practice

Operation of nursery for proper
seedling production

DM, PPT, GL III-1-3 Operation of nursery.pptx

4
Lecture &
practice

Transplanting procedure and
maintenance of planted trees

DM, PPT, GL III-1-4 Transplanting procedure.pptx

IV Protection
1.  Introduction on
mangrove ecosystem
protection

1 Lecture
Introduction on mangrove
ecosystem protection

PPT, GL
Materials\IV-1 Introduction on
mangrove ecosystem protection.pptx

1. Introduction of
QEIC database

1 Lecture
Introduction of database
available in the QEIC

PPT
The prepentasion material  is not yet
prepared, since the database is not
developed at moment.

1 Lecture Different type of education
materials

PPT VI-1-1 Materials.ppt

2
Lecture &
discussion

Necessary contents of education
materials for environment
education of mangroves and
mangrove ecosystem

PPT, discussion VI-1-2 EE Contents.ppt

1.  Method of
mangrove tree
plantation

V  Database

1. Producing
education materials

PlantationIII

VI Education

II Monitoring

1. Introduction on
Mangrove
Ecosystem
Monitoring
Program

2. Introduction on
mangrove health
assessment using
remote sensing

3. Introduction on
“Transplanted-
seedling Monitoring
Program”

-

-

41
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No Mode Contents
Category Course title

Module
Material format Material

3 Lecture &
practice

Preparation of education
materials

practics -

4 Lecture Factors to be considered in
designing education programs

PPT VI-1-4,5 EE Program.ppt

5 Lecture
Goals of education programs and
suitable education materials to
be used

PPT VI-1-4,5 EE Program.ppt

6 Lecture &
practice

Preparing activity sheet of the
education program

practice -

7 Lecture &
practice

Evaluation of the education
program

PPT, practice VI-1-7 Evaluation.ppt

1
Lecture &
practice

How to use education materials
to implement education
programs

PPT, practice VI-2-1 Implementing.ppt

2
Lecture &
practice

How to implement education
programs based on the activity
sheet

practice -

1 Lecture Importance of story line in
designing exhibition plan

PPT VII-1-1 Exhibition Plan.pptx

2 Lecture &
practice

Preparing work sheet on
exhibition articles

PPT, practice VII-1-2 Work Sheet.pptx

3
Lecture &
discussion

Lessons learnt from other
organization

PPT, discussion VII-1-3 Other Organizations.ppt

Note: PPT: Microsoft Power Point material, DM: Document material, GL: Guideline

VII
Exhibition
plan

1. Introduction of
QEIC exhibition

1. Producing
education materials

VI Education

2. Implementing
education programs

4242
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Chapter 1  Introduction 

 

1. Background 

The “Mangrove Monitoring Guideline (hereinafter referred as “Guideline”)” was prepared to 

explain the methodologies of the mangrove monitoring programs that were developed through the 

“Qurm Environmental Information Center (QEIC) Project”, a project implemented between Japan 

International Cooperation Agency (JICA) and Ministry of Environment and Climate Affairs (MECA). The 

monitoring programs consist of the following two programs: 

 Mangrove Ecosystem Monitoring Program 

 Transplanted-seedling Monitoring Program 

The monitoring methodologies of “Mangrove Ecosystem Monitoring Program” and 

“Transplanted-seedling Monitoring Program” are described in detail in Chapters 2 and 3, respectively. 

Although the Guideline is intended for application in Oman, it could be applied to other countries 

as well, with perhaps slight modifications. 

The Guideline should also be revised in accordance to the experiences gained through the 

monitoring activities. 

 

2. Characteristics of mangrove ecosystems in Oman 

Natural mangrove forests in Oman are comprised of one species Avicennia marina. They are mainly 

distributed in lagoons and inner-bays dotted along the mainland coast. Mangrove forests are also 

occasionally found along the coasts of offshore islands such as Mahut Island. Mangrove forests in the 

Dhofar region are unique, as they are often isolated from the sea by sandy beach. Figure 1.2.1 shows 

the type of areas where mangrove forests are developed in Oman. 
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Mangrove forest in lagoon 

 

Mangrove forest in inner-bay 

 

Mangrove forest in island 

 

Mangrove forest in closed lagoon 

Figure 1.2.1  Type of areas where mangrove forests are developed in Oman 

 

3. Basic outfits and gears for field survey 

There are various dangers involved when conducting field surveys in mangrove forest, such as 

sunburn, dehydration, insect attacks and cuts by sharp objects (e.g. tree branch, shells). Hence, field 

surveyors should be equipped with appropriate protective outfits and gears. Following are 

recommended outfits and gears:  

 Long-sleeve shirt and trouser 

 Hat 

 Diving boots 

 Gloves 

 Sunglass 

 Sun screen 

 Insect repellent 

 Drinking water  
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Chapter 2  Mangrove Ecosystem Monitoring Program 

 

1. Introduction 

Mangroves in Oman grow under stressful natural conditions and threats to these mangroves and 

its ecosystem are mounting mainly due to recent population growth, economic development and 

coastal development. The “Mangrove Ecosystem Monitoring Program” was developed so to monitor 

the status of mangrove ecosystems that are under threat from natural and human impacts, and to 

implement conservation and management measures in accordance to the monitoring results. The 

status of mangrove ecosystems is assessed in an integrated manner by monitoring the various 

components that constitute and sustain mangrove ecosystems. It consists of monitoring of mangrove 

forest, fauna and environmental conditions. In addition, regular inspection monitoring is included so 

to detect of any presence of human or natural threats. Figure 2.1.1 shows the basic framework of the 

“Mangrove Ecosystem Monitoring Program”. Table 2.1.1 outlines the monitoring methods of each 

monitoring items and the relevant sections in the Guideline.  

 

 

 

 

 

 

 

 

 

Figure 2.1.1  Basic framework of “Mangrove Ecosystem Monitoring Program” 

 

  

Monitoring of mangrove forest 

Status of mangrove ecosystem Inspection monitoring Monitoring of fauna 

Monitoring of environmental conditions 
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Table 2.1.1  Outline of monitoring methods of “Mangrove Ecosystem Monitoring Program” and 

relevant sections in the Guideline 

Monitoring item Method/parameter Frequency 
Relevant section 
in the Guideline 

Mangrove 
forest 

Tree growth Measurement of tree height and 
trunk circumference 

1/year 
(2/year in initial year) 

Section 2.1 

Tree health Visual assessment of mangrove 
health 

1/year 
(2/year in initial year) 

Section 2.1 

Remote sensing assessment of 
mangrove health 

1/year Appendix 1 

Fauna Monitoring of indicator species 
population 

2/year Section 3.1-3.4 

Environmental 
condition 

Water 
quality 

Measurement of temp., salinity, 
pH, DO, COD, nitrate, nitrite, 
ammonium, phosphate 

2/year Section 4.2 

Soil quality Measurement of temp., salinity, 
EC, pH, ORP, nitrate, phosphate 

2/year Section 4.3 

Topography Photo monitoring of lagoon 
mouth 

6/year Section 4.4.1 

Sedimentation monitoring of 
lagoon mouth 

6/year Section 4.4.2 

Water level Water level monitoring of 
waterway 

6/year Section 4.5 

Inspection Identification of threats through 
visual inspection 

6/year Section 5 

 

Note that the monitoring items and frequency should be adjusted in accordance to the situation of 

the target monitoring site. 

 

2. Monitoring of mangrove forest 

A healthy mangrove forest is fundamental to the sustenance of mangrove ecosystem. Therefore, 

the monitoring program will focus on monitoring the health status of the mangrove forest. The 

Guideline provides the following two monitoring approaches: 

 The first approach assesses the health of mangrove forest by monitoring representative 

mangrove trees within the forest through field survey. The health of each tree is assessed by 

measuring growth and visually observing selected health indicators. It is quick, simple and 

requires no special expertise or equipment, and can be implemented after some brief training. 

However, the effectiveness of this approach may be limited for large forests as there may be 

difficultly in monitoring sufficient amount of representative trees. In such case, the second 

approach using remote sensing (see below) may be used in combination.  

 The second approach involves the use of remote sensing (satellite image) technology for 

assessing forest health. The advantage of remote sensing is that it can cover large areas and 

areas where access is hard. However, satellite images are costly, and certain level of expertise 

will be required in using image processing software. Ground-truth work will also be required 

to verify the results. Remote sensing should be applied mainly for large mangrove forests, 
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where field survey is insufficient. The procedure of remote sensing assessment is described in 

the guideline attached as Appendix 1 (Guideline for Mangrove Health Assessment using 

Remote Sensing). 

 

2.1 Monitoring method of mangrove forest 

2.1.1 Basic concept and procedure 

The health of mangrove forest is assessed by monitoring the growth and health of representative 

mangrove trees within the forest, and then comparing the results between successive surveys. The 

health status of each tree is determined by observing selected health indicators. If the monitored 

trees show any signs of health degradation (or no health improvement of unhealthy tree) between 

the successive surveys, it may be a sign that the health of the surrounding mangrove forest is under a 

degraded or stressed state. In such case, the cause of such health degradation should be investigated 

and appropriate actions taken accordingly. In principal, monitoring should be conducted 1/year 

(2/year in initial year), preferably during the same months. Figure 2.2.1 shows the basic monitoring 

procedure (refer to the ensuing Sections for more details): 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 2.2.1  Basic procedure of mangrove health monitoring by field survey 

 

2.1.2 Selection of monitoring site and trees 

The number and location of the monitoring sites should be determined in accordance to the 

characteristics of each site, taking into account factors such as forest size, accessibility, availability of 

time and manpower. Following is one approach that could be employed for selection of monitoring 

site and trees, based on transect survey method. 

 

Step 1: Zoning of mangrove forest 

First divide the mangrove forest into several zones by using satellite images or maps as shown in 

Select monitoring site and trees 

Monitor growth and health of the monitoring trees 

Conduct the same monitoring after a set period 

Compare the monitoring results with the previous survey 

Any signs of health degradation or hindrance to health improvement? 

Continue monitoring Investigate possible causes 

Yes No 
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Figure 2.2.2.  

 

Figure 2.2.2  Zoning of mangrove forest 

 

Step 2: Setting of monitoring transect 

For each zone, set up sufficient quantity of monitoring transect as shown in Figure 2.2.3. The 

transects should be set vertical to the forest edge and long enough so that it covers the entire width 

of the forest 

 
Figure 2.2.3  Example of monitoring transect set up 

 

However, note that in some forests, it would be difficult to apply vertical transects as Avicennia 

forest are often very dense and access to the inner area almost impossible unless the branches are 

cut. In such case, as a compromise, the monitoring transects may be set along the forest edge as 

shown in Figure 2.2.4.  
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Figure 2.2.4  Example of monitoring transect set up (alternative option) 

 

Alternatively, if it is difficult to cover the entire forest for reasons such as accessibility, lack of 

manpower or time, monitoring may be focused on areas that are considered to have comparatively 

high risks of degradation such as: 

 Mangrove areas near construction site 

 Mangrove areas that are susceptible to grazing 

 Mangrove areas that are susceptible to pollution 

 

Step 3: Selection of monitoring trees 

Once the monitoring site and transects are selected, the next step is to select the monitoring trees 

within the transect. Following are the basic procedures: 

 Establish a transect at the monitoring site by laying a rope or tape measure. Then mark the 

start and end of the transect with a stake as shown in Figure 2.2.5. Record the location of the 

stakes with GPS. The stakes should be durable and installed deep enough so that it remains 

fixed until the next survey.  

 

Figure 2.2.5  Image of transect 

 

 Once the transect is set, select trees that are touching or within 1-2 m of the transect. The 
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number of monitoring trees should be at least be more than 10% of the number of trees along 

the transect (e.g. more than 10 trees if the number of trees along the transect is 100 trees). 

The selected trees should also be evenly distributed and not concentrated in one location. 

Figure 2.2.6 shows examples of monitoring tree selection. 

 

Figure 2.2.6  Examples of monitoring tree selection 

 

 Attach a numbered tag onto the selected trees so that they can be identified in the ensuing 

surveys. Use tags that have high tolerance to sunlight and salt, so that they remain extant until 

the next survey. Figure 2.2.7 shows an example of a tree tag. 

 

  

Figure 2.2.7  Example of tree tag 

 

2.1.3 Monitoring of mangrove tree growth 

Tree height and trunk circumference are measured to monitor tree growth. Tree height is 

measured from the ground level to the tree top by using a measuring rod (see Figure 2.2.8). 
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Figure 2.2.8  Measurement of tree height with measuring rod 

 

Trunk circumference is measured at a fixed height above ground level (e.g. 130 cm) as shown in 

Figure 2.2.9. Often Avicennia marina has numerous numbers of trunks protruding from the ground, 

so choose one trunk for monitoring and continue to measure the same trunk (off course you can 

monitor more than one trunk if you are willing!). Mark the trunk that you are measuring so you can 

identify it later (the tree tag mentioned above can be used). Note the above results into a field sheet 

(sample field sheet is included in the attached CD). 

 

  

Figure 2.2.9  Measurement method of trunk circumference 

 

2.1.4 Monitoring of mangrove tree health 

The health of a mangrove tree is assessed by first visually observing the following health indicators.  

 Leaf/branch density 

 Leaf health 

 Tree-top dieback 

 Flowering 

The status of each health indicator is rated by the surveyor as either “Good”, “Fair” or “Poor” by 
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referring to the assessment criteria shown in Table 2.2.1. Then based on the rating of each health 

indicator, the overall health status of the mangrove tree is rated as either “Good”, “Fair” or “Poor” by 

referring to the assessment criteria shown in Table 2.2.2. Note the results into a field sheet (sample 

field sheet is included in the attached CD). 

 

Table 2.2.1  Tree health indictors and assessment criteria 

Health indicator 
Assessment criteria 

Good Fair Poor 

1 Leaf/branch 
density 

High Moderate Low 

2 Leaf health Most leaves are 
healthy (e.g. > 80%) 

Mixture of unhealthy 
leaves 

Most leaves are 
unhealthy (e.g. > 80%) 

3 Tree-top dieback No dieback Some dieback Significant or complete 
dieback 

4 Flowering* Abundant Less abundant than 
usual 

Very few or none 

*: Applicable only in flowering season 

 

Table 2.2.2  Assessment criteria of overall health of mangrove tree 

Good Fair Poor 

All health indicators rated as 
“Good” 

One or more health indicators 
rated as “Fair” or no “Poor” 

One or more health indicators 
rated as “Poor” 

 

When conducting the assessment, make sure to observe the whole tree rather than focusing only 

on one part of the tree. Since judgment will be reliant on the surveyor’s impression, two or more 

surveyors should participate in the survey, so to reaffirm the validity of each other’s judgment. Try to 

conduct the assessment briefly based on “first impression” as you might get confused if you observe 

for long time. In addition, take photos of the tree for later reference. Following are detailed 

description of each health indicator.  

 

(1) Leaf/branch density 

In general, a healthy tree will have high density of branches and leaves, and vice versa for 

unhealthy trees. Note that healthy trees may naturally have low branch/leaf density in the lower 

section, due to for example old age, insufficient sunlight penetration caused by dense branch/leaves 

above and so on. Hence judgment should be made by taking into account such factors. Figure 2.2.10 

shows varying degrees of branch/leaf density and respective health conditions. 
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Good Fair Poor 

 

High 

 

Moderate 

 

Low 

Figure 2.2.10  Varying degrees of branch/leaf density and respective health conditions 

 

(2) Leaf health 

In general, leaves of an unhealthy tree will be small, curled and yellowish in color. However, note 

that leaves naturally turn yellowish prior to shedding so it must not be confused as sign of 

unhealthiness. Figure 2.2.11 shows some examples of healthy and unhealthy leaves. 
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Figure 2.2.11  Examples of healthy (left) and unhealthy (right) leaves 

 

(3) Tree-top dieback 

When trees are under stress or unhealthy, they often shed their leaves from the top portion of the 

tree. This is because more effort is required to transport water and nutrients to the top portion of the 

tree. Figure 2.2.12 shows an example of tree-top dieback. 
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Figure 2.2.12  Example of tree-top dieback 

 

(4) Flowering 

This indicator is applicable only for reproductive trees and during flowering season. A healthy 

reproductive tree will generally have abundant flowers and vice versa for unhealthy trees. The 

flowers range from white to a golden yellow color, are less than a centimeter across, and occur in 

clusters of three to five. In Oman, the main flowering season of Avicennia marina differs with the 

region. Table 2.2.3 shows the main flowering season by region. Figure 2.2.13 shows flower of 

Avicennia marina. 

 

Table 2.2.3  Main flowering season of Avicennia marina by region 

Region Main flowering season 

Muscat May-June 
Dhofar November-December 

 

 

Figure 2.2.13  Flower of Avicennia marina 

 

2.1.5 Investigation of possible causes of tree health degradation 

If degradation of tree health is identified between successive surveys, investigate possible causes 
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by observing factors that could affect tree health. Also refer to the monitoring results of the other 

monitoring components (e.g. monitoring results of environmental condition). Following are possible 

factors that may affect tree health. 

 

(1) Lack of water supply 

Mangrove trees need regular supply of seawater to grow. If there is no sign of seawater inundation 

even during high tide, the tree is likely to be under stressful condition. 

 

(2) Water stagnation 

Water stagnation occurs when water exchange is insufficient, which consequently could degrade 

the quality of the water and soil that the mangroves depend on. Hence, observe whether the waters 

around the mangrove trees are exchanged through tidal movement. 

 

(3) High salinity 

High water or soil salinity will affect growth of mangrove. Check the salinity of the adjacent water 

and underlying soil (see Section 4.3.3 for method of soil salinity measurement). 

 

(4) Soil erosion/sedimentation 

Soil erosion or sedimentation may be stressful to mangrove trees. Erosion may unstable the tree by 

exposing the roots. Sedimentation may bury the aerial roots and hinder respiration. Soil erosion or 

sedimentation may be identified by observation or by measuring the sedimentation rate with a 

permanent stake (see Section 4.4 for the measurement method of sedimentation). 

 

(5) Garbage and algae entanglement 

Garbage (esp. plastic bags) and algae are sometimes found entangled on mangrove trees, including 

around the aerial roots. This may be stressful to mangrove trees for example by hindering respiration 

through the aerial root. Figure 2.2.14 shows garbage and algae entangled on mangrove tree. 

 

   

Figure 2.2.14  Garbage (left) and algae (right) entangled on mangrove tree 
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(6) Intrusion of other plant species 

Non-mangrove plant species (e.g. halophyte plants) can sometimes intrude into mangrove areas, 

and affect the health of mangrove or in extreme case cause death. Figure 2.2.15 shows halophyte 

plants intruding into mangrove areas. 

   

Figure 2.2.15  Mangroves affected by intrusion of halophyte plants 

 

(7) Animal grazing 

Animal grazing can affect the health of a tree by removing fresh branches and leaves. In Oman, 

grazing by camels, goats and donkeys are common. Figure 2.2.16 shows mangrove trees affected by 

animal grazing. 

 

  

Figure 2.2.16  Mangrove trees affected by animal grazing 

 

(8) Insect pest and fungi 

In general, when leaves are unhealthy or stressed, they are more likely to be infested by insect 

pests and fungi. Typical pest may include scale insects, leafhopper, sandfly and so on. Figure 2.2.17 

shows examples of pest and infested leaves. 
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Leafhopper 

 

Scale insect 

 

Fungi 

 

Nest of insect 

Figure 2.2.17  Examples of insect pests and leaves stressed by insect and fungi 

 

2.1.6 Necessary field survey equipment 

 Tape measure (e.g. 2 m, 100 m) 

 Stakes (e.g. 1.5 m) 

 Tree tags 

 GPS 

 Field sheet/clip board 

 Waterproof marker 

 Camera 

 Measuring rod (e.g. 12 m) 

 Thermometer 

 Refractometer 

 

2.1.7 Management of monitoring data 

The monitoring data should be stored into a database, which should include the following 

information (sample database format is included in the attached CD): 

 Survey conditions (date, time, weather, tide level etc.) 

 Results of tree height and trunk circumference measurement 

 Results of tree health survey and possible stress factors 

 Photographs of the surveyed trees 
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3. Monitoring method of fauna 

3.1 Basic concept and procedure 

Mangrove ecosystems are sustained through the interaction of various types and sizes of fauna, 

and monitoring of these fauna may provide us indications on the status of the mangrove ecosystem. 

For example, if a significant reduction in bird population is identified through monitoring, we may 

infer that the abundance of their usual food source (e.g. crabs) is declining, and from it we can also 

infer that the mangrove ecosystem is under a degraded state for some reason. 

However, since it is impractical to monitor all fauna species, monitoring could instead be 

conducted by selecting “indicator species”, which are types of species that provide indications on the 

status of the mangrove ecosystem. Among the many fauna types, the Guideline will focus on 

selecting indicator species from the fish, crab, gastropod and bird families, as they are one of the 

most conspicuous fauna in the mangrove ecosystem and therefore are relatively easy to identify and 

monitor.  

In order to select indicator species, it is first necessary to understand the type of species that are 

present at the monitoring site. The initial year will hence focus on developing a species inventory for 

fishes, crabs, gastropods and birds through field survey. Once the inventory is completed, an 

appropriate indicator species will be selected, and from then on monitoring will focus on the selected 

indicator species. Monitoring should be conducted 2 times/year, preferably during the same seasons. 

Figure 2.3.1 shows the basic procedure of the fauna monitoring program.  

 

 

 

 

 

 

 

 

 

 

 

 

Figure 2.3.1  Basic procedure of fauna monitoring 

 

3.2 Development of fauna inventory 

Fauna inventory is developed through the following processes: 

 Collection of fauna from the field 

 Species identification of the collected fauna 

 Development of inventory database 

The ensuing Sections provide basic methods of the above processes for fish, crabs and gastropods. 

Development of fauna inventory 

Selection of indicator species 

Monitoring of indicator species 

Are there any significant changes in the population 
of indicator species? 

Investigate possible causes Continue monitoring 

Yes No 
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Bird inventory involves a slightly different approach as it is impractical to collect them (see Section 

3.3). 

 

3.2.1 Collection of fauna 

(1) Collection by nets 

Various types of nets can be used to collect faunas living in the waterway, such as fishes and crabs. 

Figure 2.3.2 shows examples of different types of nets and their characteristics.  

 

Net type Characteristics 

Seine net Most suitable for catching animals in relatively shallow waters. 

  

Gill net Catches indiscriminately all types of animals larger than the mesh size.  

 

 

 

 

 

 

Cast net Effective in catching animals in relatively shallow waters. Requires certain skills. 

 

 

 

 

 

Hand net Effective in catching animals in tide pools or along the edges of waterway. 

 

 

 

 

 

Figure 2.3.2  Examples of different types of nets and their characteristics 
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(2) Collection by cage 

Various types of cages can be used to collect faunas living in the waterway, such as fishes and crabs. 

The type of fauna caught will depend on the bait and mesh size. Figure 2.3.3 shows examples of 

different types of cages. 

 

 

Figure 2.3.3  Examples of different types of cages 

 

(3) Collection by digging 

Burrowing organisms (e.g. crabs and gastropods) can be caught by digging around their burrow 

with a shovel or scoop. Figure 2.3.4 shows the basic procedures using crabs as an example: 
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Step 1: First look for burrowing crabs, which is easiest during 

low tide. 

 

Step 2: Once the crab hides into its burrow, quickly dig 

around the burrow with a shovel or scoop (e.g. up to around 

20-30 cm depth). 

 

Step 3: Transfer the soil into a sieve and remove the soil by 

washing it with water. 

 

Step 4: Collect the crabs remaining inside the sieve  

 

Step 5: Transfer the crab into a container for later 

identification 

 

Figure 2.3.4  Collection procedure by digging (example with crabs) 

 

(4) Collection by hand 

Some crab species (e.g. sersamid crabs) climb on the trunk/branch of mangrove tree. These crabs 

can be collected directly by hand but wear gloves to prevent injury. Gastropods can also be collected 

by hand especially during low tide where they come out to feed on the mud surface. 
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(5) Photographs of collected fauna 

If the collected fishes are still alive, take live photos by using a portable aquarium (see Figure 2.3.5), 

as it will be useful for later identification (they lose their natural coloration once they are dead). Make 

sure the photos are properly focused on the fish. Take multiple photos so the best photo can be 

chosen later.  

 

  

Figure 2.3.5  Photo of live fish taken with a portable aquarium 

 

(6) Recording of field survey information 

Record necessary information such as below into a field sheet (sample field sheet is included in the 

attached CD): 

 Location and characteristics of the collected area 

 Collection method 

 Characteristics of the collected fauna (e.g. life stage, abundance) 

 

(7) Preservation of collected fauna 

To minimize decay of the collected fauna during transportation, preserve them in a cooler box with 

ice. Alternatively, the samples may be preserved in a glass jar filled with formalin (e.g. 10%) or 

ethanol (e.g. 80%) solution. Also note the following information on a waterproof label and put it 

inside the jar with the samples. 

 Name of mangrove site 

 Collected date and time 

 GPS coordinates of the collected site 

 Collection method 

 Jar no. 

 

(8) Necessary field survey equipment 

 Collection tools (nets, cages, scoop/shovel, sieve) 

 Equipment for sample preservation (alcohol/formalin solution, glass jars, waterproof label) 

 Portable aquarium 
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 Identification guidebook 

 Field sheet and clip board 

 Small hand net for transferring collected samples 

 Bucket 

 GPS 

 Digital camera 

 Waterproof pen 

 Cooler box with ice 

 Gloves 

 

3.2.2 Species identification of collected fauna 

In principal, the collected fauna should be identified at the lab by referring to relevant 

identification guidebooks or websites. Table 2.3.1 shows some useful guidebooks or websites. 

Consult relevant university or research institutes if uncertain. 

 

Table 2.3.1  Guidebooks and websites for species identification 

 Title Author/publisher/website 

Fishes Coastal fishes of Oman John E. Randall / University of Hawaii Press 
FishBase http://www.fishbase.org/search.php 

Crabs Crustacea Guide of the World Helmut Debelius / Ikan 
Gastropods Seashells of Eastern Arabia DT Bosch et al. / Motivate Publishing 

Seashells of Oman Donald Bosch / Longman 

Handbook on Mangrove Associate 
Molluscs of Sundarbans 

Zoological Survey of India 

 

In the process, also take photos and basic body size measurements of the collected samples. Figure 

2.3.6 shows where to measure body size for fish, crab and gastropod. 

 

Fish (standard length) Crab (carapace width) Gastropod (shell length) 

   

Figure 2.3.6  Method of size measurement for fish, crab and gastropod 

 

Once the above identification processes are completed, store the fauna in a shelf by preserving 

them inside a jar with formalin or ethanol solution.  

 

  



Technical Document 2  Mangrove Monitoring Guideline 

23 

 

3.2.3 Development of species inventory 

Once the collected faunas are identified, record the species name and the following information 

into an inventory database (sample database format is included in the attached CD).  

 Collected date and time 

 GPS coordinates of the collected site 

 Collection method 

 Scientific name, common name, family name 

 Body size 

 Life stage (juvenile or adult) 

 Abundance (common or rare) 

 

3.3 Development of bird inventory 

Since it is impractical to collect birds from the field, birds will need to be identified in the field or 

later by taking photographs. Hence, the surveyor will require skills in rapid bird identification and 

good photograph skills. Following are the basic survey procedure:  

 Prior to conducting the survey, identify the main bird habitats (e.g. feeding and roosting areas) 

through field reconnaissance. Also consider migratory seasons when deciding the survey 

period. 

 Once the main bird habitats are identified, plan the time, location and method of the survey. 

Survey can be conducted by observing birds from a fixed point, by walking around the forest, 

from the waterway by using a kayak or a combination of these. Make sure to record the 

surveyed site or route with GPS. 

 If possible, conduct the survey at varying tide levels (e.g. low and high tides). Consider light 

conditions as birds will be hard to identify when the sun is behind them. 

 Observe and identify the birds by using telescope or binocular (see Figure 2.3.7), and make 

sure to keep a certain distance from the birds so to avoid scaring the birds away. Also count 

the number of individuals for each species. Try to take photos of the birds with 

high-magnification camera for later reference. Avoid wearing brightly-colored clothes as you 

may be more easily spotted by birds. Table 2.3.2 shows useful guidebooks for bird survey and 

identification. 

 

Figure 2.3.7  Bird observation with telescope and binocular 
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Table 2.3.2  Guidebooks for bird survey and identification 

Title Publisher 

Guidance on waterbird monitoring 
methodology: Field Protocol for waterbird 
counting 

Wetlands International 

Birdwatching guide to Oman Al Roya Publishing  

Oman Bird List Sultan Qaboos Univeristy 
Birds of the Middle East Porter Aspinall 
Common birds in Oman Al Roya Press & Publishing House 

 

 Record the following information into a field sheet (sample field sheet is included in the 

attached CD). 

 GPS coordinates of survey site 

 Weather conditions 

 Tide level 

 Identified species and their abundance 

 After the field survey, record the information into an inventory database (sample database 

format is included in the attached CD). 

 

Necessary field survey equipment 

 Binocular 

 Telescope, tripod, digital camera 

 Telephoto camera, tripod 

 Kayak 

 Counter 

 GPS 

 Field sheet/clip board 

 Identification guidebook 

 

3.4 Selection of indicator species 

One of the most critical aspects of the fauna monitoring program is the selection of appropriate 

indicator species. While indicator species may comprise from individual species or group of species 

(e.g. species that belong to the same family or have similar characteristics), there should be a good 

reason for the selection. Hence, experts should be consulted in the selection process. Following are 

some potential indicator species: 

 Species that belong to the top of the food chain, such as herons and swimming crabs (see 

Figure 2.3.8) 
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Figure 2.3.8  Photo of heron (left) and swimming crab (right) 

 

 Species that play a key role in the mangrove ecosystem food chain such as leaf eating 

sesarmid crabs and mudwhelks (see Figure 2.3.9). 

   

Figure 2.3.9  Photo of sesarmid crab (left) and mudwhelk (right) 

 

 Species that are very common in the mangrove ecosystem such as fiddler crabs and gobies 

(see Figure 2.3.10). 

 

   

Figure 2.3.10  Photo of fiddler crab (left) and goby (right) 

 

In addition, the following factors should be considered in the selection process: 

 The indicator species should be selected from various habitat types within the mangrove 

ecosystem (e.g. waterway, mudflat and forest areas) 

 Monitoring of the selected species is cost effective and relatively easy (even possible by 

non-experts) 

 The ecology of the selected species is well known (e.g. food, behavior, habitat) 

 

3.5 Monitoring of indicator species 

In principal, indicator species are monitored by estimating their abundance through field survey 

and then comparing the results between successive surveys. The field survey method should be 

determined in accordance to the type of indicator species selected, but should be relatively easy so 
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that non-experts (e.g. local citizens) can also participate. Following is an example monitoring method 

in case fiddler crabs are selected: 

 

Step 1: Look for an area where fiddler crabs are predominant. Select an appropriate survey area (e.g. 

10 m x 10 m) and mark the boundaries with a stake (see Figure 2.3.11). 

 

Figure 2.3.11  Selection of survey area 

 

Step 2: Randomly place several 1 m x 1m quadrats (e.g. 10 quadrats) inside the survey area (see 

Figure 2.3.12). 

 

Figure 2.3.12  Placement of quadrat 

 

Step 3: Count the number of crab burrows inside each quadrat and recorded it onto a field sheet (see 

Figure 2.3.13). 
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Figure 2.3.13  Counting of crab burrows 

 

Step 4: Estimate the number of crab burrows per square meter (m2) of the survey area through the 

following formula: 

No. of crab burrows/m2 = total no. of crab burrows / number of quadrats 

 

Step 5: Conduct the same survey after a set period at the same survey area and compare the values. 

Any significant decrease in the values may indicate that the crab population is decreasing, and its 

cause should be investigated. 

 

3.6 Investigation of possible causes of population change 

If significant changes of indicator species population are identified between successive surveys, 

investigate possible causes that may have affected the abundance of indicator species. Also refer to 

the monitoring results of the other monitoring components (e.g. monitoring results of environmental 

condition and socioeconomic activities). Following are possible factors that may affect abundance of 

indicator species. 

 Degradation of water quality (e.g. eutrophication) 

 Change in hydrology of the waterway (e.g. closure of lagoon mouth) 

 Reduction of mangrove leaf litter 

 Intrusion of invasive species 

 Illegal fishing 

 Excessive expansion of mangrove 
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4. Monitoring method of environmental conditions 

4.1 Introduction 

Monitoring of environmental condition is important, as mangroves and fauna are influenced by the 

conditions of the ambient environment. Of particular importance are: 

 Water quality 

 Soil quality 

 Topography  

 Water level 

The monitoring methods of the above components are described in the ensuing sections. 

 

4.2 Water quality 

Degradation of water quality could have adverse impacts on aquatic fauna and mangrove trees. 

Therefore, water quality monitoring consists of parameters that are relevant to both aquatic fauna 

and mangrove trees. Monitoring should be conducted at least 2/year, but should be conducted more 

frequently at sites where the risk of water quality degradation is high. 

 

4.2.1 Water quality parameters 

In general, the following water quality parameters should be monitored: 

 Water temperature 

 Salinity 

 pH 

 Dissolved oxygen (DO) 

 Chemical Oxygen Demand (COD) 

 Inorganic nutrients (nitrate (NO3-N), nitrite (NO2-N), ammonium (NH4-N), phosphate (PO4-P)) 

Pollutants such as heavy metals, oil and pesticides should also be monitored if there are such 

pollution risks (note that these pollutants are not covered in this Guideline). 

 

4.2.2 Water quality monitoring sites 

In principal, water quality should be monitored at representative areas of the mangrove forest (e.g. 

upstream, midstream and downstream of the waterway). In order to select a representative site, the 

biological (e.g. fish habitat) and physical (e.g. topography, hydrology) characteristics of the mangrove 

site should be considered. Water quality should also be monitored at areas where there are high risks 

of water pollution (e.g. areas receiving wastewater inflow).  

If water is shallow (e.g. less than 1 m), monitoring of the surface layer should be sufficient. If water 

is deep (e.g. more than 1 m), try to monitor the bottom layer as well. 

 

4.2.3 Field survey procedure 

Following are basic field survey procedures (sample field sheet is included in the attached CD): 

 In principal, monitoring should be conducted twice, once each during flood and ebb tides (see 
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Figure 2.4.1). So plan the timing of survey carefully by checking the local tide chart. Field 

survey should preferably be conducted by at least 2-3 surveyors. 

 

 

 

 

 

 

 

 

Figure 2.4.1  Timing of water quality monitoring 

 

 Record basic information about the survey sites such as: location (GPS coordinate), weather 

and water depth. Water depth may be measured with a measuring pole or portable depth 

sounder.  

 Water temperature, salinity, pH and DO should be measured at the site using portable water 

quality meters. You can either dip the sensor directly into the water or by first collecting water 

samples with a bucket or water sampler (see Figure 2.4.2). Make sure to rinse the bucket or 

water sampler prior to sampling to prevent contamination. Also calibrate the instruments 

prior to use (see Appendix 2 for calibration method). 

  

Figure 2.4.2  Measurement of water quality with portable water quality meters 

 

 COD and inorganic nutrients are analyzed at the laboratory by bringing back water samples. 

Collect around 500 ml of water sample as each parameter requires approximately 100 ml for 

analysis. The water samples should be stored in a cooler box (with ice) when transporting to 

minimize biological breakdown. Appendix 3 shows the analysis procedure of COD and 

inorganic nutrients. 

 

4.2.4 Necessary field survey equipment 

 GPS 

 Field sheet/clipboard 

 Tissue 

High tide 

Low tide Low tide 

Flood 
tide 

Ebb 
tide 

Timing of 
monitoring 

Timing of 
monitoring 
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 Distilled water 

 Wash bottle 

 Measuring pole/portable depth sounder 

 Cooler box/ice 

 Bucket/water sampler 

 Kayak (if water is deep) 

 Sampling bottles 

 Labels and waterproof markers 

 Thermometer 

 Salinity meter 

 pH meter 

 DO meter 

 

4.2.5 Assessment and management of monitoring data 

Once the field survey and laboratory analysis is completed, the data should be recorded into a 

database (sample database format is included in the attached CD). The data may be compared with 

results of previous surveys and other sites or appropriate water quality standards. If any abnormal 

values are recorded, the cause of such abnormality should be investigated. Table 2.4.1 shows 

examples of water quality standards established by other countries for protection of aquatic 

organisms (there are no national water quality standards in Oman). 

 

Table 2.4.1  Examples of water quality standards established by other countries 

(for protection of aquatic organisms) 

Parameter Japan*1 Australia*2 Canada*3 

pH 7.8-8.4 8-8.4 7.0-8.7 
DO >6 mg/l >90 (% saturation) >8 mg/l 

COD 2 mg/l - - 
NOx (NO3

-+ NO2
-) - 8 µgN/l - 

Ammonium (NH4
+) - 10 µgN/l - 

Phosphate (PO4
3-) - 5 µgP/l - 

*1: Fisheries Water Quality Standard 

*2: Australian and New Zealand Guidelines for Fresh and Marine Water Quality (Tropical Australia) 

*3: Canadian Water Quality Guidelines for the Protection of Aquatic Life 

 

4.3 Soil quality 

Soil quality is important for the health of mangrove trees, as they absorb water and nutrients from 

the soil. Therefore, soil quality monitoring should consist of parameters that may affect the health of 

mangrove tree. Soil quality should be measured at two depths: around 10 cm and 40 cm below the 

surface. 

 

4.3.1 Soil quality parameters 

In general, the following soil quality parameters should be monitored: 



Technical Document 2  Mangrove Monitoring Guideline 

31 

 

 Soil texture 

 Soil color 

 Soil temperature 

 Oxidation-Reduction Potential (ORP) 

 Electrical conductivity (EC) 

 Salinity (NaCl) 

 pH 

 Nitrate (NO3-N) 

 Phosphate (PO4-P) 

 

4.3.2 Soil quality monitoring sites 

In principal, soil quality should be monitored at areas adjacent to the mangrove tree monitoring 

sites.  

 

4.3.3 Field survey procedure 

Following are basic field survey procedures (sample field sheet is included in the attached CD): 

 

(1) Collection of soil sample 

Soil samples are collected by using a core sampler, up to a depth of around 50 cm. Samples should 

be collected preferably during low tide. Collect at least 3 samples for each site. 

 

 

Figure 2.4.3  Collection of soil sample with core sampler 

 

(2) Classification of soil texture 

Classify the soil texture into either sandy or muddy by observing and rubbing the soil sample 

between your fingers. Table 2.4.2 shows the general characteristics of sandy and muddy soil. 
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Table 2.4.2  Characteristics of sandy and muddy soil 

Sandy soil Muddy soil 

 Predominantly comprised of sand 
particles (0.125 – 2 mm) 

 Individual soil particles will be visible 
with naked eye 

 Soil will have a gritty feel 

 Predominantly comprised of silt and 
clay particles (0.0625 – 0.0039 mm) 

 Individual soil particles will not be 
visible with naked eye 

 Soil will have a sticky feel 

 

(3) Classification of soil color 

Soil color may give clues to the conditions that the soil is subjected to. Soil can exhibit a wide range 

of color: gray, black, white, red, brown, yellow and so on. Classify soil color by visual observation or 

by using soil-color chart (see Figure 2.4.4), if available. 

 

Figure 2.4.4  Classification of soil color with soil-color chart 

 

(4) Measurement of soil temperature 

Soil temperature is measured by inserting soil thermometer into the soil sample (see Figure 2.4.5).  

 

Figure 2.4.5  Measurement of soil temperature with soil thermometer 

 

(5) Measurement of Oxidation-Reduction Potential (ORP) 

Oxidation-Reduction Potential (ORP) is measured by directly inserting an ORP sensor into the soil 

sample (see Figure 2.4.6). Insert the probe deep into the sample. Measurement should be conducted 

as soon as possible after collecting the sample, as values will change quickly once exposed to air.  
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Figure 2.4.6  Measurement of ORP with ORP meter 

 

(6) Measurement of EC, salinity, pH 

EC, salinity and pH can be measured in the field by first preparing a 1:5 ratio soil/water suspension. 

Figure 2.4.7 shows the procedure of measuring EC, salinity and pH with 1:5 ratio soil/water 

suspension. 
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Step 1: Pour 50 ml of distilled water into a 

measuring cylinder 

 

Step 2: Add soil sample until the water/soil 

mixture increase to 100 ml. 

 

Step 3: Add additional distilled water to bring the 

water volume to 300 ml. 

 

Step 4: Shake intermittently for 5 minutes. 

 
Step 5: Allow the suspended soil to settle (e.g. 5 

min.) 

 

Step 6: Dip the sensor into the solution and take a 

reading. 

Note: The described volume is an example.  

Figure 2.4.7  Procedure of measuring EC, salinity and pH with 1:5 ratio soil/water suspension 

 

(7) Measurement of nitrate (NO3
-) and phosphate (PO4

3-) 

Plants require an adequate supply of nutrients, particularly nitrate and phosphate. Nitrate and 

phosphate are analyzed at the laboratory by collecting water from the 1:5 ratio soil/water suspension. 

The water samples should be stored in a cooler box (with ice) when transporting to minimize 

biological breakdown. Approximately 100 ml of water sample is required for each parameter. The 
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analysis procedure is same as the water quality (see Appendix 3). 

 

4.3.4 Necessary field survey equipment 

 GPS 

 Field sheet/clipboard 

 Labels and waterproof markers 

 Cooler box/ice 

 Soil sampler 

 Water sampling bottle 

 Soil color chart 

 Distilled water 

 Measuring cylinder (around 500 ml) 

 Soil thermometer 

 ORP meter 

 EC meter 

 pH meter 

 

4.3.5 Assessment and management of monitoring data 

Once the field survey and laboratory analysis is completed, the data should be recorded into a 

database (sample database format is included in the attached CD). The obtained data may be 

compared with results of previous surveys and other sites or appropriate soil quality standards. If any 

abnormal values are recorded, the cause of such abnormality should be investigated. Table 2.4.3 

shows the tolerance level of plants against varying salinity levels. 

 

Table 2.4.3  Tolerance level of plants against varying salinity levels 

Salinity rating ECse* (dS/m) Effect 

Slightly saline 1.5-2 Salinity effects usually minimal 
Moderately saline 2-6 Yield of salt sensitive plants restricted 

Highly saline 6-15 Only salt tolerant plants yield satisfactorily 
Extremely saline >15 Few salt tolerant plants yield satisfactorily 

*: Electrical conductivity (EC) value of saturated extract. The above values are applicable if EC levels are measured on 

a saturated extract.  

Source: Queensland Government 

 

Totally anoxic sediments have redox potentials below -200 mV, while typical oxygenated soils have 

potentials of above +300 mV. 

 

4.4 Topography 

Topographic alterations may have significant impacts on mangrove ecosystem. One of the major 

concerns is the decrease in the depth or closure of the lagoon mouth, which may occur through 

natural or human induced coastal accretion or erosion process. Such alterations will significantly 
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change the lagoon hydrology and as a consequence degrade the mangrove forest and ecosystem 

through reduced water exchange, water stagnation or ultimately drying-up of the waterway. The 

Guideline provides two approaches for monitoring the topography of the lagoon mouth. 

 

4.4.1 Photo monitoring 

The topography of the lagoon mouth may be monitored by taking photographs of the mouth from 

a fixed location and height at regular intervals (e.g. 2/month). Following are the basic procedures: 

 Try to choose a location where you can have a good overall view of the mouth (see Figure 

2.4.8). Record the location with GPS. 

 

 

Figure 2.4.8  Example of photo monitoring 

 

 If possible, install at the monitoring location a permanent stake with a platform for placing 

camera (see Figure 2.4.9).  

 

Figure 2.4.9  Example of platform for photo monitoring 

 

 Take photographs of the mouth and upload the photograph into a database (sample database 

format is included in the attached CD). Try to take photographs during similar tide levels. 

 

4.4.2 Sedimentation monitoring 

The topography of the lagoon mouth may also be monitored by measuring the rate of 
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sedimentation. Sedimentation rate is monitored by installing permanent stakes at the lagoon mouth, 

and then measuring the distance between the top of the stake and soil surface at regular intervals 

(e.g. 2/month). A decrease in the distance between successive surveys will indicate that the area is 

under sedimentation. Following are the basic monitoring procedures: 

 Install permanent stakes (e.g. PVC pipe with 1.5 m length) along the cross-section of the inlet 

mouth (see Figure 2.4.10). Make sure the stakes are installed vertically and deep enough (e.g. 

> 50 cm) so that it will not move downward or upward.  

 

 

Figure 2.4.10  Image of permanent stake installation 

 

 Measure the distance between the top of the stake and soil surface (see Figure 2.4.11) and 

record the values into a field sheet and later into the database (sample field sheet and 

database format is included in the attached CD).  

 

 

Figure 2.4.11  Measurement method of sedimentation 

 

 Conduct the same measurement after a set period (e.g. 2 month) and compare the values. 

Make sure to measure the same side of the stake as the previous survey. If the values are less 

than the previous survey, the area can be considered to be under sedimentation. 

 

Alternatively, sedimentation may also be monitored by measuring the cross-section profile of the 
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lagoon mouth with auto level. However, this method will require a fixed reference point and certain 

level of expertise in conducting the measurements and will not be covered in this Guideline. 

 

4.5 Water level 

Long-term elevation of the lagoon water level may have adverse impacts on mangroves, by for 

example, constantly inundating the aerial roots and hindering their respiration. Water level is 

monitored by fixing a permanent stake inside the waterway, and then measuring the distance 

between the top of the stake and water surface (see Figure 2.4.12) at regular intervals (e.g. 2/month). 

A decrease in the distance between successive surveys will indicate that the water level is increasing. 

Note that this method is applicable only for mangrove sites where there is no tidal fluctuation, such 

as at the closed khawrs of Salalah (sample field sheet and database format is included in the attached 

CD. 

 

Figure 2.4.12  Measurement of water level with a permanent stake 

 

5. Inspection monitoring 

To supplement the monitoring surveys described in the preceding sections, regular visual 

inspection surveys should be conducted around the mangrove forest to identify of any presence of 

human or natural threats to the mangrove ecosystem. The frequency of inspection should be at least 

every 2 months. Following are among others some of the threats that should be checked through 

visual inspection: 

 Grazing of mangrove tree by domestic animals (e.g. camels, goats, donkeys) 

 Entanglement of waste on mangrove tree 

 Wastewater discharge 

 Illegal fishing 

 Intrusion of invasive plant species 

 Overgrowth and entanglement of algae on mangrove tree 

 Water stagnation  
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The inspector should walk around the forest recording its route using GPS tracking function. If any 

threats are identified, the inspector should record the type of threat and GPS location into a field 

sheet (sample field sheet is included in the attached CD). Photographs should also be taken at the site. 

Once the inspection is completed, the identified threats, photographs and inspection route should be 

recorded into database (sample database format is included in the attached CD).  
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Chapter 3  Transplanted-seedling Monitoring Program 

 

1. Introduction 

The main objective of the “Transplanted-seedling Monitoring Program” is to monitor the growth 

and health status of the transplanted seedlings, and if unhealthy seedlings are identified, to 

implement protective measures by investigating possible causes. In addition, the data and findings 

obtained through the monitoring activities should be referred to increase the success rate of future 

transplantation activities. The monitoring program consists of the following components: 

 Monitoring of seedling growth 

 Monitoring of seedling health 

 Monitoring of environmental condition 

Monitoring should be conducted as frequently as possible (e.g. 1/month) and continued until the 

seedlings are considered to have stabilized in the new environment (e.g. confirmation of aerial roots). 

The ensuing Sections provide detailed methodologies on the monitoring program (sample field sheet 

is included in the attached CD). 

 

2. Monitoring method 

2.1 Selection of monitoring seedling 

Since it is impractical to monitor all the transplanted seedlings, monitoring activities should focus 

on representative areas of the transplantation site. Once the area is selected, establish a quadrat 

around the target seedlings as shown in Figure 3.2.1. The size and shape of the quadrat should be 

determined in accordance to the configuration of the transplantation. The boundary of the quadrat 

should be marked for example by installing permanent stakes at the corners of the quadrat and then 

connecting them with a rope. Record the GPS coordinates of the quadrat so that the location can be 

identified in the ensuing survey. 

 

 

Figure 3.2.1  Establishment of monitoring quadrat 
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2.2 Monitoring method of seedling growth 

The growth of the seedlings is monitored by measuring stem height, stem diameter and number of 

leaves. Following are the basic monitoring procedures: 

 Select the seedlings to be monitored within the quadrat. The selected seedlings should be 

sufficient in quantity (e.g. more than 10% of the total) and evenly distributed (see Figure 

3.2.2). Tag the selected seedlings by using a numbered tag and cable tie. Do not tie the tags 

too tight as it will stress the stem. 

 

Figure 3.2.2  Example of monitoring seedling selection 

 

 Measure the stem height and diameter of the selected seedlings as shown in Figure 3.2.3. 

 

 

Figure 3.2.3  Measurement of stem height (left) and diameter (right) 

 

2.3 Monitoring method of seedling health 

Seedling health is monitored by visually estimating the ratio of unhealthy seedling (including dead 

seedlings) within the monitoring quadrat. Record the spatial trend of unhealthy seedlings into a field 
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sheet as shown in Figure 3.2.4. Take photographs of the quadrat for later reference. In general, an 

unhealthy seedling will have among others the following characteristics: 

 Low leaf density 

 Small and curled leaf shape 

 Yellowish leaf color 

 Stunted growth 

 

 

 

 

 

 

 

 

 

 

 

Figure 3.2.4  Example of spatial trend of unhealthy seedling 

 

If unhealthy seedlings are found, the causes of unhealthiness should be investigated by considering 

its spatial trend (e.g. high rate of unhealthy seedling in the lower intertidal zone) and possible factors 

that can affect seedling health. Table 3.2.1 shows possible factors that can affect seedling health and 

investigation methods. 

  

Unhealthy seedlings 

Healthy seedlings 

Upper intertidal zone 

Mid intertidal zone 

Lower intertidal zone 
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Table 3.2.1  Possible factors that can affect seedling health and investigation method 

Stress factor Investigation method 

Lack of water supply Lack of water supply may result in 
drying-up of soil and hence lack of 
water for the seedlings. 

Observe whether the monitoring area 
becomes inundated by seawater 
during high tide. Also check whether 
the inlet mouth is not closed. 

Lack of water exchange Lack of water exchange may 
deteriorate water and soil conditions. 

Observe whether the waters around 
the monitoring area recede at low 
tide. Also check whether the inlet 
mouth is not closed. If there is water 
stagnation, measures the DO 
concentration. 

Soil erosion Soil erosion may unstabilize the 
seedlings.  

Observe whether the roots of the 
seedlings are not exposed.  

Infestation by insect 
pests and fungi 

Insect pests can hinder growth for 
example by eating the leaves or 
sucking the sap. 

Observe of any presence of insect 
pests on leaves and stem. 

Entanglement of algae 
and garbage 

Algae and garbage can stress the 
seedling by getting entangled around 
the stem.  

Observe if algae and garbage is not 
entangled around the stem.  

Intrusion of other plant 
species 

Intrusion of other plant species (e.g. 
halophytes) can stress the seedling. 

Observe of any presence of 
halophytes. 

Animal grazing Animal grazing can stress the seedling 
by eating the leaves and branch. 

Observe of any presence of grazing 
on leaves and branch as well as feces. 

High salinity conditions High water and soil salinity will 
hinder seedling growth. 

Measure salinity of adjacent water 
and underlying soil (refer to Chapter 
2 for measurement methods) 

Low oxygen soil 
conditions 

Hypoxic or anoxic soil conditions will 
hinder seedling growth. 

Measure oxidation-reduction 
potential of the underlying soil (refer 
to Chapter 2 for measurement 
methods) 

 

2.4 Monitoring method of environmental condition 

In general, water and soil quality should be monitored. If possible, measure all the monitoring 

parameters covered in the “Mangrove Ecosystem Monitoring Program”. However, if that is difficult, 

try at least to monitor parameters that can be measured in situ with portable meters. Topography 

and water level should also be monitored if considered necessary. 

 

2.5 Necessary field survey equipment 

 GPS 

 Camera 

 Field sheet/clipboard 

 Stake/rope/hammer 

 Tag and cable tie 

 Tape measure and caliper 

 DO meter 

 Soil sampler 

 Distilled water 
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 Measuring cylinder 

 ORP meter 

 Salinity meter or refractometer 

 

2.6 Management of monitoring data 

The monitoring data should be stored into a database, which should include the following 

information (sample database format is included in the attached CD): 

 Site information (location and characteristics of the monitoring sites) 

 Survey conditions (date, time, weather, tide level etc.) 

 Results of stem height and diameter measurement 

 Results of seedling health survey and possible stress factors 

 Photographs of the surveyed quadrat 
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1. Introduction 
 
Remote  sensing  and  geographical  information  system  (GIS)  have  emerged  as  invaluable 
technologies  for  ecosystem  analysis,  evaluation,  and  monitoring.  They  have  been  used 
worldwide  in  several  projects  dealing with  prioritizing  and  analyzing  resource management 
alternatives including the monitoring of mangrove.  
 
As  part  of  the  Qurm  Environmental  Information  Center  (QEIC)  project  by  the  Ministry  of 
Environment  and Climate Affairs  (MECA)  and  Japan  International Cooperation Agency  (JICA), 
remote  sensing  technology  (satellite  image)  was  considered  as  an  effective  method  for 
monitoring and assessment of the health status of mangrove forests in Oman.  
 
While there are various approaches for monitoring mangrove forest, this Guideline focuses on 
the  use  of  Normalized  Difference  Vegetation  Index  (NDVI),  which  is  a  common  index  of 
vegetation health.  In general, high NDVI value will  indicate healthy vegetation but there  is no 
established threshold value to differentiate healthy and unhealthy mangrove. The health status 
will therefore be assessed by comparing the NDVI values between target and baseline years. In 
other words, a decrease in the NDVI value from the baseline year may imply that the mangrove 
forest is in a degraded state. Moreover, since mangroves have seasonal variation in health, it is 
preferable  to  compare  images  between  the  same  seasons. Ground‐truth works will  also  be 
important to verify the results. 
 
The  Guideline  explains  the  basic  assessment  procedures  by  using  the  image  processing 
software,  ENVI  and  satellite  images  of Qurm Nature  Reserve  (October  2011  and  September 
2012). Therefore,  the prerequisite  for using  this Guideline  is  fundamentals of  remote sensing 
and familiarity with the use of ENVI software. The Guideline also provides brief explanations on 
available satellite images and basic functions of ENVI. 
 
 
2. Available satellite imagery 
 
2.1 Landsat satellites 
 
Landsat MSS with a spatial resolution of 80 m per pixel and four spectral bands was launched by 
the  United  States  Space  and  Administration  Agency  (NASA)  in  1972.  Landsat  TM  with  an 
improved spatial and spectral resolution was  launched  in 1984. Landsat 1 to 3 were equipped 
with the MSS sensor whereas Landsat 4 and 5 had TM sensors. Landsat 7, which was launched 
on April 15, 1999, and still active, has the ETM+ sensor. Landsat 8 was launched on February 11, 
2013. Landsat 8 carries a ETM+ sensor, a new band 9 for cirrus cloud detection and two thermal 
bands  10  and  11  with  spatial  resolution  of  100  m.  Landsat  TM  and  ETM+  sensors  are 
multispectral  radiometers  capable  of  providing  medium‐resolution  images  of  the  Earth’s 
surface  in  spectrally  filtered  radiation  at  the  visible,  near‐infrared,  short‐wave  infrared,  and 
thermal‐infrared wavelengths. For Landsat TM, the nominal pixel resolution  is 30 m  in the six 
visible, near and short‐wave  infrared bands. However, the thermal‐infrared band has a spatial 
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resolution of 120 m  in  the TM, and 60 m  in  the ETM+  sensors,  respectively.  In addition,  the 
ETM+ carries a 15 m panchromatic band. A typical TM and ETM+ scene is 185 by 185 km. Ortho‐
rectified Landsat MSS, TM and ETM+  images data are freely available and can be downloaded 
from the internet (http://earthexplorer.usgs.gov). 

 
2.2 High‐resolution satellites 
 
Commercial satellite companies  launched sub meter ground resolution satellites following the 
deregulation  by  the United  States Government  in  the  1990s.  The  first  commercial  satellite, 
Ikonos, with  one meter  resolution  in  panchromatic  and  4 m multispectral was  launched  by 
Space  Imaging  in  1999.  Since  then  a  range  of  high‐resolution  satellites  have  been  launched 
notably QuickBird, GeoEye, WorldView  and  KOMPSAT. GeoEye,  launched  by Digitalglobe  on 
Septermber 6, 2008 is highest available commercial satellite with a ground resolution of 41 cm 
in  panchromatic  and  1.65  m  in  four  multispectral  bands  in  the  visible  and  near‐infrared 
wavelengths (Table 1). 
 

Table 1 Characteristics of GeoEye spectral bands 

Sensor  Spectral bands Wavelength (µm) 

GeoEye 1‐2  Panchromatic  0.450‐0.900 

Band 1 (Blue)  0.450‐0.520 

Band 2 (Green)  0.529‐0.600 

Band 3 (Red)  0.625‐0.695 

Band 4 (Near‐infrared)  0.760‐0.800 

 
 
3. Basic functions of ENVI 
 
There are several available commercial and free software for digital image processing of remote 
sensing  data.  The  analysis  in  this  Guideline  is  based  on  ENVI,  which  is  one  the  leading 
commercial image processing software. 
 
ENVI  software provides  a WINDOWS‐NT based environment with  an  intuitive point‐and‐click 
graphical user interface. Most functions in ENVI are assessed through icons, pull down and form 
menus, where  text dialog boxes, buttons and scroll bars make  it simple  to set all parameters 
before a  function  is applied  to a displayed  image. Help documents,  tour and  field guides are 
available for further  information. Some selected basic functions are described below. Refer to 
the ENVI tutorial ENVI_intro.pdf (ENVI, 2003) for more details. A file named Qurm‐GeoEye‐sept‐
18‐2012.dat  which  is  GeoEye  satellite  image  of  the  Qurm  National  Park  area  recorded  on 
September 18, 2012 is used in the illustrations below. The step‐by‐step instructions below are 
taken from ENVI tutorials (ENVI, 2003) and the online ENVI Help. 
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3.1 Loading a grayscale or color images 
 
1) Grayscale Image 
Opening an Image File: 
- From the ENVI main menu bar, select File > Open Image File. 
- Navigate to the Qurm‐GeoEye‐sept‐18‐2012.dat file and click Open 

 

 
 
The list of available GeoEye bands is provided as shown in the above figure. 
 
- Select Band 1. The band you have chosen is displayed in the field marked Selected Band. 
- Click the Gray Scale radio button then click Load Band to load the image into a new display. 

Band 1 will be loaded as a grayscale image.  
 

2) Color Image 
- To display GeoEye band 421 in RGB from a Qurm‐GeoEye‐sept‐18‐2012.dat. 
- Click the RGB Color radio button, then select Band 4 Qurm‐GeoEye‐sept‐18‐2012.dat. The 

band you have chosen is displayed in the field marked R (see figure below) 
- Select Band 2. The band you have chosen is displayed in the field marked G.  
- Select Band 1. The band you have chosen is displayed in the field marked B.  
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- Click Display #1 and select New Display.  
- Click Load RGB to load the image into a new display.  

 

 
 

3.2 Displaying the cursor location and value 
 
- To display the cursor location and value, select Window >Cursor Location/Value from 

either the ENVI main menu bar or the Display group menu bar. You can also right‐click in 
the Image window and select Cursor Location/Value.  

- Move the mouse cursor over the Image, Scroll, or Zoom windows to display location and 
value information in the Cursor Location/Value dialog. 

- Double‐click in the Image window to hide the Cursor Location/Value dialog. Double‐click 
again to show the Cursor Location/Value dialog. 

- From the Cursor Location/Value menu bar, select File >Cancel to close the dialog. 
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3.3 Displaying image profiles  
 
- From the Display group menu bar, select Tools > Profiles > X Profile to display a window 

plotting data values versus sample number for a selected line in the image. 
- From the Display group menu bar, select Tools > Profiles > Y Profile to display a plot of data 

value versus line number. 
- From the Display group menu bar, select Tools > Profiles > Z 

Profile to display a spectral plot. You can also open a Z profile from the right‐click menu in 
any Image window.  

- From the Display group menu bar, select Window > Mouse Button Descriptions to view the 
descriptions of the mouse button actions in the Profile displays. 

- A red crosshair extends to the top and bottom and to the sides of the Image window. The 
red lines indicate the line or sample locations for the vertical or horizontal profiles. Move 
the crosshair around the image (just as you move the Zoom box) to see the three image 
profile plots update to display data on the new location. 

- Close the profile plots by selecting File > Cancel from the menu bar within each window.  
 
3.4 Performing quick contrast stretching  
 
You can perform quick contrast stretches using default parameters and data from either the 
Image window, the Zoom window, or the Scroll window. 
 
- From the Display group menu bar, select Enhance and apply various contrast stretches 

(Linear, Linear 0‐255, Linear 2%, Gaussian, Equalization, and Square Root).  
- Compare the effects of the various stretches on the display group.  
 
3.5 Displaying interactive scatter plots  
 
You can plot the data values of two selected image bands versus each other in a scatter plot to 
graphically display the overlapping values. 
 
- From the Display group menu bar, select Tools >2D Scatter Plots. The Scatter Plot Band 

Choice dialog appears, allowing you to choose the two image bands to compare.  
- Select one band for the x axis and another band for the y axis and click OK. It may take a 

few seconds for ENVI to extract and tabulate the data values. 
- Once the scatter plot has appeared (see image right), position the mouse cursor anywhere 

in the Image window and drag with the left mouse button pressed. Pixel values contained 
in a ten‐pixel by ten‐pixel box surrounding the crosshair will be highlighted in red on the 
scatter plot. 

- From the Display group menu bar, select Window >Mouse Button Descriptions to display 
the functions of the different mouse button actions when applied in the Scatter Plot display.  

- Click and drag the cursor around in the Image window to observe the dancing pixels effect.  
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3.6 Linking two displays  
 
Link the two displays together for comparison. When you link two displays, any action you 
perform on one display (scrolling, zooming, etc.) is echoed in the linked display. To link the two 
displays on your screen, do the following. 
 
- From the Display group menu bar, select Tools > Link > Link Displays. You can also right‐

click in the Image window and select Link Displays. 
- Click OK in the Link Displays dialog to establish the link.  
- Scroll and zoom in one display group and observe as your changes are mirrored in the 

second display.  
 
3.7 Dynamic overlays 
 
ENVI’s multiple dynamic overlay feature allows you to dynamically superimpose parts of one or 
more  linked  images onto another  image. Dynamic overlays are turned on automatically when 
you link two displays, and may appear in either the Image window or the Zoom window.  
 
- Click the left mouse button in one of the Image windows to see the image displays overlaid 

on one another.  
- To create a smaller overlay area, position the mouse cursor anywhere in either Image 

window (or Zoom window) and hold down and drag with the middle mouse button. Upon 
button release, the smaller overlay area is set and a small portion of the linked image will 
be superimposed on the current Image window.  

- Click the left mouse button in the Image window and drag the small overlay window 
around the image to see the overlay effects.  

- Resize the overlay area at by clicking and dragging the middle mouse button until the 
overlay area is the desired size. 

 
3.8 Annotating the image  
 
ENVI’s  flexible  annotation  features  allow  you  to  add  text,  polygons,  color  bars,  and  other 
symbols  to  your plots  and  images.  The Annotation  Text dialog  allows  you  to  choose  from  a 
variety of annotation types. Different types are selected from the Object menu and include Text, 
Symbols,  Rectangles,  Ellipses,  Polygons,  Polylines,  Arrows, Map  Scale  Bars  and  Declination 
Diagrams, Map Keys, Color Table Ramps, and  Images. By default, the Annotation dialog starts 
up with Text selected. Other fields in the dialog let you control the size, color, placement, and 
angle of the annotation text. When you select different annotation types from the Object menu, 
the fields in the dialog change to display options appropriate to the new type.  
 

- From the Display group menu bar, select Overlay >Annotation. 
- Type some text in the text field of the Annotation Text dialog.  
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- Select a font, font size, and color using the fields provided in the dialog, then position the 
mouse pointer in the Image window and click the left mouse button. Your text is displayed 
in the window at the point you clicked. 

- Using the left mouse button, drag the handle (displayed in the image below as a diamond 
shape to the left, bottom of the text) to position the text in the window.  

- You can continue to change the annotation’s properties and position by changing the fields 
in the dialog box or dragging the text or symbol while holding down the left mouse button. 
When you are satisfied with the annotation, click the right mouse button to fix the 
annotation in position.  
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- You can save your image annotation by selecting File>Save Annotation from the 

Annotation Text dialog menu bar. If you do not save your annotation in a file, it will be lost 
when you close the Annotation Text dialog (you will be prompted to save the annotation if 
you close without first saving). You can also restore saved annotation files by selecting 

File> Restore Annotation from the Annotation Text dialog menu bar. 

- To edit an annotation element that has already been set in the image, select 

Object>Selection/Edit from the Annotation Text dialog menu bar.  

- Draw a box around the annotation you wish to edit by clicking and dragging with the left 
mouse button. When the handle reappears, click and drag the handle and annotation to 
move and configure the item just as you would a new annotation.  

- To suspend annotation operations and return to normal ENVI functionality temporarily, 
select the Off radio button at the top of the Annotation Text dialog. This allows you to use 
the scroll and zoom features in your display without losing your annotations. To return to 
the annotation function, select the radio button in the Annotation Text dialog for the 
window you are annotating.  

- Leave your annotation on the Image window as you complete this tutorial  
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3.9 Adding Grid Lines 
 
You can use grid lines to overlay one or more grids on an image. Grids can be pixel‐based or 
map‐coordinate and/or latitude/longitude based (for georeferenced images). Each image 
display can have its own set of grids, which are displayed in the Image, Scroll, and Zoom 
windows.  
 
- From the Display group menu bar, select Overlay > Grid Lines to open the Grid Line 

Parameters dialog box. As soon as you choose this option, an image border is automatically 
added.  

- You can adjust the grid line attributes by setting the line thickness and color and the grid 
spacing by selecting Options > Edit Pixel Grid Attributes from the Grid Lines Parameters 
dialog menu bar. This selection brings up the Edit Pixel Attributes dialog box.  

- In the Edit Pixel Attributes dialog, you can change the color, thickness and grid spacing for 
the labels, lines, box and corners of the grid. When the attributes are set up to your 
satisfaction, click OK in the Edit Pixel Attributes dialog to apply the changes to the grid on 
the images.  

- When you have added a satisfactory grid, click Apply in the Grid Line Parameters dialog.  
 
3.10 Saving and outputting an image  
 
ENVI gives you several options for saving and outputting your filtered, annotated, gridded 
images. You can save your work in ENVI’s image file format, or in several popular graphics 
formats (including Postscript) for printing or importing into other software packages. You can 
also output directly to a printer. 
 
- From the Display group menu bar, select File > Save Image As > Image File to save your 

work in ENVI’s native format (as an RGB file). The Output Display to Image File dialog 
appears. 

- Select 24‐Bit color or 8‐Bit grayscale output.  
- Click the Change Graphic Overlay Selections to select graphics options (including 

annotation and gridlines)  
-  Set border options.  
- Select output to Memory or File using the desired radio button. If output to File is selected, 

enter an output filename. 
- If you select other graphics file formats from the Output File Type drop‐down which, by 

default is set to ENVI, your choices will be slightly different. 
- Click OK to save the image. This process saves the current display values for the image, not 

the actual data values.  
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4. Procedures for mangrove health assessment 

4.1 Color composite images 
 
Satellite  image  color  composites  using  the  visible  and  infrared  bands  can  be  used  in  field 
mapping  as well  as  visual  assessment  of  the  health  of mangrove  forests.  Color  composites 
incorporating  the  near‐infrared  are most  useful  because  of  the  high  reflectance  of  healthy 
vegetation  in  that  region  compared  to  the  visible.  Figs.  1  and  2  show  the  GeoEye  color 
composites  generated  from  bands  3,  2,  and  1  and  from  bands  4,  2,  and  1  acquired  on 
September 18, 2012. In Fig. 2 the near‐infrared, band 4, was projected through a red filter and 
consequently vegetation shows up  in shades of red. Figs 3 and, 4 show similar GeoEye  image 
recorded on October 11, 2011.  
 

 
Fig. 1. GeoEye band 3, 2, and 1 color composite image of Qurm mangrove and surrounding 

areas recorded on September 18, 2012. 
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Fig. 2. GeoEye band 4, 2, and 1 color composite image of Qurm mangrove and surrounding 

areas recorded on September 18, 2012. 

 
Fig. 3. GeoEye band 3, 2, and 1 color composite image of Qurm mangrove and surrounding 

areas recorded on October 11, 2011. 
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Fig. 4. GeoEye band 4, 2, and 1 color composite image of Qurm mangrove and surrounding 

areas recorded on October 11, 2011. 
 
4.2 Georeferencing of images 
 
An  important  component  to  change  detection  or multitemporal  data  analysis  is  radiometric 
calibration and geometric corrections. The images used in this study were georeferenced to the 
UTM zone 40 and WGS84,  the projection used by  the National Survey Authority of Oman,  to 
facilitate  their  comparisons  and  to  map  changes  between  the  two  dates.  In  general  a 
registration of error of less than half of a pixel is accepted. The step‐by‐step instructions below 
are taken from ENVI tutorial and online ENVI Help. 
 
ENVI’s  image  registration and geometric correction utilities allow  the user  to  reference pixel‐
based  images to geographic coordinates and/or correct them to match base  image geometry. 
Ground control points (GCPs) are selected using the Image and Zoom windows for both image‐
to‐image  and  image‐to‐map  registration.  Coordinates  are  displayed  for  both  base  and 
uncorrected  image  GCPs,  along with  error  terms  for  specific warping  algorithms.  Next  GCP 
point prediction allows simplified selection of GCPs. 
 
Warping is performed using resampling, scaling and translation (RST), polynomial functions (of 
order 1 through n), or Delaunay triangulation. Resampling methods supported include nearest‐
neighbor, bilinear  interpolation,  and  cubic  convolution. Comparison of  the base  and warped 
images  using  ENVI’s  multiple  dynamic  overlay  capabilities  allows  quick  assessment  of 
registration accuracy. 
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Use Select GCPs:  Image‐to‐Map  to  select GCPs  for  image‐to‐map  registration. Use  the Zoom 
window to select GCPs. (Image‐to‐map registration requires you to display at least one image.) 
When selecting GCPs, you can select subpixel coordinates. Choose to enter corresponding map 
coordinates manually, from a Vector window, from a base image, or from a GPS link. When you 
select enough points to define a warp polynomial, you can begin to predict GCP locations in the 
warp  image. You can save and  restore GCPs  to and  from  files, and you can change  the color 
labels  and  order  of  the  GCP markers.  See Warping  and  Resampling  for  descriptions  of  the 
warping methods. 
 
- Open the image file and display the desired band.  
- From the ENVI main menu bar, select Map > Registration > Select GCPs: Image to Map. 

The Image to Map Registration dialog appears. 
- If you have more than one image open, select the display group to use from the Input 

Display drop‐down list. If only one image is displayed, it is automatically selected.  
- In the Select Registration Projection list, select the output projection or enter a custom 

projection type.  
- Click OK. The Ground Control Points Selection dialog appears.  
 
Collecting Ground Control Points (Image‐to‐Map)  
 
The procedure for selecting GCPs is similar to that for image‐to‐image registration. 
 
- In the Image window, position the Zoom box over the desired GCP area.  
- In the Zoom window, left‐click on a specific pixel to position the cursor over that pixel or 

portion of that pixel. The coordinates of the selected location appear in the Ground Control 
Points Selection dialog in the Image X and Image Y fields. Subpixel coordinates are supplied 
to provide higher accuracy in selecting GCPs. 

- Select from the following options:  
o Enter GCPs from a base image.  
o Automatically enter map coordinates from vector data.  
o Automatically enter map coordinates from GPS locations.  
o To enter map coordinates from a paper map, enter the easting and northing (or 

latitude/longitude) of the selected GCPs into E and N fields, respectively.  
o To enter the map GCP location from a paper map in latitude and longitude, click 

the toggle button next to the map projection name and enter the values into the 
Lat and Long fields. 
Use negative (‐) longitude for the western hemisphere and negative (‐) latitude 
for the southern hemisphere. 

o To change the latitude and longitude values to degrees, minutes, and seconds, 
click DMS. To use decimal degrees, click DDEG.  

o To return to map projection coordinates, click the projection toggle button. 
The corresponding map projection coordinates are calculated automatically. 

- When you select a desired pixel in the image and enter the map coordinates, click Add 
Point in the Ground Control Points Selection dialog to add the point to the list of GCPs. To 
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view the Image to Map GCP List, click Show List. The Image to Map GCP List appears with 
the GCPs listed in a table. 
When you add a GCP, a marker is placed in the image, which consists of an ID number next 
to an encircled crosshair. The marker indicates the selected pixel (or subpixel location). The 
center of the marker (located under the crosshair) indicates the actual GCP location.  
When you select GCPs from a Vector window, ENVI also places a marker in the Vector 
window. The marker consists of an ID number of the GCP displayed with a +. 

- Add additional GCPs using the same procedure. When you enter enough points, the Image 
to Map GCP List shows the predicted x,y coordinates for the selected warp, the x,y error, 
and the RMS error. 

 

- The Ground Control Points Selection dialog shows the number of GCPs you selected. When 
you select a sufficient number of GCPs to conduct a first‐degree polynomial warp, the total 
RMS error is also displayed. 

 
Tip: For the best registration, try to minimize the RMS error by refining the positions of the 
pixels with the largest errors or by removing them. You can reduce errors by adding more 
points. If you only have a few points, place them near the image corners or widely scatter them 
throughout the image. For details about editing, predicting, and positioning GCPs, see GCP 
Options. For details about managing GCPs, see Managing GCPs. 
 
Entering GCPs from a Base Image  
 
If you have two files containing the same scene and one of the files contains map coordinate 
data, you can use that file as a base image and add GCPs to the image that is not 
georereferenced. 
 
- Open and display a georeferenced image. This is the base image. 
- Open and display a like image that is not georeferenced.  
- From the ENVI main menu bar, select Map > Registration > Select GCPs: Image to Map. 

The Image to Map Registration dialog appears.  
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- Select the non‐georeferenced image as the Input Display and enter projection information. 
Click OK. The Ground Control Points Selection dialog appears.  

- In the Image window of the georeferenced image, right‐click and select Pixel Locator to 
open the Pixel Locator dialog.  

- In the Zoom window of the georeferenced image, left‐click on a specific pixel to position 
the cursor over that pixel or portion of that pixel. The coordinates of the selected location 
display in the Pixel Locator dialog, in sample and line order. 

- In the Zoom window of the non‐georeferenced image, select the same pixel.  
- When you select the desired pixel in both images, click Export in the Pixel Locator dialog. 

The pixel information is exported to the Ground Control Points Selection dialog.  
- In the Ground Control Points Selection dialog, click Add Point. The GCP is added to the non‐

georeferenced image.  
- Add additional GCPs by following the same procedure.  
 
Entering Map GCPs from Vector Windows  
 
If you have a vector file for the area to map‐register, you can extract the map coordinates 
directly from the vector data and load them into the Ground Control Points Selection dialog. 
- Select GCPs from the displayed image. 
- Load the vectors into a Vector window and use the vector cursor positioning capabilities 

(left‐click) to locate a feature corresponding to the feature selected on the image.  
- At the bottom of the Vector Parameters dialog, click Export to enter the map coordinates 

of the vector cursor directly into the Ground Control Points Selection dialog, or select 
Export Map Location from the Vector window right‐click menu.  

- In the Ground Control Points Selection dialog, click Add Point to enter the selected point 
into the registration.  

 
Saving GCPs as Vector Files 
 
To save the GCP points and all the associated information and attributes as an ENVI vector file, 
in the Available Vectors List, select the new registration’s GCP vector layer, and select File > 
Save Memory Layers to File from the Ground Control Points selection dialog menu bar.  
Warping Options  
To use the GCPs to perform registration, select either Options > Warp Displayed Band or 
Options > Warp File from the Ground Control Points selection dialog menu bar. The 
Registration Parameters dialog appears. 
 
 
4.3 Setting of boundary of study area and calculation of surface area 
 
It  is essential to know the general boundary and surface area of the mangrove forest and the 
other surfaces and how they change over time. Two techniques used by ENVI for surface area 
calculation as well as the boundary of the forest area is described below. 
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Use of Regions of Interest (ROIs) 
 
ENVI lets you define regions of interest (ROIs) in your images. ROIs are typically used to extract 
statistics for classification, masking, and other operations.  

- From the Display group menu bar, select Overlay > Region of Interest, or right‐click in the 
Image window and select ROI Tool.  

- Draw a polygon that represents the region of interest by clicking the left mouse button  in 
the  Image window  to establish  the  first point of  the ROI polygon  then  selecting  further 
border points  in sequence by clicking  the  left button again. Close  the polygon by clicking 
the right mouse button, then accept the polygon by clicking the right mouse button again. 
The  middle  mouse  button  deletes  the  most  recent  point,  or  (if  you  have  closed  the 
polygon) the entire polygon.  

- ROIs  can  also  be  defined  in  the  Zoom  and  Scroll windows  by  selecting  the  appropriate 
window radio button in the ROI Tool dialog.  

- When you have  finished defining an ROI,  it  is  shown  in  the dialog  table, with  the name, 
region color, number of pixels enclosed, and other ROI properties.  

- ROIs can also be defined as polylines or as a collection of individual pixels by selecting the 
desired ROI type from the ROI_Type pull‐down menu in the ROI Tool.  

- Click the New Region button.  
- Select an ROI by  clicking  in a  cell of  the  far  left  column of  the ROI Tool  table. An ROI  is 

selected when  its entire  row  is highlighted. An asterisk next  to  the  row also signifies  the 
currently active ROI. Multiple ROIs can be selected by using Shift‐click or Ctrl‐click. All the 
ROIs can be selected by clicking the Select All button. Click and type to edit the values  in 
the cells of the ROI Tool table. Change the name for the region and select a new color.  

- Hide ROIs by selecting them in the table and clicking the Hide ROIs button. Use the Show 
ROIs button to re‐display these hidden ROIs.  

- Go to an ROI in the ENVI display by selecting it and clicking the Goto button.  
- View the statistics for one or more ROIs by selecting them in the table and clicking the Stats 

button.  
- Grow  an  ROI  to  its  neighboring  pixels  within  a  specified  threshold  by  selecting  it  and 

clicking the Grow button. 
- Pixelate  polygon  and  polyline ROIs  by  selecting  them  in  the  table  and  clicking  the Pixel 

button. Pixelated objects become a collection of editable points. 
- Delete ROIs by selecting them in the table and clicking the Delete button.  
- The ROI Tool table also allows you to view and edit various ROI properties, such as name, 

color,  and  fill pattern. Menu options  available  at  the  top of  the ROI  Tool dialog  let  you 
perform other various  tasks, such as calculate ROI means, save your ROI definitions, and 
load saved definitions. ROI definitions are retained  in memory after the ROI Tool dialog  is 
closed, unless you explicitly delete them. ROIs are available to other ENVI functions even if 
they are not displayed.  

- Close the ROI Tool using the menu at the top of the table, select File > Cancel.  
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Measurement Tool 
 
Measurement Tool can be used to get a report on the distance between points in a polygon or 
polyline, and to get perimeter and area measurements for polygons, rectangles, and ellipses. 
- Select one of the following options:  

o From the ENVI main menu bar, select Basic Tools > Measurement Tool.  
o From the Display group menu bar, select Tools > Measurement Tool. 

The Display Measurement Tool dialog appears.  
- In the Display field, enter the number of the display that you want to take measurements 

from.  
- Select the radio button  for the display group window  (Image, Scroll, Zoom)  in which you 

want  to measure. To disable  the measurement  function at any  time, select  the Off  radio 
button. 

- From  the Display Measurement  Tool menu  bar,  select  Type  >  area_shape  you want  to 
measure.  

- From the Display Measurement Tool dialog menu bar, select Units > unit_type. If the pixel 
size  of  the  image  is  not  stored  in  the  header,  and  you  select  any  unit  except  Pixels, 
complete the following steps when the Input Display Pixel Size dialog appears:  

o In the X Pixel Size and Y Pixel Size fields, type the size of the pixels in your image.  
o From the Units drop‐down list, select the unit type.  
o Click OK. 

- From the Display Measurement Tool dialog menu bar, select Area > report_type to specify 
measuring the area in Units2 (for example, meters2), Acres, or Hectares. If you select Acres 
or Hectares, The  Input Display Pixels dialog appears. Enter  the X/Y Pixel  Size,  select  the 
Units from the drop‐down list, and click OK. 
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- From the Display Measurement Tool dialog menu bar, select Options > unit_type to specify 
whether  the measurement  information  is  reported  as  line  segments  (the  default)  or  as 
point coordinates. The options are:  

o Report  as  Points:  To  produce  a  listing  of  the  vertices  coordinates.  The 
coordinates are reported as a pixel location (Pixel (x,y)).  

o Report as Segments: To produce a listing of the line segment distances.  
o Georef  Map  (x,y)  or  Georef  (Lat/Lon):  For  georeferenced  images,  you  can 

produce a listing of the coordinates as either map coordinates or as latitude and 
longitude coordinates. 

- In the display group window, left‐click and draw the shape.  
o For Rectangle or Ellipse type,  left‐click and hold the button and drag the shape 

to the size. To draw a square or circle, middle‐click and hold the button and drag.  
o Right‐click to close the polygon or complete the line.  
o For Polygon type, the distance between the vertices are listed and the perimeter 

and total area are reported when the polygon is closed.  
o For  Polyline  type,  the  distance  between  the  vertices  are  listed  and  the  total 

distance is given when the polyline is completed.  
o For Rectangle  type,  the  lengths of  the  side  segments,  the perimeter,  and  the 

total area are reported.  
o For Ellipse type, the circumference and total area are reported.  
o To erase the shape, right‐click again. 

 
Vector overlays showing the general outline of the mangrove forest, wadi and water, and open 
flat or bare soil are depicted in Fig. 5. From the September 18, 2012 GeoEye image, the general 
mangrove area  is 100.2 hectares, water and wadi within  the mangrove  is 21.89 hectares and 
open  land or bare soil  is 12.96 hectares. The total area of the actual mangrove forest  is 65.37 
hectares. 
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Fig. 5. GeoEye band 4, 2,  and 1  color  composite  image of Qurm mangrove  and  surrounding 
areas recorded on September 18, 2012 with overlays showing the general area of the mangrove 
forest (white) wadi and water (green) and open flat or bare soil (brown). 
 
4.4  Calculation of Normalized Difference Vegetation Index 
 
NDVI (Normalized Difference Vegetation Index) values indicate the amount of green vegetation 
present in the pixel. It is one of the most frequently used index for vegetation analysis. Higher 
NDVI values indicate more green vegetation. ENVI’s NDVI uses the standard algorithm: 

 
In areas with less than 20% vegetation cover, NDVI must be used with caution as the ratio may 
not  show  any  sensitivity  to  vegetation  abundance  (Choudhury  and  Tucker  1987).  NDVI  can 
saturate in dense vegetation conditions when the leave area index becomes high. The value of 
the index ranges from ‐1 to 1. The common range for green vegetation is 0.2 to 0.8. 
 
- From the ENVI main menu bar, select Transform > NDVI. The Input File dialog appears.  
- Select  an  input  file  and  perform  optional  spatial  subsetting,  then  click  OK.  The  NDVI 

Calculation Parameters dialog appears.  
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- Specify  the  Input File Type  (TM, MSS, AVHRR, and  so on)  from  the drop‐down  list. ENVI 
automatically enters the bands it uses to calculate the NDVI in the Red and Near IR fields. 
To  calculate  the NDVI  for a  sensor  type not  listed  in  the drop‐down  list, enter  the band 
numbers in the Red and Near IR fields. 

- Select output to File or Memory.  
- Select one of the following output types from the Output Data Type drop‐down list.  

o Byte: Enter the Min and Max NDVI value in the fields supplied.  
o Floating Point  

- Click OK. ENVI adds the resulting output to the Available Bands List.  
 
NDVI image of the September 18, 2012 and that of October 11, 2011 are portrayed in Figs.6 and 
7. 
 
 

 
Fig. 6. GeoEye NDVI image of Qurm mangrove and surrounding areas recorded on September 

18, 2012. 
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Fig. 7. GeoEye NDVI image of Qurm mangroves and surrounding areas recorded on October 11, 

2011. 
 
4.4 Comparison of NDVI values 
 
Several  change  detection  techniques  applied  to  satellite  digital  images  have  been  used 
successfully.  Some  of  these  include  image  difference,  ratioing,  principal  component  analysis 
(PCA), and selective principal component analysis  (Jensen and Toll, 1982; Singh, 1989, Chavez 
and Kwarteng 1989, Chavez and MacKinnon 1994, Kwarteng and Chavez, 1998).  In this study, 
selective principal component was used to map changes between the two dates. The technique 
uses either two bands from the same image or one band from each of the two images as input 
to  principal  component  analysis—a  statistical  technique  that  rotates  the  axes  of  a 
multidimensional  image space  in the direction of maximum variance. Two bands recorded on 
different dates were used as input to the PCA. The first component (PC1) maps information that 
is  common  to  both  images  (topography  and  surface  reflectance)  whereas  the  second 
component (PC2) maps the temporal contrast between the input images (Chavez and Kwarteng, 
1989;  Kwarteng  and  Chavez,  1998).  NDVI  change  image  was  generated  from  the  second 
principal components (PC2) of GeoEye NDVI images recorded in 2011 and 2012. 
 
Principal  Components  is  used  to  produce  uncorrelated  output  bands,  to  segregate  noise 
components, and to reduce the dimensionality of data sets. Because multispectral data bands 
are often highly correlated,  the principal components  (PC)  transformation  is used  to produce 
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uncorrelated output bands. This is done by finding a new set of orthogonal axes that have their 
origin at the data mean and that are rotated so the data variance is maximized.  
 
Principal  component  bands  are  linear  combinations  of  the  original  spectral  bands  and  are 
uncorrelated. You can calculate the same number of output PC bands as input spectral bands. 
The  first PC band  contains  the  largest percentage of data  variance  and  the  second PC band 
contains the second  largest data variance, and so on. The  last PC bands appear noisy because 
they  contain very  little variance, much of which  is due  to noise  in  the original  spectral data. 
principal components bands produce more colorful color composite images than spectral color 
composite images because the data is uncorrelated. ENVI can complete forward and inverse PC 
rotations. 
 
Calculating Forward PC Rotations using ENVI 
The forward PC rotation uses a linear transform to maximize the variance of the data. When 
you use forward PC rotation, ENVI allows you to calculate new statistics or to rotate from 
existing statistics. You can save the output of either as byte, floating‐point, integer, long integer, 
or double precision values. You also have the option to subset the output of the PC rotation 
based on eigenvalues, and to generate output of only the PC bands that you need.   
 
Computing New Statistics and Rotating 
Use Compute New Statistics and Rotate to calculate the eigenvalue and covariance or 
correlation statistics for your data and to calculate the forward PC rotation transform. 
 
- From the ENVI main menu bar, select Transform > Principal Components > Forward PC 

Rotation > Compute New Statistics and Rotate. The Input File dialog appears. 
- Select the input file and perform optional spatial and spectral subsetting, and/or masking, 

then click OK. The Forward PC Parameters dialog appears. 
-  
Note: If you have any bad bands in your dataset, you should use spectral subsetting to exclude 
them from PC analysis. When bad bands are set to the same values as adjacent bands, when 
they are interpolated from nearby bands, when they are set to a constant value, or when they 
contain zero variance or large outliers, a “singularity” problem is encountered where the band 
becomes a near‐perfect linear combination of other bands. This may cause the “Too May 
Iterations in TQLI” error message to appear when you calculate the forward PC rotation. 
 
Click Stats Subset to calculate the statistics based on a spatial subset or the area under an ROI. 
The calculated statistics are applied to the entire file or to a spatial subset of the file. See 
Statistics Subsetting for details. 
 
- Enter the Stats X/Y Resize Factors less than 1 in the appropriate fields to sub‐sample the 

data when calculating the statistics. This increases the speed of the statistics calculations. 
For example, using a resize factor of 0.1 will use every 10th pixel in the statistics 
calculations. 

- In the Output Stats Filename [.sta] field, enter a filename for the noise statistics.  
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- Select whether to calculate the PCs based on the Covariance Matrix or Correlation Matrix 
using the toggle button. Typically:  

o Use Covariance Matrix when calculating the principal components.  
o Use Correlation Matrix when the data range differs greatly between bands and 

normalization is needed. 
- If you applied a mask, enter a value for the output results in the Output Mask Value field. 

ENVI applies the mask for the statistics calculation and the masked areas of the output 
dataset are set to the entered mask value.  

- Select output to File or Memory.  
- From the Output Data Type drop‐down list, select the data type of the output file.  
- To use a subset from eigenvalues, use the Select Subset from Eigenvalues toggle button to 

select Yes or No.  
- If you chose No to selecting a subset from eigenvalues, select the Number of Output PC 

Bands. The default number of output bands is equal to the number of input bands.  
- Click OK.  
 
If you chose No to selecting a subset from eigenvalues, ENVI performs the transform and adds 
the output to the Available Bands List. The PC Eigenvalues plot window also appears. For 
information on editing and other options in the Eigenvalue plot window, see Using Interactive 
Plot Functions. 
 
If you chose Yes to selecting a subset from eigenvalues, the Select Number of Output Bands 
dialog appears. Each band is listed with its corresponding eigenvalue and the cumulative 
percentage of data variance contained in each IC band. Do the following: 

o Select the Number of Output IC Bands. IC Bands with large eigenvalues contain 
the largest amounts of data variance, while bands with lower eigenvalues 
contain less data information and more noise. Sometimes, it is best to output 
only those bands with large eigenvalues to save disk space.  

o Click OK. ENVI performs the transform and adds the output to the Available 
Bands List. The output IC rotation contains only the number of bands that you 
selected. For example, if you chose 4 as the number of output bands, only the 
first four IC bands appear in your output file.  

 
Rotating from Existing Statistics 
If you have already calculated covariance and eigenvalue statistics for your data, you can use 
them as input into the PC rotation. You can use any statistics file in the PC rotation that 
contains covariance and eigen statistics for the same number of bands as your input data. (You 
may have already calculated these statistics using the Basic Tools > Statistics option or during a 
previous PC rotation session.) 
 
- From the ENVI main menu bar, select Transform > Principal Components > Forward PC 

Rotation > PC Rotation from Existing Stats. The Input File dialog appears.  
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- Select an input file and perform optional spatial subsetting, and/or masking, then click OK. 
The Enter Statistics Filename dialog appears with all of the existing statistics files in the 
current input data directory listed, using the default file extension .sta.  

- Select the statistics file. The Forward PC Parameters dialog appears.  
- Select whether to calculate the PCs based on the Covariance Matrix or Correlation Matrix 

using the toggle button. Typically:  
o Use Covariance Matrix when calculating the principal components.  
o Use Correlation Matrix when the data range differs greatly between bands and 

normalization is needed. 
- Select output to File or Memory.  
- From the Output Data Type drop‐down list, select the data type of the output file.  
- Select the number of output PC bands by using one of the following options:  

o To select the number of output bands without examining the eigenvalues, select 
No from the Select Subset from Eigenvalues toggle button, then set the Number 
of Output PC Bands.  

o To select the number of output MNF bands by examining the eigenvalues, use 
the following steps: 

A. Select Yes from the Select Subset from Eigenvalues toggle button.  
B. Click OK. ENVI calculates the statistics and the Select Output PC Bands dialog 

appears, with each band listed with its corresponding eigenvalue. Also listed is 
the cumulative percentage of data variance contained in each PC band for all 
bands.  

C. Set the Number of Output PC Bands. For the best results, and to save disk space, 
output only those bands with high eigenvalues. Images with eigenvalues close to 
1 are mostly noise.  

- Click OK. When ENVI finishes processing, the PC Eigenvalues plot window appears and the 
PC bands are added to the Available Bands List. For information on editing and other 
options in the Eigenvalue plot window, see Using Interactive Plot Functions.  

 
Fig. 8 shows that the NDVI values of the mangrove acquired on September 18, 2012 is between 
0.3‐0.6. The NDVI image recorded on October 11, 2014 show slightly higher values from 0.3 to 
0.7 (Fig. 9) than the September 20 2012  image. The NDVI change  image portrays  insignificant 
changes between 2011 and 2012 (Fig 10). In the forest area the changes are between ‐0.1 and 
0.1 
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Fig. 8. GeoEye NDVI image of Qurm mangrove acquired on September 18, 2012 showing NDVI 
ranges. The overlays show the general area of the mangrove forest (white) wadi and water 
(brown) and open flat or bare soil (black). 
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Fig. 9. GeoEye NDVI  image of Qurm mangrove  acquired on October 11, 2011  showing NDVI 
ranges.  The overlays  show  the  general  area of  the mangrove  forest  (white) wadi  and water 
(brown) and open flat or bare soil (black) 
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Fig. 10. Change between GeoEye NDVI images recorded on October 11, 2011 and September 18, 
2012.  The  overlays  show  the  general  area  of  the mangrove  forest  (white) wadi  and water 
(brown) and open flat or bare soil (black) 
 
5.  Conclusion 
 
With  improving spatial and spectral resolution data acquired  in the visible,  infrared and radar 
will  continue  to  integral  parts  of  several  projects  dealing  with  ecosystem  evaluation  and 
analysis including analysis of mangrove forests. This manual is intended to be an addition aid to 
mangrove analysis and evaluation in conjunction with fieldwork. 
 
Remote sensing analysis and fieldwork indicate that the mangrove forest at Qurm National Park 
is  stable.  It  is  recommended  that high‐resolution  satellite  imagery  should be used  for health 
assessment and change detection studies at  least every one or  two years. From such  studies 
and changes could be monitored. 
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pH meter (SevenGo TM SG2) 
 
1) Buffer groups  
The pH meter allows you to perform 1‐,2‐ and 3‐ point calibrations. If you select your calibration buffer 
group  from  one  of  the  four  predefined  groups  defined  in  the meter,  the  buffers  are  automatically 
recognized and displayed during calibration (auto buffer recognition). The four predefined buffer groups 
are:  
 

B1  7.00  4.00 10.01 1.68   (at 25 °C) 

B2  7.00  4.01 9.21 2.00 11.00  (at 25 °C) 

B3  7.00  4.00 9.00 2.00 12.00  (at 20 °C) 

B4  6.86  4.01 9.18 1.68   (at 25 °C) 

 
Tables (B1…B4) for automatic temperature compensation are programmed in the meter.  
 
2) Performing a 1‐point calibration  
Place  the  electrode  in  a  calibration  buffer  and  press  Cal.  The  meter  endpoints  according  to  the 
preselected endpoint mode after the signal has stabilized or after pressing Read the meter display and 
freezes  the  relevant buffer  value.  The offset  value  and  the  slope  are  then  shown on  the display.  To 
accept the calibration and return to sample measurement, press Read. To reject the calibration, press 
Exit. 
 
3) Performing a 2‐point calibration 

‐ Step  1  Perform  the  first  point  calibration  as  described  above  in  “Performing  a  1‐point 
calibration”. 

‐ Step 2 Rinse the electrode with deionized water.  
‐ Step 3 Place the electrode in the next calibration buffer and press Cal. 

 
The meter endpoints according  to  the preselected endpoint mode after the signal has stabilized after 
pressing Read. The meter displays and  freezes  the relevant buffer value, updates the electrode offset 
and shows the new slope calculated from the two calibration points.  
To  accept  the  calibration  and  return  to  sample measurement,  press Read.  To  reject  the  calibration, 
press Exit. 
 
4) Performing a 3‐point calibration  
Perform the same step as described above in “Performing a 2‐point calibration”, and then repeat step 2 
and 3 for the third calibration point.  
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Conductivity meter (SevenGo TM SG3) 
 
1) Selecting a standard  
When using the conductivity meter, you have to select a standard for calibration. 

Press and hold   until the current standard blinks. 
Use the ^ or ˅ key to select  another standard. When the desired standard blinks, press Read to confirm 
your selection. The following three predefined are available: 

‐ 84 µS/cm 
‐ 1413 µS/cm 
‐ 12.88 ms/cm 

Tables for automatic temperature compensation are programmed in the meter for each standard.  
 
2) Perfuming a calibration  
Place the conductivity sensor in the defined calibration standard and press Cal. 
With the default setting, the conductivity meter automatically endpoints when the signal  is stable. To 
manually  endpoint,  press  Read.  The meter  displays  the  value  of  the  standard  followed  by  the  cell 
constant after a few seconds. To accept the calibration and return to sample measurement, press Read. 
To reject the calibration, press Exit. 
 
Note 
To ensure the most accurate conductivity readings, you should verify your cell constant with a standard 
solution regularly and recalibrate if necessary. Use always fresh standards.  
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DO meter (SevenGo TM SG6) 
 
1) Preparing for Calibration 
‐ Before performing a calibration,  the sensor has  to be connected  to  the  instrument  for at  least 6 

hours (Polarization Time) 
‐ Before performing calibration, the membrane must be examined for damage or contamination.  If 

the membrane is dirty, clean carefully with a soft moist cloth. 
 
2) Performing a 1‐Point calibration 
‐ For calibration  in vapour saturated air  (100% O2  ) place  the electrode  in a bottle 1cm above  the 

water surface as shown in the graphic below. 
 

 
 
‐ Press then Cal. The meter endpoints according to the pre‐selected endpoint settings after the signal 

has stabilized or after pressing Read. 
‐ Terminate calibration by pressing the End soft key. After the reading has end pointed, calibration 

results appear in the display. 
‐ To use the calibration data for later measurements, press Save. 
‐ To discard the calibration data, press Cancel. 
 
Note 
‐ To ensure the most accurate dissolved oxygen readings, it is advisable to calibrate regularly. 
‐ For the 1Point‐calibration, the sensor must be removed from the medium, gently cleaned and dried. 

Water droplets on the membrane must be removed because they prevent the sensor  from being 
correctly calibrated. 
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Analysis procedure of COD and inorganic nutrients   

using HACH DR890 portable colorimeter 
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Nitrate nitrogen (NO3‐N): Method 8192 
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Method 8192
NITRATE, Low Range (0 to 0.50 mg/L NO3

--N) 

For water, wastewater and seawater*

Cadmium Reduction Method

* Seawater requires a manual calibration; see Interferences.

1.  Enter the stored 
program number for low 
range nitrate nitrogen 
(NO3

--N).

Press: PRGM

The display will show:

PRGM ?
Note: For most accurate 
results, perform a Reagent 
Blank Correction using 
deionized water (see 
Section 1).

2.  Press: 55 ENTER

The display will show 
mg/L, NO3-N and the 
ZERO icon.
Note: For alternate forms 
(NO3), press the 
CONC key.

3.  Fill a 25-mL 
graduated mixing 
cylinder to the 15-mL 
mark with sample.

Note: Adjust the pH of 
stored samples before 
analysis.

4.  Add the contents of 
one NitraVer 6 Nitrate 
Reagent Powder Pillow 
to the cylinder. Stopper.

Note: It is necessary to 
remove all the powder from 
the foil pillow. Tap the 
pillow until no more 
powder pours out. Be sure 
to remove powder from the 
corners of the pillow.
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5.  Press: 

TIMER ENTER

A 3-minute reaction 
period will begin.  Shake 
the cylinder vigorously 
throughout this three 
minute period.

Note: Shaking time and 
technique influence color 
development.  For most 
accurate results, analyze a 
standard solution several 
times and adjust the 
shaking time to obtain the 
correct result.

6.  When the timer 
beeps, the display will 
show: 2:00 TIMER 2

Press: ENTER

A 2-minute reaction 
period will begin.

Note: A deposit will remain 
after the powder dissolves 
and will not affect results.

7.  When the timer 
beeps, pour 10 mL of the 
sample into a 
sample cell.

Note: Do not transfer any 
cadmium particles.

8.  Add the contents of 
one NitriVer 3 Nitrite 
Reagent Powder Pillow 
to the sample cell (the 
prepared sample). Cap 
the cell and shake gently 
for 30 seconds.

Note: A pink color will 
form if nitrate is present.

9.  The display will 
show: 15:00 TIMER 3

Press: ENTER

A 15-minute reaction 
period will begin. 

Fill another sample cell 
(the blank) with 10 mL 
of sample.

10.  When the timer 
beeps, place the blank 
into the cell holder. 
Tightly cover the sample 
cell with the 
instrument cap.

11.  Press: ZERO

The cursor will move to 
the right, then the 
display will show:

0.00 mg/L NO3-N
Note: If Reagent Blank 
Correction is on, the 
display may flash “limit”. 
See Section 1.

12.  Place the prepared 
sample into the cell 
holder. Tightly cover the 
sample cell with the 
instrument cap.

NITRATE, Low Range, continued 
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Sampling and Storage
Collect samples in clean plastic or glass bottles.  Store at 4 °C (39 
°F) or lower if the sample is to be analyzed within 24 to 48 hours.  
Warm to room temperature before running the test.  For longer 
storage periods, adjust sample pH to 2 or less with sulfuric acid, 
ACS (about 2 mL per liter).  Sample refrigeration is still required.

Before testing the stored sample, warm to room temperature and 
neutralize with 5.0 N Sodium Hydroxide Standard Solution. Do 
not use mercury compounds as preservatives. Correct the test 
result for volume additions; see Correction for Volume Additions 
(Section 1) for 
more information.

13.  Press: READ

The cursor will move to 
the right, then the result 
in mg/L NO3

--N 
(or alternate form) will 
be displayed.

Note: Standard Adjust may 
be performed using a 
prepared standard 
(see Section 1).
Note: Rinse the sample cell 
and cylinder immediately 
after use to remove all 
cadmium particles.

Note: See Pollution 
Prevention and Waste 
Management for proper 
disposal of cadmium.

NITRATE, Low Range, continued 
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Accuracy Check
Standard additions Method

a) Fill three 25-mL graduated mixing cylinders with 15 mL 
of sample.

b) Snap the neck off a Nitrate Nitrogen Ampule Standard 
Solution, 12.0 mg/L NO3

--N.

c) Using the TenSette Pipet, add 0.1, 0.2, and 0.3 mL of the 
standard to the three samples.  Stopper and mix well.

d) Analyze each sample as described above.  The nitrate 
nitrogen concentration should increase 0.08 mg/L for each 
0.1 mL of standard added.

e) If these increases do not occur, see Standard Additions 
(Section 1) for more information.

Standard Solution Method
Prepare a 0.20 mg/L nitrate nitrogen standard by diluting 2.00 mL 
of a
10.0 mg/L Nitrate Nitrogen Standard Solution to 100.0 mL with 
deionized water. Use this standard in place of sample in Step 3.

Standard Adjust
To adjust the calibration curve using the reading obtained with 
the 0.20-mg/L standard solution, press the SETUP key and scroll 
(using the arrow keys) to the STD setup option. Press ENTER to 
activate the standard adjust option. Then enter 0.20 to edit the 
standard concentration to match that of the standard used. Press 
ENTER to complete the curve adjustment. If you are using a 
reagent blank correction, the blank correction should be entered 
before the Standard Adjust feature is entered. See Section 1, 
Standard Curve Adjustment for more information.

Method Performance
Precision
In a single laboratory using a standard solution of 0.25 mg/L 
nitrate nitrogen (NO3

--N) and two representative lots of reagent 
with the instrument, a single operator obtained a standard 
deviation of +0.03 mg/L nitrate nitrogen.

NITRATE, Low Range, continued 
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Estimated Detection Limit
The estimated detection limit for program 55 is 0.01 mg/L NO3

--
N. For more information on the estimated detection limit, see
Section 1.

Interferences

Summary of Method
Cadmium metal reduces nitrates present in the sample to nitrite. 
The nitrite ion reacts in an acidic medium with sulfanilic acid to 
form an intermediate diazonium salt which couples to 
chromotropic acid to form a pink-colored product.

Pollution Prevention and Waste Management
NitaVer 6 contains cadmium metal. Both samples and reagent 
blanks will contain cadmium (D006) at a concentration regulated 
as hazardous wastes by the Federal RCRA. Do not pour these 
solutions down the drain. See Section 3 for more information on 
proper disposal of these materials.

Interfering 
Substance

Interference Levels and Treatments

Calcium 100 mg/L

Chloride Chloride concentrations above 100 mg/L will cause low 
results. The test may be used at high chloride 
concentrations (seawater) but a calibration must be done 
using standards spiked to the same chloride concentration.

Ferric iron All levels

Nitrite All levels: This method measures both the nitrate and 
nitrite in the sample. If nitrite is present, the nitrite nitrogen 
test Program 60 should be done on the sample. Pretreat 
the nitrate nitrogen sample with the following 
pretreatment. Then subtract the amount of nitrite found 
from the results of the LR nitrate nitrogen test using the 
pretreated sample.
1. Add 30-g/L Bromine Water dropwise to the sample in 

Step 3 until a yellow color remains. Mix after each drop.
2. Add one drop of 30-g/L Phenol Solution to destroy the 

yellow color.
3. Proceed with the LR Nitrate procedure.

pH Highly buffered samples or extreme sample pH may 
exceed the buffering capacity of the reagents and require 
sample pretreatment.

Strong oxidizing 
and reducing 
substances

Interfere at all levels

NITRATE, Low Range, continued 
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REQUIRED REAGENTS
Low Range Nitrate Reagent Set (100 tests).................................................................. 24298-00

Includes: (1) 21071-69, (1) 21072-49
Quantity Required

Description Per Test Unit Cat. No.
NitriVer 3 Nitrite Reagent Powder Pillows..............1 pillow ............... 100/pkg.......... 21071-69
NitraVer 6 Nitrate Reagent Powder Pillows ............1 pillow ............... 100/pkg.......... 21072-49

REQUIRED APPARATUS
Cylinder, graduated, mixing, 25 mL............................. 1........................... each............ 1896-40
Sample Cell, 10-20-25 mL, w/ cap ............................... 2......................... 6/pkg.......... 24019-06

OPTIONAL REAGENTS
Description Unit Cat. No.
Bromine Water, 30 g/L........................................................................... 29 mL*............ 2211-20
Nitrate Nitrogen Standard Solution, 10.0 mg/L as NO3

--N...................500 mL.............. 307-49
Nitrate Nitrogen Standard Solution, Voluette ampule, 
   12 mg/L as NO3

--N, 10 mL ................................................................. 16/pkg.......... 14333-10
Phenol Solution, 30 g/L ...........................................................................29 mL............ 2112-20
Pretreatment Kit, contains: (1) 2112-20, (1) 2211-20................................. each............ 2268-00
Sodium Hydroxide Standard Solution, 5.0 N ............................ 50 mL* SCDB............ 2450-26
Sulfuric Acid, ACS..............................................................................500 mL*.............. 979-49
Water, deionized............................................................................................4 L.............. 272-56

OPTIONAL APPARATUS
Ampule Breaker.......................................................................................... each.......... 21968-00
Dropper, for 29-mL bottle........................................................................... each............ 2258-00
Flask, volumetric, Class A, 100 mL ........................................................... each.......... 14574-42
pH Indicator Paper, 1 to 11 pH .......................................................... 5-roll/pkg.............. 391-33
pH Meter, sension™1, portable, with electrode .......................................... each.......... 51700-10
Pipet, serological, 2 mL .............................................................................. each.............. 532-36
Pipet, TenSette, 0.1 to 1.0 mL..................................................................... each.......... 19700-01
Pipet Tips, for 19700-01 TenSette Pipet ................................................. 50/pkg.......... 21856-96
Pipet Tips, for 19700-01 TenSette Pipet ............................................ 1000/pkg.......... 21856-28
Pipet, volumetric, Class A, 2.00 mL........................................................... each.......... 14515-36
Pipet Filler, safety bulb ............................................................................... each.......... 14651-00
Thermometer, –20 to 110 °C....................................................................... each.......... 26357-02
Nitrate at these levels can also be determined directly using the Nitrate Ion Selective Electrode 
(Cat. No. 23488-00).

For Technical Assistance, Price and Ordering
In the U.S.A.—Call 800-227-4224
Outside the U.S.A.—Contact the Hach office or distributor serving you.

* Contact Hach for larger sizes

NITRATE, Low Range, continued 
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Method 10019

NITRITE, Low Range, Test ‘N Tube (0–0.500 mg/L NO2
--N)

Diazotization Method For water, wastewater, and seawater
USEPA approved for wastewater analysis*

1.  Enter the stored 
program number 
for nitrite nitrogen 
(NO2

--N), Test ‘N Tube.

Press: PRGM

The display will show:

PRGM ?

Note: For most accurate 
results, perform a Reagent 
Blank Correction using 
deionized water (see 
Section 1).

2.  Press: 63 ENTER

The display will show 
mg/L, NO2-N and the 
ZERO icon.

Note: For alternate forms 
(NO2

-, NaNO2), press the 
CONC key.

3.  Insert the COD/TNT 
Adapter into the cell 
holder by rotating the 
adapter until it drops 
into place. Then push 
down to fully insert.

Note: For increased 
performance, a diffuser 
band covers the light path 
holes on the adapter. Do 
not remove the diffuser 
band.

4.  Fill a Test ‘N Tube 
NitriVer® 3 Nitrite vial 
with 5 mL of sample. 
Cap and shake to 
dissolve powder. This is 
the prepared sample.

5.  Press:
TIMER ENTER

A 20-minute reaction 
period will begin.

Note: A pink color will 
develop if nitrite is present.

6.  When the timer 
beeps, fill an empty 
Test ‘N Tube vial with 
5 mL of sample 
(the blank).

7.  Clean the outside of 
the vials with a towel.

Note: Wipe with a damp 
towel and follow with a dry 
one to remove fingerprints 
and other marks.

8.  Place the blank in the 
vial adapter. 

Push straight down on 
the top of the vial until it 
seats solidly into the 
adapter. 

Note: Do not move the vial 
from side to side as this can 
cause errors.

* Federal Register, 44(85) 25505 (May 1, 1979).
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Sampling and Storage
Collect samples in clean plastic or glass bottles.

Store at 4 °C (39 °F) or lower and analyze within 48 hours. Warm 
to room temperature before running the test. 

Do not use acid preservatives.

Remove suspended solids by filtration.

Accuracy Check
Standard Solution Method
Pipet 5.00 mL of a fresh Hach standard, 250 mg/L as NO2

--N into 
a Class A 250-mL volumetric flask. Dilute to the line with 
deionized water to make a 5.00-mg/L intermediate standard. 
Pipet 10.00 mL of the 5.0-mg/L intermediate standard into a 
Class A 500-mL volumetric flask. Dilute to the line with 
deionized water to make a 0.100 mg/L NO2

--N standard solution. 
Prepare immediately before use.

Run the test using the 0.100 mg/L NO2
--N standard in place of the 

sample. Results should be between 0.090 and 0.110 mg/L NO2
--N.

9.  Cover the sample cell 
tightly with the 
instrument cap.

10.  Press: ZERO

The cursor will move to 
the right, then the 
display will show:

0.000 mg/L NO2-N

Note: If the reagent blank 
correction is on, the display 
may flash “limit.” See 
Section 1.

11.  Place the prepared 
sample in the adapter. 

Push straight down on 
the top of the vial until it 
seats solidly into the 
adapter. 

Note: Do not move the vial 
from side to side as this can 
cause errors.

12.  Tightly cover the 
sample cell with the 
instrument cap.

Press: READ

The cursor will move to 
the right, then the result 
in mg/L nitrite nitrogen 
(or an alternate form) 
will be displayed.

Note: Standard Adjust may 
be performed using a 
prepared standard 
(see Section 1).

NITRITE, Test 'N Tube, continued 
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Method Performance
Precision
In a single laboratory, using a standard solution of 0.250 mg/L 
nitrite nitrogen and two representative lots of reagent with the 
instrument, a single operator obtained a standard deviation of 
±0.004 mg/L NO2

--N.

Estimated Detection Limit
The estimated detection limit for program 63 is 0.006 mg/L NO2

-

-N. For more information on derivation and use of Hach’s 
estimated detection limit, see Section 1.

Interferences

Summary of Method
Nitrite in the sample reacts with sulfanilic acid to form an 
intermediate diazonium salt. This couples with chromotropic acid 
to produce a pink-colored complex directly proportional to the 
amount of nitrite present. 

Interfering 
Substance

Interference Levels

Antiminous ions Interfere by causing precipitation 

Auric ions Interfere by causing precipitation

Bismuth ions Interfere by causing precipitation

Chloroplatinate 
ions

Interfere by causing precipitation

Cupric ions Cause low results

Ferric ions Interfere by causing precipitation

Ferrous ions Cause low results

Lead ions Interfere by causing precipitation

Mercurous ions Interfere by causing precipitation

Metavanadate ions Interfere by causing precipitation

Nitrate Very high levels of nitrate (>100 mg/L nitrate as N) appear 
to undergo a slight amount of reduction to nitrite, either 
spontaneously or during the course of the test. A small 
amount of nitrite will be found at these levels.

Silver ions Interfere by causing precipitation

Strong oxidizing 
and reducing 
substances

Interfere at all levels

NITRITE, Test 'N Tube, continued 
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REQUIRED REAGENTS 
Description Cat. No.
NitriVer® 3 Nitrite, Low Range Test ‘N Tube Reagent Set (50 tests) ...............................26083-45

Includes: 
(50) NitriVer® 3 Nitrite Test ‘N Tube Vials.......................................................................................................*

Vials, 6 x 100 mm, 6/pkg ................................................................................................22758-06
Caps, for 22758-06 vials, 6/pkg......................................................................................22411-06
Deionized water, 100-mL....................................................................................................272-42

REQUIRED APPARATUS 
Quantity Required

Description Per Test Unit Cat. No.
COD/TNT Adapter ..............................................................1 ....................... each....... 48464-00
Test Tube Rack .................................................................. 1-3...................... each....... 18641-00
Pipet, TenSette, 1 to 10 mL..................................................1 ....................... each....... 19700-10
Pipet Tips for 19700-10 TenSette Pipet ...............................1 ................... 50/pkg....... 21997-96

OPTIONAL REAGENTS
Nitrite Standard Solution, 250 mg/L as NO2

--N .......................................500 mL ....... 23402-49
Water, deionized............................................................................................... 4 L........... 272-56

OPTIONAL APPARATUS
Flask, volumetric, 250 mL............................................................................. each....... 14574-46
Flask, volumetric, 500 mL............................................................................. each....... 14574-49
Pipet, volumetric, Class A, 10.00 mL............................................................ each....... 14515-38

For Technical Assistance, Price and Ordering 
In the U.S.A. call 800-227-4224
Outside the U.S.A.—Contact the Hach office or distributor serving you.

* Not available separately.

NITRITE, Test 'N Tube, continued 
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Method 10031
NITROGEN, AMMONIA, High Range, Test ‘N Tube 
(0 to 50 mg/L NH3-N) For water, wastewater, and seawater

Salicylate Method*

1.  Enter the stored 
program number for 
nitrogen, ammonia, high 
range Test ‘N Tube 
(NH3-N) method.

Press: PRGM

The display will show:

PRGM  ?

2.  Press: 67 ENTER

The display will show 
mg/L, NH3-N and the 
ZERO icon.
Note: For alternate forms 
(NH3), press the 
CONC key.
Note: For proof of 
accuracy, use a 10-mg/L 
nitrogen, ammonia 
standard in place of the 
sample.

3.  Insert the COD/TNT 
Adapter into the cell 
holder by rotating the 
adapter until it drops 
into place. Then push 
down to fully insert it.

Note: For increased 
performance, a diffuser 
band covers the light path 
holes on the adapter. Do 
not remove the diffuser 
band.

4.  Remove the caps 
from 2 AmVer Diluent 
Reagent High Range 
Vials. Add 0.1 mL of 
sample to one vial (the 
sample). Add 0.1 mL of 
deionized water to the 
other (the blank).

5.  Add the contents of 1 
Ammonia Salicylate 
Reagent Powder Pillow 
for 5 mL Sample to 
each vial.

6.  Add the contents of 1 
Ammonia Cyanurate 
Reagent Powder Pillow 
for 5 mL Sample to 
each vial.

7.  Cap the vials tightly 
and shake thoroughly to 
dissolve the powder.

Note: A green color
will develop if ammonia 
is present.

8.  Press: 

TIMER ENTER

A 20-minute reaction 
period will begin.

* Adapted from Clin. Chim. Acta, 14 403 (1966).
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9.  Clean the outside of 
the vial with a towel. 
After the timer beeps, 
place the blank into the 
vial adapter. Tightly 
cover the vial with the 
instrument cap.

Note: Wipe with a damp 
cloth and follow with a dry 
one to remove fingerprints 
and other marks.

10.  Press: ZERO

The cursor will move to 
the right, then the 
display will show:

0 mg/L NH3-N

11.  Place the prepared 
sample in the adapter. 

Push straight down on 
the top of the vial until it 
seats solidly into the 
adapter. 

Note: Do not move the vial 
from side to side as this can 
cause errors.

12.  Tightly cover the 
vial with the instrument 
cap.

13.  Press: READ

The cursor will move to 
the right, then the result 
in mg/L NH3-N will 
be displayed.

Note: Standard Adjust may 
be performed using a 
prepared standard (see 
Standard Adjust in Section 1).

NITROGEN, AMMONIA, High Range, Test 'N Tube, continued 



369

Sampling and Storage
Collect samples in clean plastic or glass bottles. Best results are 
obtained with immediate analysis. If chlorine is known to be 
present, add one drop of 0.1 N sodium thiosulfate for each 0.3 
mg/L Cl2 in a one liter sample. Preserve the sample by reducing 
the pH to 2 or less with hydrochloric acid (at least 2 mL). Store at 
4 °C (39 °F) or less. Preserved samples may be stored up to 28 
days. Before analysis, warm samples to room temperature and 
neutralize with 5.0 N sodium hydroxide. Correct the test result for 
volume additions.

Accuracy Check
Standard Additions Method

a) Snap the top off an Ammonia PourRite Ampule Standard, 
150 mg/L NH3-N.

b) Use the TenSette Pipet to add 0.2, 0.4 and 0.6 mL of 
standard to three 25-mL samples. Swirl to mix.

c) Analyze each sample as described above. The ammonia 
concentration should increase approximately 1.2 mg/L 
NH3-N for each 0.2 mL of standard added.

d) If these increases do not occur, see Standard Additions in 
Section 1 for more information.

Standard Solution Method 
To check accuracy, use a 10 or 50 mg/L Nitrogen, Ammonia 
Standard Solution or use a Nitrogen, Ammonia Voluette Ampule 
Standard, 50 mg/L. 

Method Performance
Precision
In a single laboratory, using a standard solution of 50 mg/L ammonia 
nitrogen (NH3-N) and two representative lots of reagent with the 
instrument, a single operator obtained a standard deviation of +5 mg/
L NH3-N.

Estimated Detection Limit
The estimated detection limit for program 67 is 1 mg/L NH3-N. 
For more information on the estimated detection limit, see 
Section 1.

NITROGEN, AMMONIA, High Range, Test 'N Tube, continued 
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Interferences
The following ions may interfere when present in concentrations 
exceeding those listed below.

In some lab environments, airborne cross contamination of the 
blank is possible. Complete preparation of the blank before 
opening or handling any samples or standards to avoid transfer of 
ammonia. If sample or standard containers have already been 
open, move to a separate area of the lab to prepare the blank.

Substance Concentration and Suggested Treatments

Acidic or basic 
samples

Adjust to approximately pH 7. Use 1 N Sodium Hydroxide 
Standard Solution for acidic samples and 1 N Hydrochloric 
Acid Standard Solution for basic samples.

Calcium 50,000 mg/L as CaCO3

Glycine, hydrazine Will cause intensified colors in the prepared sample. 

Magnesium 300,000 mg/L as CaCO3

Iron Eliminate iron interference as follows:
1. Determine the amount of iron present in the sample 

using one of the total iron procedures.
2. Add the same iron concentration to the deionized water 

in step 4.
3. The interference will then be successfully blanked out.

Nitrite 600 mg/L as NO2
--N

Nitrate 5,000 mg/L as NO3
--N

Orthophosphate 5,000 mg/L as PO4
3--P

Sulfate 6,000 mg/L as SO4
2-

Sulfide Sulfide will intensify the color. Eliminate sulfide interference 
as follows:
1. Measure about 350 mL of sample in a 500 mL 

Erlenmeyer flask.
2. Add the contents of one Sulfide Inhibitor Reagent 

Powder Pillow. Swirl to mix.
3. Filter the sample through folded filter paper. Use the 

filtered solution in step 4.

Turbidity and color Give erroneous high values. Samples with severe 
interferences require distillation. Hach recommends the 
distillation procedure using the Hach General Purpose 
Distillation Set. 

NITROGEN, AMMONIA, High Range, Test 'N Tube, continued
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Summary of Method
Ammonia compounds combine with chlorine to form 
monochloramine. Monochloramine reacts with salicylate to form 5-
aminosalicylate. The 5-aminosalicylate is oxidized in the presence of a 
sodium nitroprusside catalyst to form a blue-colored compound. The 
blue color is masked by the yellow color from the excess reagent 
present to give a green-colored solution.

Safety
Good safety habits and laboratory techniques should be used 
throughout the procedure. Consult the Material Safety Data 
Sheets for information specific to the reagents used. For 
additional information, refer to Section 3.

Pollution Prevention And Waste Management
The ammonia salicylate reagent contains sodium 
nitroferricyanide. Cyanide solutions are regulated as hazardous 
wastes by the Federal RCRA. Collect cyanide solutions for 
disposal as reactive (D001) waste. Be sure cyanide solutions are 
stored in a caustic solution with pH >11 to prevent release of 
hydrogen cyanide gas. See Section 3 for further information in 
proper disposal of these materials.

REQUIRED REAGENTS
AmVer™ Reagent Set for Nitrogen, Ammonia, High Range, TNT (25 tests) ..............26069-45
   Includes: (1) 23952-66, (1) 23954-66, (1) 272-42, *(50) AmVer HR Vials

Quantity Required
Description Per Test Unit Cat. No.
AmVer™ HR Reagent Test ‘N Tube™ Vials ............ 2 vials ...................50/pkg .......................*
Ammonia Salicylate Reagent Powder Pillows....... 2 pillows.................50/pkg ..........23952-66
Ammonia Cyanurate Reagent Powder Pillows ...... 2 pillows.................50/pkg ..........23954-66

REQUIRED APPARATUS
COD/TNT Adapter...........................................................1 .................each.................48464-00
Pipet, TenSette®, 0-1 mL .................................................1 .................each.................19700-01
Pipet Tips for 19700-01................................................ varies ......... 50/pkg.................21856-96 
Test Tube Rack ............................................................... 1-3 ...............each.................18641-00
Funnel, micro (for reagent addition) ................................1 .................each.................25843-35

* Not available separately.

NITROGEN, AMMONIA, High Range, Test 'N Tube, continued
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OPTIONAL REAGENTS
Quantity Required

Description Per Test Unit Cat. No.
Nitrogen, Ammonia Standard Solution, 50 mg/L NH3-N......................500 mL.......... 14791-50
Nitrogen, Ammonia Standard Solution, 10 mg/L NH3-N......................500 mL.............. 153-49
Ammonia Standard Solution, PourRite™ ampules, 

150 mg/L NH3-N, 2 mL....................................................................... 20/pkg.......... 21284-20 
Hydrochloric Acid, ACS........................................................................500 mL.............. 134-49
Sodium Hydroxide Standard Solution, 5.0 N ..........................................50 mL............ 2450-26
Sodium Hydroxide Standard Solution, 1.0 N ........................................100 mL............ 1045-32
Sodium Thiosulfate Standard Solution, 0.1 N .......................................100 mL.............. 323-32
Sulfide Inhibitor Powder Pillows.......................................................... 100/pkg............ 2418-99
Sulfuric Acid, 1.00 N...................................................................100 mL MDB............ 1270-32
Wastewater Influent Standard, Inorganic

(NH3–N, NO3, PO4, COD, SO4, TOC)................................................500 mL.......... 28331-49
Water, deionized..................................................................................... 4 L ...................  272-56

OPTIONAL APPARATUS
Cylinder, 25 mL, graduated, mixing........................................................... each.......... 20886-40
Distillation Apparatus Set, general purpose ............................................... each.......... 22653-00
Heater and Support Apparatus (for distillation), 115 VAC......................... each.......... 22744-00
Heater and Support Apparatus (for distillation), 230 VAC ........................ each.......... 22744-02
Filter Paper, folded................................................................................ 100/pkg............ 1894-57
Flask, Erlenmeyer, 500 mL......................................................................... each.............. 505-49
Funnel, analytical (for filtering).................................................................. each............ 1083-68
Jack, laboratory (use with distillation apparatus) ....................................... each.......... 22743-00
pH Indicator Paper, 1 to 11 pH ......................................................... 5 rolls/pkg.............. 391-33
Pipet Tips, for 19700-01 TenSette Pipet ............................................ 1000/pkg.......... 21856-28
PourRite™ Ampule Breaker ....................................................................... each.......... 24846-00
Sample Cell, 10-20-25 mL, w/cap ............................................................ 6/pkg.......... 24019-06

For Technical Assistance, Price and Ordering
In the U.S.A.—Call 800-227-4224
Outside the U.S.A.—Contact the Hach office or distributor serving you.

NITROGEN, AMMONIA, High Range, Test 'N Tube, continued 
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Phosphate phosphorus (PO4‐P): Method 8048 
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Method 8048

PHOSPHORUS, REACTIVE (0 to 2.50 mg/L PO4
3-) For water, wastewater, seawater

(Also called Orthophosphate) PhosVer 3 (Ascorbic Acid) Method* 
(Powder Pillows or AccuVac Ampuls) USEPA Accepted for wastewater analysis reporting**

Using Powder Pillows

* Adapted from Standard Methods for the Examination of Water and Wastewater.
** Procedure is equivalent to USEPA method 365.2 and Standard Method 4500-PE for wastewater.

1. Enter the stored 
program number for 
reactive phosphorus, 
ascorbic acid method. 

Press: PRGM

The display will show:

PRGM ?

Note: For most accurate 
results, perform a Reagent 
Blank Correction using 
deionized water (see 
Section 1).

2. Press: 79 ENTER

The display will show 
mg/L, PO4 and the 
ZERO icon.

Note: For alternate forms 
(P, P2O5), press the CONC 
key.

3. Fill a sample cell 
with 10 mL of sample.

Note: For samples with 
extreme pH, see 
Interferences following 
these steps.

Note: Clean glassware 
with 1:1 HCl. Rinse again 
with deionized water. Do 
not use detergents 
containing phosphates to 
clean glassware.

4. Add the contents of 
one PhosVer 3 
Phosphate Powder 
Pillow for 10-mL 
sample to the cell (the 
prepared sample). Shake 
for 15 seconds.

Note: A blue color will 
form if phosphate is 
present.
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5. Press: 

TIMER ENTER

A two-minute reaction 
period will begin. 
Perform Steps 6-8 
during this period.

Note: If the acid-persulfate 
digestion was used, an 8-10 
minute reaction period is 
required.

6. Fill another sample 
cell with 10 mL of 
sample (the blank). 

7. Place the blank into 
the cell holder. Tightly 
cover the sample cell 
with the instrument cap.

8. Press: ZERO

The cursor will move to 
the right, then the 
display will show:

0.00 mg/L PO4

Note: If Reagent Blank 
Correction is on, the 
display may flash “limit”. 
See Section 1.

9. After the timer 
beeps, place the 
prepared sample into the 
cell holder. Tightly 
cover the sample cell 
with the instrument cap.

10. Press: READ

The cursor will move to 
the right, then the result 
in mg/L phosphate 
(PO4

3-) will be 
displayed.

Note: Standard Adjust may 
be performed using a 
2.0-mg/L PO43-standard; 
see Section 1.
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Using AccuVac Ampuls

1. Enter the stored 
program number for 
reactive phosphorus- 
ascorbic acid method.

Press: PRGM

The display will show:

PRGM  ?

Note: For most accurate 
results, perform a Reagent 
Blank Correction using 
deionized water (see 
Section 1).

2. Press: 79 ENTER

The display will show 
mg/L, PO4 and the 
ZERO icon.

Note: For alternate forms 
(P, P2O5), press the CONC 
key.

3. Fill a sample cell 
(the blank) with at least 
10 mL of sample. 
Collect at least 40 mL 
of sample in a 50-mL 
beaker.

Note: For samples with 
extreme pH, see 
Interferences.

Note: Clean glassware 
with 1:1 HCl. Rinse again 
with deionized water. Do 
not use detergent 
containing phosphates to 
clean glassware.

4. Fill a PhosVer 3 
Phosphate AccuVac 
Ampul with sample.

Note: Keep the tip 
immersed while the ampul 
fills completely.

PHOSPHORUS, REACTIVE, continued
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5. Place an ampul cap 
securely over the tip of 
the ampul.  Shake the 
ampul for about 30 
seconds.  Wipe off any 
liquid or fingerprints.

Note: A blue color will 
form if phosphate is 
present.

Note: Accuracy is not 
affected by undissolved 
powder.

6. Press: 

TIMER ENTER

A two-minute reaction 
period will begin. 
Perform Steps 7-8 
during this period.

Note: Use an 8-10 minute 
reaction period if 
determining total 
phosphorus following the 
acid-persulfate digestion.

7. Place the blank into 
the cell holder. Tightly 
cover the sample cell 
with the instrument cap.

8. Press: ZERO

The cursor will move to 
the right, then the 
display will show:

0.00 mg/L PO4

Note: If Reagent Blank 
Correction is on, the 
display may flash “limit”. 
See Section 1.

9. After the timer 
beeps, place the 
AccuVac ampul into the 
cell holder. Tightly 
cover the ampul with the 
instrument cap.

10. Press: READ

The cursor will move to 
the right, then the result 
in mg/L phosphate 
(PO4

3-) will be 
displayed.

Note: Standard Adjust may 
be performed using a 
2.0-mg/L PO43- standard; 
see Section 1.

:30
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Sampling and Storage
Collect sample in plastic or glass bottles that have been cleaned 
with 1:1 Hydrochloric Acid Solution and rinsed with deionized 
water. Do not use commercial detergents containing phosphate 
for cleaning glassware used in this test. 

Analyze samples immediately after collection for best results. If 
prompt analysis is impossible, preserve samples for up to 48 
hours by filtering immediately and storing samples at 4 °C. Warm 
to room temperature before testing.

Accuracy Check
Standard Additions Method

a) Fill three 25-mL graduated mixing cylinders with 25 mL of 
sample.

b) Snap the neck off a Phosphate PourRite Ampule Standard 
Solution, 50 mg/L as PO4

3-.

c) Use the TenSette Pipet to add 0.1 mL, 0.2 mL, and 0.3 mL 
of standard, respectively, to the three mixing cylinders.  
Stopper each and mix thoroughly.

d) For analysis with AccuVacs, transfer solutions to dry, 
clean 50 mL beakers to fill the AccuVac ampules. For 
analysis with powder pillows, transfer only 10 mL of 
solution to the sample cells.

e) Analyze each standard addition sample as described in the 
procedure. The phosphate concentration should increase 
0.2 mg/L PO4

3- for each 0.1 mL of standard added.

f) If these increases do not occur, see Standard Additions in 
Section 1.

Standard Solution Method
Prepare a 2.0 mg/L PO4

3- standard solution by pipetting 4.0 mL 
of Phosphate Standard Solution, 50 mg/L as PO4

3-, into an acid-
washed Class A 100-mL volumetric flask. Dilute to volume with 
deionized water. Stopper and invert to mix. Use this solution in 
place of the sample in the procedure to insure the accuracy of the 
test. The mg/L PO4

3- reading should be 2.00 mg/L. 
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Method Performance
Precision

In a single laboratory using a standard solution of 1.00 mg/L 
PO4

3- and two lots of reagents with the instrument, a single 
operator obtained a standard deviation of ±0.05 mg/L PO4

3-. 

In a single laboratory using a standard solution of 1.00 mg/L 
PO4

3- and two representative lots of AccuVac ampuls with the 
instrument, a single operator obtained a standard deviation of 
±0.03 mg/L PO4

3-.

Estimated Detection Limit (EDL)
The EDL for program 79 is 0.05 mg/L PO4. For more information 
on the estimated detection limit, see Section 1.

Interference

Summary of Method
Orthophosphate reacts with molybdate in an acid medium to 
produce a Phosphomolybdate complex. Ascorbic acid then 
reduces the complex, giving an intense molybdenum blue color.

Interfering 
Substance

Interference Levels and Treatments

Aluminum Greater than 200 mg/L

Arsenate All levels

Chromium Greater than 100 mg/L

Copper Greater than 10 mg/L

Hydrogen sulfide All levels

Iron Greater than 100 mg/L

Nickel Greater than 300 mg/L

Silica Greater than 50 mg/L

Silicate Greater than 10 mg/L

Turbidity or color Large amounts may cause inconsistent results in the 
test because the acid present in the powder pillows may 
dissolve some of the suspended particles and because 
of variable desorption of orthophosphate from the 
particles. For highly turbid or colored samples, add the 
contents of one Phosphate Pretreatment Pillow to 25 mL 
of sample. Mix well. Use this solution to zero the 
instrument.

Zinc Greater than 80 mg/L

Highly buffered 
samples or extreme 
sample pH

May exceed the buffering capacity of the reagents and 
require sample pretreatment. 
pH 2 to 10 is recommended.
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REQUIRED REAGENTS & APPARATUS (Using Powder Pillows)
Quantity Required

Description Per Test  Unit Cat. No.
PhosVer 3 Phosphate Reagent Powder Pillows

10 mL sample size ............................................1 Pillow ............ 100/pkg..............21060-69
Sample Cell, 10-20-25 mL, w/cap ..................................... 2................ 6/pkg..............24019-06

REQUIRED REAGENTS & APPARATUS (Using AccuVac Ampuls)
PhosVer 3 Phosphate Reagent AccuVac Ampuls.... 1 ampul .............. 25/pkg..............25080-25
Beaker, 50 mL ................................................................... 1 .................. each..................500-41
Cap, ampul, blue ................................................................ 1 .............. 25/pkg................1731-25
Sample Cell, 10-20-25 mL, w/cap ..................................... 1................ 6/pkg..............24019-06

OPTIONAL REAGENTS
Drinking Water Standard, Inorganic, F–, NO3

–N, PO4
3–, SO4

2–................. 500mL ..........28330-49
Hydrochloric Acid Standard Solution, 6.0 N (1:1) ...........................500 mL..................884-49
Phosphate Standard Solution, 1mg/L ..................................................500mL................2569-49
Phosphate Standard Solution, PourRite ampule, 

   50 mg/L as PO4
3-, 2 mL ............................................................... 20/pkg..................171-20

Phosphate Standard Solution, Voluette Ampul, 50 mg/L, 10 mL ....... 16/pkg..................171-10
Sodium Hydroxide Standard Solution, 5.0 N ........................ 100 mL* MDB................2450-32
Wastewater Effluent Standard, Inorganic 

(NH3–N, NO3–N, PO4, COD, SO4, TOC) ..................................... 500 mL ..........28332-49
Water, deionized ........................................................................................ 4 L..................272-56

OPTIONAL APPARATUS
AccuVac Snapper Kit ............................................................................. each ..............24052-00
Ampule Breaker Kit for 10-ml ampules.................................................. each..............21968-00
Aspirator, vacuum ................................................................................... each................2131-00
Cylinder, graduated, mixing, 25 mL, tall (3 required) ............................ each..............20886-40
Filter Holder, 47 mm, 300 mL, graduated............................................... each..............13529-00
Filter, membrane, 47 mm, 0.45 microns ........................................... 100/pkg..............13530-00
Flask, filtering, 500 mL........................................................................... each..................546-49
Flask, volumetric, Class A, 100 mL........................................................ each..............14574-42
pH Indicator Paper, 1 to 11 pH ..................................................... 5 rolls/pkg ..................391-33
pH Meter, Sension™1, portable with electrode ..................................... each..............51700-10
Pipet, 2 mL serological ........................................................................... each..................532-36
Pipet, TenSette, 0.1 to 1.0 mL TenSette Pipet......................................... each..............19700-01
Pipet Tips, for 19700-01 ..................................................................... 50/pkg..............21856-96
Pipet Tips, for 19700-01 ...................................................... .......... 1000/pkg..............21856-28
Pipet Filler, safety bulb .......................................................................... each..............14651-00
Pipet, volumetric, Class A, 4.00 mL ....................................................... each..............14515-04
PourRite Ampule Breaker Kit ................................................................. each..............24846-00
Outside the U.S.A.—Contact the Hach office or distributor serving you.

* Larger sizes available.
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Method 8000

OXYGEN DEMAND, CHEMICAL For water, wastewater and
seawater

Reactor Digestion Method* USEPA approved for reporting wastewater analysis**
Digestion

* Jirka, A.M.; Carter, M.J. Analytical Chemistry, 1975, 47(8). 1397.
** Federal Register, April 21, 1980, 45(78), 26811-26812. The 0-15,000 mg/L range is not USEPA approved.

1. Homogenize 500 
mL of sample for 2 
minutes in a blender.

Note: For the 0-15,000 
mg/L range, homogenize 
100 mL of sample. Pour the 
blended sample into a 
250-mL beaker. Stir with a 
magnetic stirrer while 
withdrawing a sample 
aliquot. This improves 
accuracy and 
reproducibility.

2.  Turn on the DRB 200 
Reactor. Preheat to 
150 °C. 
Note: See DRB 200 user 
manual for selecting 
pre-programmed 
temperature applications.

3.  Remove the cap of a 
COD Digestion Reagent 
Vial for the appropriate 
range:

Note: The reagent mixture 
is light-sensitive. Keep 
unused vials in the opaque 
shipping container, in a 
refrigerator if possible. The 
light striking the vials 
during the test will not 
affect results.

4.  Hold the vial at a 
45-degree angle. Pipet 
2.00 mL (0.2 mL for the 0 
to 15,000 mg/L range) of 
sample into the vial.
Note: For the 0-15,000 
mg/L range, pipet only 
0.20 mL of sample, not 
2.00 mL of sample, using a 
TenSette Pipet. For greater 
accuracy analyze a 
minimum of three replicates 
and average the results.

Note: Spilled reagent will 
affect test accuracy and is 
hazardous to skin and other 
materials. Do not run tests 
with vials which have been 
spilled. If spills occur, wash 
with running water.

Sample 
Conc. 
Range 
(mg/L)

COD 
Digestion 
Reagent Vial 
Type

0 to 150 Low Range

0 to 1500 High Range

0 to 15,000 High Range 
Plus

Caution: Some of the chemicals and apparatus used in this 
procedure may be hazardous to the health and safety of the user if 
inappropriately or accidentally misused. Please read all warnings 
and the safety section of this manual. Wear appropriate eye 
protection and clothing. If contact occurs, flush the affected area 
with running water. Follow all instructions carefully.
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5.  Replace the vial cap 
tightly. Rinse the outside 
of the COD vial with 
deionized water and wipe 
the vial clean with a 
paper towel.

6.  Hold the vial by the 
cap and over a sink. Invert 
gently several times to mix 
the contents. Place the vial 
in the preheated DRB 200 
Reactor.
Note: The vial will become 
very hot during mixing.

7.  Prepare a blank by 
repeating Steps 3 to 6, 
substituting 2.00 mL 
(0.2 mL for the 0 to 15,000 
mg/L range) deionized 
water for the sample.
Note: Be sure the pipet 
is clean.

Note: One blank must be 
run with each set of 
samples. Run samples and 
blanks with vials from the 
same lot number (lot # is on 
the container label). 

8.  Heat the vials for 
2 hours.
Note: Many samples are 
digested completely in less 
than two hours. If desired, 
measure the concentration 
(while still hot) at 15 
minute intervals until the 
reading remains 
unchanged. Cool vials to 
room temperature for final 
measurement.

9.  Turn the reactor off. 
Wait about 20 minutes for 
the vials to cool to 120 °C 
or less.

10.  Invert each vial 
several times while still 
warm. Place the vials into 
a rack. Wait until the vials 
have cooled to room 
temperature.
Note: If a pure green color 
appears in the reacted 
sample, measure the COD 
and, if necessary, repeat the 
test with a diluted sample.

11.  Use one of the 
following analytical 
techniques to measure the 
COD:

• Colorimetric method, 
0-150 mg/L COD

• Colorimetric method, 
0-1,500 mg/L COD

• Colorimetric method, 
0-15,000 mg/L COD

Heat for 2 

Choose a 
range

OXYGEN DEMAND, CHEMICAL, continued 
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Colorimetric Determination, 0 to 150 mg/L COD 

1. Enter the stored 
program number for 
chemical oxygen 
demand (COD), low 
range.

Press: PRGM

The display will show:

PRGM ?

2.  Press: 16 ENTER

The display will show 
mg/L, COD and the 
ZERO icon.

Note: For alternate form 
(O2), press the CONC key.

3.  Insert the COD/TNT 
Adapter into the cell 
holder by rotating the 
adapter until it drops into 
place. Then push down to 
fully insert it.
Note: For increased 
performance, a diffuser 
band covers the light path 
holes on the adapter. Do 
not remove the diffuser 
band.

4.  Clean the outside of 
the blank with a towel.
Note: Wiping with a damp 
towel, followed by a dry 
one, will remove 
fingerprints or other marks.

5.  Place the blank in the 
adapter. 

Push straight down on 
the top of the vial until it 
seats solidly into the 
adapter. 

Note: Do not move the vial 
from side to side as this can 
cause errors.

6.  Tightly cover the vial 
with the instrument cap.
Note: The blank is stable 
when stored in the dark. 
See Blanks for 
Colorimetric 
Determination following 
these procedures.

7.  Press: ZERO

The cursor will move to 
the right, then the 
display will show:

0 mg/L COD

8.  Clean the outside of 
the sample vial with 
a towel.
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9.  Place the sample vial 
in the adapter.

Push straight down on 
the top of the vial until it 
seats solidly into the 
adapter. 

Note: Do not move the vial 
from side to side as this can 
cause errors.

10.  Tightly cover the vial 
with the instrument cap.

11.  Press: READ

The cursor will move to 
the right, then the result 
in mg/L COD will be 
displayed.

Colorimetric Determination, 0 to 1,500 and 0 to 15,000 mg/L COD 

1. Enter the stored 
program number for 
chemical oxygen 
demand, high range.

Press: PRGM

The display will show:

PRGM ?

2.  Press: 17 ENTER

The display will show 
mg/L, COD and the 
ZERO icon.

Note: For alternate form 
(O2), press the CONC key.

3.  Insert the COD/TNT 
Adapter into the cell 
holder by rotating the 
adapter until it drops into 
place. Then push down to 
fully insert it.

4.  Clean the outside of 
the blank with a towel.
Note: Wiping with a damp 
towel followed by a dry one 
will remove fingerprints or 
other marks.

OXYGEN DEMAND, CHEMICAL, continued 
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5.  Place the blank in the 
adapter. 

Push straight down on 
the top of the vial until it 
seats solidly into the 
adapter. 

Note: Do not move the vial 
from side to side as this can 
cause errors.

6.  Tightly cover the 
sample cell with the 
instrument cap.

The blank is stable when 
stored in the dark. See 
Blanks for Colorimetric 
Determination following 
these procedures.

7.  Press: ZERO

The cursor will move to 
the right, then the 
display will show:

0 mg/L COD

8.  Clean the outside of 
the sample vial with 
a towel.

9.  Place the sample in the 
adapter. 

Push straight down on 
the top of the vial until it 
seats solidly into the 
adapter. 

Note: Do not move the vial 
from side to side as this can 
cause errors.

10.  Tightly cover the 
sample cell with the 
instrument cap.

11.  Press: READ

The cursor will move to 
the right, then the result 
in mg/L COD will 
be displayed.

Note: When using High 
Range Plus COD Digestion 
Reagent Vials, multiply the 
reading by 10.

Note: For most accurate 
results with samples near 
1,500 or15,000 mg/L COD, 
repeat the analysis with a 
diluted sample.

OXYGEN DEMAND, CHEMICAL, continued 
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Sampling and Storage
Collect samples in glass bottles. Use plastic bottles only if they 
are known to be free of organic contamination. Test biologically 
active samples as soon as possible. Homogenize samples 
containing solids to assure representative samples. Samples 
treated with sulfuric acid to a pH of less than 2 (about 2 mL per 
liter) and refrigerated at 4 °C can be stored up to 28 days. Correct 
results for volume additions; see Correction for Volume Additions 
(Section 1) for more information.

Accuracy Check
Standard Solution Method
Check the accuracy of the 0 to 150 mg/L range with a 100 mg/L 
standard. Prepare by dissolving 85 mg of dried (120 °C, 
overnight) potassium acid phthalate (KHP) in 1 liter of deionized 
water. Use 2.0 mL as the sample volume. The expected result will 
be 100 mg/L COD. As an alternative, dilute 10 mL of 1000-mg/L 
COD Standard Solution to 100 mL to make a 100-mg/L standard.

Check the accuracy of the 0 to 1,500 mg/L range by using either a 
300 mg/L or 1000 mg/L COD Standard Solution. Alternatively, 
prepare a 500 mg/L standard by dissolving 425 mg of dried (120 
°C, overnight) KHP. Dilute to 1 liter with deionized water. Use 
2.0 mL of one of these solutions as the sample volume.

Check the accuracy of the 0 to 15,000 mg/L range by using a 
10,000 mg/L COD standard solution. Prepare the 10,000 mg/L 
solution by dissolving 8.500 g of dried (120 °C, overnight) KHP 
in 1 liter of deionized water. Use 0.2 mL of this solution as the 
sample volume; the expected result will be 10,000 mg/L COD.

Method Performance
Precision
Program #16: In a single laboratory, using a standard solution of 
100 mg/L COD and two representative lots of reagent with the 
instrument, a single operator obtained a standard deviation of ±2 
mg/L COD.

Program #17: In a single laboratory, using a standard solution of 
1000 mg/L COD and two representative lots of reagent with the 
instrument, a single operator obtained a standard deviation of 
± 16 mg/L COD. For more information on Hach’s precision 
statement, see Section 1.
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Estimated Detection 
Limit (EDL)

The EDL for program 16 is 4 mg/L COD. The EDL for program 
17 is 30 mg/L COD. For more information on derivation and use 
of Hach’s estimated detection limit, see Section 1.

Alternate reagents Mercury-free COD2 Reagents can provide a mercury-free testing 
option for non-reporting purposes. For process control 
applications, COD2 reagents will eliminate mercury waste and 
save on disposal costs. These reagents are fully compatible with 
test procedures and calibration curves programmed into the 
DR/2400 spectrophotometer. Determine chloride and ammonia 
for accurate results.

Note: Mercury-free COD2 reagents are not approved for USEPA reporting. 
Request a copy of the COD Reagent Vial Information Brochure, Lit. No. 
1356, for more information about specific applications.

Interferences
Chloride is the primary interference when determining COD 
concentration. Each COD vial contains mercuric sulfate that will 
eliminate chloride interference up to the level specified in column 
1 in Table 1. Samples with higher chloride concentrations should 
be diluted. Dilute the sample enough to reduce the chloride 
concentration to the level given in column 2.

If sample dilution will cause the COD concentration to be too low 
for accurate determination, add 0.50 g of mercuric sulfate 
(HgSO4) to each COD vial before the sample is added. The 
additional mercuric sulfate will raise the maximum chloride 
concentration allowable to the level given 
in column 3.

Table 1

Column 1 Column 2 Column 3

Vial Type Used Maximum Cl- 
concentration 
in sample 
(mg/L)

Maximum Cl- 
concentration of 
diluted samples 
(mg/L)

Maximum Cl- 
concentration in 
sample when 0.50 
HgSO4 added (mg/L)

Low Range 2000 1000 8000

High Range 2000 1000 4000

High Range Plus 20,000 10,000 40,000

OXYGEN DEMAND, CHEMICAL, continued 
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Blanks for Colorimetric Determination
The blank may be used repeatedly for measurements using the 
same lot of vials. Store it in the dark. Monitor decomposition by 
measuring the absorbance at the appropriate wavelength (420 or 
610 nm). Zero the instrument in the absorbance mode, using a 
vial containing 5 mL of deionized water and measure the 
absorbance of the blank. Record the value. Prepare a new blank 
when the absorbance has changed by about 0.01 absorbance 
units.

Summary of Method
The mg/L COD results are defined as the mg of O2 consumed per 
liter of sample under conditions of this procedure. In this 
procedure, the sample is heated for two hours with a strong 
oxidizing agent, potassium dichromate. Oxidizable organic 
compounds react, reducing the dichromate ion (Cr2O7

2-) to green 
chromic ion (Cr3+). When the 
0-150 mg/L colorimetric method is used, the amount of Cr6+ 
remaining is determined. When the 0-1,500 mg/L or 0-15,000 
mg/L colorimetric method is used, the amount of Cr3+ produced is 
determined. The COD reagent also contains silver and mercury 
ions. Silver is a catalyst, and mercury is used to complex the 
chloride interference.

Pollution Prevention and Waste Management
Final samples will contain mercury (D009), silver (D011), and 
chromium (D007) at concentration levels regulated by the 
Federal RCRA. Please see Section 3 for further information on 
proper disposal of these materials.

REQUIRED REAGENTS 
Description Qty/Test Unit Cat. No.
Select the appropriate COD Digestion Reagent Vial:
Low Range, 0 to 150 mg/L COD.................................... 1 to 2 vials ..... 25/pkg.......... 21258-25
High Range, 0 to 1,500 mg/L COD................................ 1 to 2 vials ..... 25/pkg.......... 21259-25
High Range Plus, 0 to 15,000 mg/L COD ...................... 1 to 2 vials ..... 25/pkg.......... 24159-25
Water, deionized.................................................................. varies ...............4 L.............. 272-56

REQUIRED APPARATUS
Blender, Osterizer, 120 V, 14 speed........................................1 ................. each.......... 26160-00
Blender, Osterizer, 240 V, 14 speed........................................1 ................. each.......... 26160-02
DRB 200 Reactor, 110 V, 15 x 16 mm tubes ..................................................LTV082.53.40001
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REQUIRED APPARATUS (continued)
Description Qty/Test Unit Cat. No.
DRB 200 Reactor, 220 V, 15 x 16 mm tubes ................................................. LTV082.52.40001
COD/TNT Adapter................................................................. 1..................each ..........48464-00
Pipet, TenSette, 0.1 to 1.0 mL ................................................ 1..................each ..........19700-01
Pipet Tips, for 19700-01 TenSette Pipet ................................ 1..............50/pkg ..........21856-96
Pipet, volumetric, Class A, 2.00 mL ...................................... 1..................each ..........14515-36
Pipet Filler, safety bulb .......................................................... 1..................each ..........14651-00
Test Tube Rack ............................................................... 1 to 2 racks .........each ..........18641-00

ALTERNATE REAGENTS*
COD2, LR, 0 to 150 mg/L COD ...................................... 1–2 vials .......25/pkg ..........25650-25
COD2, HR, 0 to 1500 mg/L COD.................................... 1–2 vials .......25/pkg ..........25651-25
COD2, HR, 0 to 1500 mg/L COD.................................... 1–2 vials .....150/pkg ..........25651-15
COD2, HR, 0 to 15,000 mg/L COD................................. 1–2 vials .......25/pkg ..........28343-25

OPTIONAL REAGENTS
Description Unit Cat. No.
COD Digestion Reagent Vials, 0 to 150 mg/L COD ............................150/pkg ..........21258-15
COD Digestion Reagent Vials, 0 to 1,500 mg/L COD .........................150/pkg ..........21259-15
COD Standard Solution, 300 mg/L ....................................................... 200 mL ..........12186-29
COD Standard Solution, 1000 mg/L ..................................................... 200 mL ..........22539-29
Mercuric Sulfate............................................................................... 28.3 grams ............1915-20
Oxygen Demand Standard (BOD, COD, TOC), 10-mL Ampules..........16/pkg ..........28335-10
Potassium Acid Phthalate, ACS................................................................500 g ..............315-34
Potassium Dichromate Standard Solution, 0.25 N............................ 1000 mL* ............1809-53
Sulfuric Acid, ACS ........................................................................... 500 mL** ..............979-49
Wastewater Effluent Standard, Inorganic 

(NH3–N, NO3–N, PO4, COD, SO4, TOC) ..................................... 500 mL ..........28332-49
Wastewater Influent Standard, Inorganic 

(NH3–N, NO3–N, PO4, COD, SO4, TOC) ..................................... 500 mL ..........28331-49

OPTIONAL APPARATUS
Balance, analytical, 115 V...........................................................................each ..........28014-01
Balance, analytical, 230 V...........................................................................each ......... 28014-02
Beaker, 250 mL ...........................................................................................each ...........500-46H
Cylinder, graduated, 5 mL...........................................................................each ..............508-37
DRB 200 Reactor, 110 V, 21 x 16 mm and 4 x 20 mm.................................. LTV082.53.42001
DRB 200 Reactor, 220 V, 21 x 16 mm and 4 x 20 mm.................................. LTV082.52.42001
DRB 200 Reactor, 110 V, 9 x 16 mm and 2 x 20 mm.................................... LTV082.53.30001

* Mercury-free COD2 reagents are not approved for USEPA reporting. Request a copy of the COD Reagent Vial 
Information Brochure, Lit. No. 1356, for more information about specific applications.
** Contact Hach for larger sizes.
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OPTIONAL APPARATUS (continued)
Description Unit Cat. No.
DRB 200 Reactor, 220 V, 9 x 16 mm and 2 x 20 mm ....................................LTV082.52.30001
Electromagnetic Stirrer, 120 V, with electrode stand.................................. each.......... 45300-01
Electromagnetic Stirrer, 230 V, with electrode stand.................................. each.......... 45300-02
Flask, volumetric, Class A, 1000 mL ......................................................... each.......... 14574-53
Flask, volumetric, Class A, 100 mL ........................................................... each.......... 14574-42
pH Paper, 1 to 11 pH units ................................................................ 5 rolls/pkg.............. 391-33
Pipet, serological, 5 mL .............................................................................. each.............. 532-37
Pipet Tips, for 19700-01 TenSette Pipet ............................................. 1000/pkg.......... 21856-28
Pipet, volumetric, Class A, 10 mL.............................................................. each.......... 14515-38
Spoon, measuring, 0.5 g.............................................................................. each.............. 907-00
Stir Bar, 22.2 x 4.76 mm (7/8" x 3/16")...................................................... each.......... 45315-00
Stir Bar Retriever ........................................................................................ each.......... 15232-00
Timer........................................................................................................... each.......... 26304-00

For Technical Assistance, Price and Ordering
In the U.S.A.—Call 800-227-4224
Outside the U.S.A.—Contact the Hach office or distributor serving you.

OXYGEN DEMAND, CHEMICAL, continued 
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1. Introduction 

1.1  Objective of the Guideline 

The Mangrove Plantation Guideline (hereinafter abbreviated as “Guideline”) was prepared based on 
the knowledge and experiences gained through the plantation activities conducted since 2001 by the 
Ministry of Environment and Climate Affairs (MECA) through the cooperation of Japan International 
Cooperation Agency (JICA).  

The  objective  of  the Guideline  is  to  assist  those who  plan  to  implement mangrove  plantation  in 
Oman and other middle‐east countries where Avicennia marina grows. However, the Guideline may 
also be applicable for other countries and mangrove species perhaps with some modifications. 

The  Guideline  provides  detailed  descriptions  on  the  plantation  procedures,  in  particular  the 
“seedling  transplantation method”, which  is  the main method  employed  by MECA.  This method 
conducts plantation by transplanting seedlings that were artificially grown in a seedling nursery.  The 
Guideline  also  provides  descriptions  for  an  alternative  plantation method  termed  “direct  sowing 
method”. This method conducts plantation by sowing seeds directly at the plantation site. Table 1.1 
compares the advantages and disadvantages of both methods. 

 

Table 1.1: Comparison of advantages and disadvantages of “seedling transplantation method” and 
“direct sowing method” 

  Seedling Transplantation Method Direct Sowing Method 

Cost  High  Low

Nursery  High cost to construct nursery Low cost as no need to construct nursery

Necessary input  High input for materials and labourers 
to produce seedlings 

Low input as no need to produce seedlings

Transportation  High cost for seedling transportation Low cost for seed transportation 

Number of seeds 
required 

Need relatively less amount of seeds 
compared to direct sowing method 

Need large amount of seeds due to low 
root‐taking rate 

Field work  Need equipment and labourers for 
seedling transplantation 

Easy and require no equipment and 
labourers 

Root‐taking rate  High  Low 

 

Although  “seedling  transplantation method”  requires high  cost  for nursery  construction,  seedling 
production,  transportation and  transplantation,  the  root‐taking  rate of  the  transplanted  seedlings 
are relatively high. On the other hand, the cost of “direct sowing method”  is relatively  low but has 
lower root‐taking rate. The best method should be selected according to the objective of plantation 
and the characteristics of the plantation site. 

 

1.2  Objective of mangrove plantation 

Mangrove  plantation  is  generally  conducted  to  compensate  lost  mangrove  area  (e.g.  through 
development)  or  to  create  new  mangrove  area.  Mangrove  plantation  is  also  conducted  as 
mangroves provide various benefits to the people and environment. Followings are some examples 
of benefits that can be derived through plantation: 

- Provides precious greenery as  recreational and educational sites  to  the coastal area, which  is 
especially significant in arid countries like Oman. 
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Fig. 1.1: Plantation to create recreational and educational sites 

 

- Provides habitats and feeding area for numerous animals including fishes, crabs and birds. 

       

Fig. 1.2: Plantation to enrich biomass and biodiversity 

 

- Provides protection of shorelines against erosion. 

       

Fig. 1.3: Plantation as countermeasures against erosion 
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- Improves coastal water quality by capturing silt and absorbing pollutants.  

       

Fig. 1.4: Plantation to improve coastal water quality 

 

Mangrove plantation  should be planned by  considering  the benefits mentioned  above. However, 
despite the various benefits, it is also important to consider negative aspects of mangrove plantation 
when planning plantation such as: 

- Conflict with land use (e.g. plantation in private land or in communal land). 

       

Fig. 1.5: Conflict with existing land use through plantation 

 

- Reduction of bird feeding ground. 

       

Fig. 1.6: Reduction of bird feeding ground through plantation 
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2.  Selection of plantation site 

Selection of  an  appropriate plantation  site  is  important  in order  to perform  successful mangrove 
plantation. The following section describes the factors to consider for site selection. A field check list 
and  evaluation  sheet  for  site  selection  was  prepared  (see  Appendix  1),  which  can  be  used  for 
evaluating the candidate site at the field (a soft copy of Appendix 1 is included in the attached CD). 

 

2.1 Natural conditions 

(1) Meteorology 

Meteorological  conditions  such  as  temperature,  wind  direction  and  wind  speed  should  be 
considered  in the site selection process. Areas subject to cold winter temperature and/or constant 
strong winds are generally unsuitable for plantation. 

 

(2) Hydrology 

Hydrological  conditions  such  as  sea water  exchange,  current  regime  and wave  action  should  be 
considered in the site selection process. Following are some important factors to consider: 

- Regular water  exchange  is  important  for  the  growth  of  seedlings.  Avoid  plantation  in  areas 
where water exchange is limited. 

- Avoid plantation  in areas  that are  subject  to high waves and  strong  current, as  it will hinder 
settlement of seedlings. 

 

(3) Intertidal zone 

Since plantation is basically conducted in the intertidal zone, check the area available for plantation 
by  studying  the width and  slope of  the  intertidal  zone.  In general, a wide  intertidal  zone  is more 
suitable for plantation. 

 

(4) Soil properties 

Areas with thin soil  layer are not suitable for plantation as  it will hinder root growth. The depth of 
the  soil  layer  should be  at  least more  than 15  cm.  In  addition,  soils with  anoxic  conditions, high 
salinity and muddy texture are unsuitable for plantation. 

       

Fig. 2.1: Unsuitable soil properties for plantation (left: anoxic soil, right: high salinity soil) 
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(5) Water quality 

Areas with high water salinity (more than 50 ‰) and low DO concentration are generally unsuitable 
for plantation. 

 

(6) Fauna  

Mangrove plantation can have adverse impacts on animals that feed and live in the intertidal zone. 
While some of these animals may coexist with mangroves, some may not be as adaptable. One of 
the main issues that have been raised recently, is that mangrove plantation will reduce the feeding 
area  of  birds,  as many  bird  species  prefer  to  feed  at  exposed  intertidal  areas.  So  study  the  bird 
feeding areas carefully and avoid plantation if it will significantly reduce existing bird feeding areas. 

 

2.2 Social conditions 

(1) Risk of animal grazing 

Areas with  high  risk  of  grazing  by  domestic  animals  such  as  camels,  goat  and  sheep  should  be 
avoided.  

       

Fig. 2.2: Grazing of mangrove by domestic animals 

(2) Existing land use 

Mangrove  plantation  can  alter  the  existing  land  use  of  the  local  residents.  Therefore,  avoid 
plantation  in  areas  that  are  heavily  used  by  the  local  residents  (e.g.  boat  landing,  recreational 
activities).  

 

(3) Future development plan 

Avoid plantation in areas that are within or near to areas proposed for future development such as 
road and port construction, as these development activities will  likely have adverse  impacts on the 
planted seedlings. 

 

2.3 Others 

(1) Past distribution of mangrove forest 

If  available,  try  to  collect  information  (e.g.  aerial  photos,  satellite  image)  of  past  mangrove 
distribution. For sites where mangroves grew in the past, reforestation should be promoted for the 
recovery of mangrove forest. Priority should be given for such site. 
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(2) Future expansion potential of mangrove forest 

Consider  the  potential  area  for  future  expansion  of  the  mangrove  forest,  by  studying  the 
topography, tidal range and other factors. Reconsider plantation if such expansion will have adverse 
effects on natural or social conditions. 

 

(3) Accessibility and necessary cost 

Preferably,  the  plantation  site  should  be  relatively  easy  to  access  as  plantation  activities  require 
seedling  transportation  and  maintenance  works.  The  cost  of  transplantation  should  also  be 
considered  through cost and benefit analysis. The possibility of alternative  low cost methods  (e.g. 
direct sowing method) should also be considered.  

 

Fig.2.3: Difficulties encountered during seedling transportation 

 

2.4 Consultation of stakeholders 

The  local  residents  should  be  consulted  prior  to  selecting  the  plantation  site  to  avoid  future 
problems. A strong willingness of the  local residents to plant and maintain mangrove forest  is also 
important for successful plantation. 

       

Fig. 2.4: Consultation of local stakeholders 
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3.  Plantation by seedling transplantation method 

3.1 Seed collection, treatment and storage 

(1) General characteristics of Avicennia marina seed 

A. marina seeds cannot be stored for long periods because they are viviparous. In other words, the 
seeds  have  no  dormant  period  and  keep  growing  even  after  detachment  from  the mother  tree. 
Therefore, the seeds are delicate and deteriorate easily especially in hot and humid conditions.  

A. marina  seeds  have  a  pericarp  (thin  skin  that  coats  the  seed)  for  floatation  in  seawater  and 
protection  from dehydration. The  seed  sinks  to  the  seafloor once  the pericarp  is  removed, which 
usually takes between 6 hours to 2 days. These characteristics should be taken into consideration for 
seed collection, treatment and storage. 

     
 

     

Fig. 3.1: Characteristics of A. marina seed 

 

(2) Seed collection  

(i) Timing and season 

The  fruition  season  of mangrove  should  be  clarified  before  starting  plantation  project.  In Oman, 
seeds can be collected from early July‐August in the northern region. In the Dhofar region, seeds can 
be collected during  two seasons:  in May‐June and December‐January. Prior  to  the seed collection 
works, make sure the nursery is prepared for sowing as seeds cannot survive for long periods after 
collection.  

 

(ii) Seed collection site 

Following are some factors that should be considered when selecting the seed collection site: 

Seed with pericarp Seed without pericarp 
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- Seeds should be collected from a healthy and matured mangrove forest. 

- The seed collection site should be easily accessible for the workers to carry out the task. 

- Preferably, seeds should be collected from mangroves near the nursery site. 

 

(iii) Collection of seeds 

Following are some factors that should be considered when collecting seeds: 

- Size of seed should be relatively large, preferably weighing more than 3 grams with pericarp. Do 
not collect fallen seeds on ground. 

- Seeds with a tiny pin hole on the surface of pericarp should be excluded, as it is a sign of insect 
infestation. 

- Since the branches of mangrove trees are fragile,  it  is recommended not to climb up the trees 
for seed collection. 

- Since  seeds  are  bruised  easily,  seeds  should  be  collected  carefully.  Bruised  seeds  are  easily 
infected by fungi. Seeds cannot survive once it is infected by fungi. 

       

Fig. 3.2: Seed collection and collected seeds 

 

(3) Seed treatment  

(i) Purpose of treatment 

Seeds are treated mainly to remove pericarp, which is easily affected by fungi and can then spread 
to  the whole  seed.  Since  the  treated  seeds  cannot be  stored  for a  long  time, only  the necessary 
amount of seeds should be treated. 

 

(ii) Necessary equipment 

- Large water containers (e.g. 70‐100 liters) for seed treatment. 

- Small buckets or water pump to draw water. 

 

(iii) Procedure 

Step‐1: Put the collected seeds  into a container. The volume of the seeds should be  less than one 
sixth  (1/6) of  the volume of  the  container  to avoid damage  to  the  seeds by  their weight. 
Then fill the container with fresh seawater and soak the seeds for around 24 hours (around 6 
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hours  in case of stored seeds). After a while,  the seawater  in  the container will change  its 
color to brown. So, change the water at least every 2 hours. 

  

Fig. 3.3: Soaking of collected seeds 

 

Step‐2: After soaking for a while, the pericarp of the seeds will usually peel off by themselves. If not, 
they  should  be  peeled  off  by  hand.  Healthy  naked  seeds will  sink  to  the  bottom  of  the 
container. Remove the pericarp from the container as they can damage the seeds. 

      

Fig. 3.4: Removal of pericarp 

 

If the pericarp  is  infected by fungus (left photo below), the underlying seed  is also usually  infected 
(right photo below). Since fungus infected seeds cannot grow, remove all such infected seeds during 
the peeling off process. Also remove naked seeds that keep floating as they are usually infected by 
insects. 

       

Fig. 3.5: Infected pericarp and seeds 

 

Step‐3: Transfer  the healthy naked  seeds  (i.e.  seeds at  the bottom of  the container)  into another 
container filled with fresh seawater. Soak the seeds for another 6 hours or more to remove 
mucus around seeds. The wastewater used for soaking the seeds should not be reused. 
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(4) Seed storage  

If  the collected seeds cannot be sowed  immediately,  they can be stored  for 10  to 15 days  if done 
properly. Following are some tips for seed storage: 

- Do not remove the pericarp when storing seeds. 

- Store the seeds  in a cool and dry shaded area or under air conditioned room. Air temperature 
should be less than 26 degrees, and make sure the seeds are dry. The seeds should not be piled 
on top of each other, but instead should be spread evenly on the floor.  

- Regularly turn the seeds upside down to release heat and moisture to avoid fungus infestation 
on  pericarp.  Fungus  often  appears  if  the  seedlings  are  piled.  Seeds  cannot  survive  once  the 
surface is infected by fungus.  

- Check and remove damaged seeds (e.g. fungus and insect infected). 

- Do not store the seeds in a refrigerator, as it may get cold burn and die. 

 

3.2  Preparation of seedling 

Seedlings are usually grown  in a seedling nursery. There are two types of nurseries: a “permanent 
type”  and  “temporary  type”.  A  “permanent  type”  nursery  is  a  fixed  structure  and  is  usually 
constructed if there is a constant demand for seedlings. A “temporary type” nursery is much simpler 
without any fixed structure, and can be employed among others if seedling demand is temporary or 
construction of a “permanent  type” nursery  is  too costly or difficult. See Section 3.2  (6)  for more 
explanation on “temporary type” nursery.  

 

Fig. 3.6: General structure of “permanent type” nursery 

 

The procedures of seedling preparation are explained by using “permanent type” nursery. 

 

(1) Location and size of nursery 

The location and size of the nursery should be determined by considering the following: 

- Location of the planned plantation sites 

- Seedling demand 

- Accessibility for operation and maintenance 

Shade net 

Nursery bed 
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- Accessibility to irrigation seawater and sandy soil for seedling pots 

- Risk of natural hazards (e.g. floods) 

 

(2) Irrigation of seedlings 

There are  two  types of  irrigation method: pump  irrigation method and  tidal  irrigation method.  In 
general, tidal irrigation is suitable if the water source has daily tidal fluctuation. On the other hand, 
pump irrigation is suitable if the water source has no or only limited tidal fluctuation. Details of each 
method are described below: 

 

(i) Tidal irrigation 

Tidal  irrigation  is  highly  recommended  as  the  seedlings  are  irrigated  automatically  through  tidal 
fluctuation. However,  the  level of water  intake and nursery bed must be  carefully  considered  for 
effective  irrigation.  In  general,  water  intake  level  can  be  determined  by  applying  the  following 
formula: 

Water intake level = (Lowest‐H + Highest‐L)/2 

Lowest‐H: lowest high tide level within the year 

Highest‐L: Highest low tide level within the year 

 

The following figure shows the basic structure and water intake level of tidal irrigation nursery. 

 

Fig. 3.7: Basic structure and water intake level of tidal irrigation nursery 

 

(ii) Pump irrigation 

In  case  of  the  pump  irrigation method,  irrigation water  should  be  filled  in  the  planting  pool  by 
operating a pump and drainage gate. The  seedlings  should be  inundated at  least once per day. A 
drainage gutter and drain outlet  is also required for proper drainage, which should be higher than 
the highest high  tide  level  (in case  there  is  tidal  fluctuation). The  following  figures show  the basic 
structure of pump irrigation nursery. 
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Fig. 3.8: Basic structure of pump irrigation 

 

(3) Shading of seedlings 

A  shade  net  can  be  installed  in  the  nursery  to  prevent  damage  of  young  seedlings  from  direct 
sunlight and hot dry wind. The following figure shows an example of shade net structure.  

 

 

Fig. 3.9: Structure of shade net 

 

If possible, the shade net should be removable as excessive shading may promote spindly growth1 of 
seedlings. 

 

(4) Sowing of seeds 

After removing the pericarp, seeds should be sown as soon as possible. Following are some tips for 
seed sowing: 

                                                            
1 Spindly growth: Plants growing under insufficient sunlight and excess fertilization may become overly tall. Such plants 
tend to be weak against diseases and other stresses. 

Frame constructed 
by steel pipes 

Shade net fixed on  
the steel structure 
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- An agricultural vinyl pot can be used as a seedling pot. Typical pots used are 10 cm diameter 
and 25 cm height with punched holes for water to drain. 

- Normal beach sand at  the site or near  the nursery should be used  for soil. Silt or muddy soil 
should not be used. 

- Sow 1 seed per pot. Remove pots with dead seed  (change to black color) and replace by new 
pot with a healthy seed. This  is because dead seeds are quickly  infested by fungi and bacteria, 
which can spread to the other healthy seeds. 

- One third (1/3) to half (1/2) of the seed should be out of sand as shown in the figure below. 

 

 

 

 

 

 

 

Fig. 3.10: Sowing depth of seeds 

 

Fig. 3.11: Young shoots after 7‐10 days after sowing 

 

Fig. 3.12: Seedling growth 4 months after sowing 

Depth for sowing

2~3 seeds/pot 
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(5) Operation and maintenance 

Main  activities  after  seed  sowing  are  irrigation management  and  shade  control. Make  sure  the 
nursery  is  regularly  inundated  and  drained  properly.  The  following maintenance works  are  also 
required to keep the nursery in good condition: 

- Steel  pipes  used  for  the  nursery  should  be maintained  especially  for  the  part  inundated  by 
seawater, as  it can quickly corrode. One of the examples shown  in the figure  is to protect the 
bottom of the steel pipe by PVC pipe and concrete. 

     

Fig. 3.13: Protection of steel pipe from seawater 

- Shade  net  should  be  periodically  cleaned  in  order  to  keep  the  light  conditions  constant. 
Furthermore, shade net should be replaced from time to time. 

 

     

Fig. 3.14: Cleaning of shade net 

 

(6) Temporary nursery  

The  structure  of  the  temporary  nursery  is  much  simpler  than  permanent  type.  Construction 
materials  are  usually  available  at  the  site  and  has minimal  requirement  of  concrete  structures. 
Number  of  planting  pool  to  be  constructed  should  be  determined  by  calculating  the  number  of 
seedling  to  be  required  for  the  designated  planting  area  and  planting  schedule.  Following  figure 
shows the basic design of the temporary nursery. 
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Fig. 3.15: Basic design of temporary nursery 

 

3.3 Transplanting of seedling 

In general, seedlings should be transplanted among others by considering the following: 

- The  upper  half  of  the  intertidal  zone  (between mean  water  level  and  high  water  level)  is 
generally suitable for transplanting 

- Area with very slow current and no strong wave 

- Soil with good drainage (e.g. sand) 

- Water salinity less than 50 ppt (5%) 

 

(1) Procedure for transplanting 

(i) Timing and season 

Seedlings can be transplanted about 6 months after sowing. Therefore,  in Oman, transplantation  is 
usually conducted around  January‐February  in Northern Regions, and  in November‐December and 
June‐July in the Dhofar region. 

 

(ii) Necessary equipment 

25
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- Truck and wheel barrow for transportation of seedling, pots and equipment. 

     

Fig. 3.16: Truck and wheel barrow for seedling transportation 

 

- Trowels or shovels for digging and backfilling. 

 

Fig. 3.17: Trowels and shovels for digging and backfilling 

 

- Measuring rope (e.g. 50 m) with 1 m interval mark 

- Compass bearing to determine direction of the measuring rope 

- GPS for recording the transplanted location. 

 

(iii) Procedure 

- Start transplanting work at the time of lowest tide. 

- Stretch a measuring  rope at  the designated planting area and dig a hole at  constant  interval 
(e.g. 1 m) along the rope. 

- Transplant seedlings at the hole prepared by referring to the following figure. 
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Fig. 3.18: Process of seedling transplantation 

 

- To protect the seedlings from waves and seaweeds, the frontline of plantation area should be 
planted densely. Recommended planting density is (0.7‐1.0 m) × (0.7‐1.0 m). 

- Following  is a brochure  that can be distributed during  transplantation events, which provides 
basic plantation procedures with illustrations. 

A:  Dig a hole a little bit deeper than the 
pot 

B:  Remove the plastic pot and put the 
seedling with soil without damaging 
roots 

C:  Backfill the hole with soil and compact 
moderately 

A

B

C
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Fig. 3.19: Brochure explaining the basic procedure of seedling transplantation 

- Upon  completion  of  the  plantation  works,  record  the  coordinates  of  the  perimeter  of  the 
planted area with GPS.  

 

(2) Monitoring of seedling 

The  transplanted  seedlings  should be  regularly monitored  (e.g. 1 month)  to observe  their growth 
and  health,  as  well  as  to  identify  any  natural  and  human  threats.  The  monitoring  method  is 
described in the “Mangrove Monitoring Guideline (Technical Document 2).  
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4. Plantation by direct sowing method 

4.1 Seed collection and treatment 

Seed collection and treatment for direct sowing method is generally same as seedling transplantation 
method. 

 

4.2 Direct sowing 

Compared  to  the  seedling  transplantation method,  the direct  sowing method  is  low  in  cost  as  it 
requires no  seedling production  in  the nursery. Furthermore,  the growth  speed of  the  seedling  is 
faster for direct sowing because the sown seeds extend their root system smoothly in the soil after 
sowing. On the other hand, the transplanted seedlings need certain period for extending new root 
system in the dug pit and consequently seedling growth is slow during this period. 

 

(1) Location for direct sowing 

Basic conditions required for the planting site are the same as the seedling transplantation method. 
However,  the  adjacent waters  need  to  be  very  calm  to  avoid  seed  dispersal.  The  direct  sowing 
method can also be applicable in deep swampy areas where people cannot enter to work. 

 

(2) Sowing procedure 

Sowing season  is dependent on the seed collection time. It can be July‐August  in northern regions, 
and May‐June and December‐January in Dhofar Region.  

Compared  to  the  transplantation method,  large  number  of  seeds  can  be  used  for  direct  sowing. 
Although the germination rate of each seed in direct sowing may be lower, it can be compensated by 
the sheer quantity of seeds available.  

Seeds maybe sown by scattering or by sowing them into the soil. In the later case, depth of sowing 
should be adjusted according to the soil conditions. In sandy areas seed should be placed 3 cm under 
surface and covered with sand. While in muddy or silty areas, half of the seed should be out of mud.  

 

Fig. 4.1: Sowing of seeds by scattering 
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Appendix 1  Field check list and evaluation sheet for site selection 
 

Attachment-1: Field Checklist for Site Selection (Observation Sheet)

No. Points to be checked
Favorable condition for

plantation (5 point)
Medium condition for

plantation (3 point)
Unavorable condition for

plantation (1 point)
Note

1
Situation of the mouth of
khawr

Mouth of khawr is opened
throughout the year

Mouth of khawr is
occasionally closed

Mouth of khawr is closed
throughout the year

5 4 3 2 1

2
Situation of the tidal
current and ocean wave

Tidal current and wave are
calm throughout the year

Tidal current and wave are
occasionally strong

Tidal current and wave are
strong throughout the year

5 4 3 2 1

3 Extent of intertidal zone Intertidal zone is wide and flat
Intertidal zone is medium and
rather slopy

Intertidal zone is narrow and
steep

5 4 3 2 1

4 Thickness of the soil layer
Enough soil depth for root
growth more than 15cm

Limited soil depth for root
growth less than 15cm

No soil layer at all 5 4 3 2 1

5
Smell of hydrogen sulfide
from subsurface soil layer

No smell of hydrogen sulfide
from soil layer at all

Some smell of hydrogen
sulfide in some places

Strong smell of hydrogen
sulfide at everywhere

5 4 3 2 1

6 Salinity level of water
Average water salinity is very
low (less than 2%)

Average water salinity is
similar to ordinary sea water
(3-4%)

Average water salinity is very
high (more than 5%)

5 4 3 2 1

7
Situation of the grazing
activity potential

No grazing activity potential at
all

Occasional grazing activity
potential seasonally

Heavy grazing activity
potential due to the situation

5 4 3 2 1

8
Land use situation by the
local community

No human activity in the site
Occasional human activity in
the site

Heavy human activity in the
site

5 4 3 2 1

9
Access from the main road
to the site for plantation
and maintenance

Easy access from the main
road to the site by road

Moderate access from the
main road to the site with
rough road

Difficult access from the main
road to the site wthout road

5 4 3 2 1

10
Utilization as birds feeding
ground

No use  as birds feeding
ground

Some use as birds feeding
ground

High use as birds feeding
ground

5 4 3 2 1

11 Coastal development plan No plan for future development
Some paper plan for future
development

Practical plan for future
development

5 4 3 2 1

GPS Easting:                                                                   

Tide during survey (hig/low):                                                                                   

Existing mangrove tree (matured tree/seedlings):                                                   

Evaluation 

Date:                                         

Location:                                  

GPS Northing:                                                                 
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Field Checklist for Site Selection (Sample Evaluation Sheet)

No. Points checked Evaluation Note

Satellite Image or Google Earth Image

1
Situation of the mouth of
khawr

4 Better to ask local people

2
Situation of the tidal
current and ocean wave

4
Generally calm but some wind ripple was
observed

3 Extent of intertidal zone 3 Generally flat and more or less wide area

4 Thickness of the soil layer 5 Deep enough

5
Smell of hydrogen sulfide
from subsurface soil layer

5 No smell at all

6 Salinity level of water 3 Better to check several places
Evaluation Result

7
Situation of the grazing
activity potential

4
No symptom was observed on mangrove
leaves

8
Land use situation by the
local community

4
Site is adjacent to the residential area of
the local people

9
Access from the main road
to the site for plantation
and maintenance

3 Need to pass rough road

10
Utilization as birds feeding
ground

3 Several species of birds were observed

11 Coastal development plan 4 Better to ask local people

GPS Northing:563513

GPS Easting:2630736

Tide during survey (hig/low): Surveyed during low tide

Existing mangrove tree: Both matured trees and seedlings were available

Date: 2013/10/4

Location: Grim

0

1

2

3

4

5
1

2

3

4

5

67

8

9

10

11
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1 Introduction 

1.1  Objective of the Guideline 

The Mangrove Protection Guideline (hereinafter abbreviated as “Guideline”) was prepared mainly to 
assist the staffs of QEIC/MECA responsible for managing and protecting the mangrove ecosystem in 
Oman.  The  Guideline  explains  potential  threats  to  mangrove  ecosystems  in  Oman  and 
recommended  measures  to  counter  against  these  threats,  which  includes  practical  as  well  as 
regulatory measures. Note  that  the Guideline  focuses on protecting not only  the mangrove  forest 
but also the various fauna that constitute the mangrove ecosystem. 

 

1.2  Legal framework related to mangrove ecosystem protection 

Existing laws and regulations related to mangrove protection are as follows: 

 The  Law on Conservation of  the Environment  and Prevention of Pollution  (Royal Decree No. 
114/2001) 

 The Law on Nature Reserves and Wildlife Conservation (Royal Decree No. 6/2003) 

 Decision No 20/90 regarding the rules regulating and specifying coastal setbacks 

Although there are no direct descriptions about mangroves  in these  laws and regulations, relevant 
articles are as follows. 

 

Royal Decree No. 114/2001 

This  law  is  the basic environmental  law of Oman. Article 21 prohibits  cutting down, uprooting or 
damage of any tree, shrub or grass  in public forests, without obtaining a permit from the Ministry. 
Article 33 penalizes anyone who cuts down tree  in conservation area by either  imprisonment for a 
term not exceeding one month or with fine not  less than RO 10 and not more than RO 500. Since 
mangroves are basically public forests, these articles are applied. 

 

Royal Decree No. 6/2003 

This  law  is  the basic  law  regarding nature  reserves and wildlife  conservation. Nature  reserves are 
designated by Royal Decree as  stipulated  in Article 10. QNR and khwars of  the Dhofar  region are 
nature reserves with mangrove distribution. QNR and khwars of the Dhofar region are designated as 
nature reserve through Royal Decree 38/75 and Royal Decree 49/97, respectively.  

Article 13  stipulates  the development of management plan.  The management plan  is  required  to 
designate  the  nature  reserve  into  public  zone,  specially  protected  zone  and  zone  for 
research/education purposes. 

 

Decision No 20/90 

The  Decision  specifies  setbacks  for  coastal  areas  including  sandy  beaches  and  khwars,  which  is 
where mangroves are commonly distributed. Setbacks of sandy beaches and khwars are specified as 
150 m from the maximum end of tidemark. However, setbacks may be specified as 50 m for beaches 
where the construction developments have limited impact on the environment. 
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2 Potential threats to mangrove ecosystem and recommended protective measures  

2.1  Coastal development 

1) Threats 

Coastal development may adversely affect mangrove ecosystem in various ways. While development 
in mangrove  area  is basically  prohibited  in Oman,  it  is  important  to  be  aware  that  development 
activities outside of mangrove areas can also affect mangrove ecosystem, which may somewhat be a 
more gradual and long‐term process.  

Port construction, including marinas, is one of the major threats to mangroves in Oman. An example 
can  be  seen  at  Khawr Harmul  at  Liwa.  Following  the  construction  of  Port  of  Sohar  at  a  location 
approximately 2.5 km southeast from Khawr Harmul, severe beach erosion and accretion occurred 
along  the coastline, and as a  result,  the mouth of Khawr Harmul had moved 200‐300 m  from  the 
original  location.  Figure  1  shows  how  the  location  of  the mouth  of  Khawr  Harmul  has  changed 
before and after port construction. Such movement of the mouth will have changed significantly the 
hydrology of the mangrove forest, and as a result threaten the long‐term survival of the mangroves. 
In extreme  case,  the mouth of Khawr Harmul  could eventually  close  through  sediment accretion, 
which will have devastating impacts on the mangrove ecosystem as there will be no more seawater 
inflow from the mouth. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 1  Location of mouth of Khawr Harmul before and after port construction 

 

Road  construction  in  the  vicinity  of  the  mangrove  forest  may  also  have  adverse  impacts.  For 
example, when roads are built, the underlying soil is compressed and this results in soil compaction. 
This  as  a  consequence, may  alter  the  hydrology  of  the mangrove  area  (e.g.  hindrance  of water 
drainage), and as a result affect mangrove health.  

Construction activities may also impact mangrove ecosystems. Following are some examples: 

 Pollution of lagoon water by discharge of construction wastewater (see Figure 2) 

 Disturbance to fauna (e.g. birds) by emission of loud noise (e.g. pile‐driving works) 

 Accumulation of dust on mangrove leaves by dust dispersion 

Location of mouth of Khawr Harmul 
after port construction (May 2002) 

Location of mouth of Khawr Harmul 
before port construction (Feb. 1998) 
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Figure 2  Wastewater discharge into QNR 

 

2) Protective measures 

Establishment of buffer zone 

To protect mangrove ecosystem  from encroaching development activities, a “buffer zone” may be 
established outside  the periphery of mangrove  forest  (see Figure 3). While people will be  free  to 
enter  the buffer  zone, no  industrial,  commercial or housing  structures will be allowed  to be built 
inside  the  buffer  zone,  including  temporary  structures  (e.g.  access  road).  However,  small‐scale 
structures  that  are  used  for  recreational  purposes  (e.g.  boardwalk,  huts) may  be  exempted.  The 
width  of  the  buffer  zone may  be  determined  on  a  site‐by‐site  basis,  by  taking  into  account  the 
characteristics of each site.  

A buffer zone may also help to remove pollutants contained  in wastewater (e.g. from septic tanks) 
through its soil purification function, and consequently prevent or minimize pollutants reaching the 
mangrove area. 

 

 

 

 

 

 

 

Figure 3  Concept of buffer zone 

 

Implementation of EIA 

Any development projects with potential  impacts on mangrove  ecosystem  should be  required  to 
undertake an Environmental  Impact Assessment  (EIA)  study. The EIA  study  should  include among 
others  a  detailed  baseline  study,  analysis  of  alternatives,  impact  assessment  and  environmental 
management plan. Following are some important points to be covered by the EIA: 

 The EIA should have a detailed and rational description on the site selection process, including 
an analysis of alternative development sites.  
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 The baseline  study  should be based on a comprehensive  field  survey,  including both physical 
(e.g. water  quality)  and biological  environment.  Seasonal  variations  in  the  environment  (e.g. 
migratory patterns of birds)  should be  taken  into  account when planning  the  timing of  field 
surveys.  

 Impacts on hydrology (both groundwater and surface water) and topography of the mangrove 
forest are one of  the major concerns, and hence should be assessed  in detail by  for example 
employing a numerical simulation model.  If significant changes are predicted,  impacts of such 
changes to the mangrove ecosystem should be assessed in detail including long‐term impacts.  

 A detailed environmental management plan  should be provided  if any  impacts on mangrove 
ecosystem are predicted. The environmental management plan  should  include cost,  schedule 
and  the  organization  responsible  for  implementing  the mitigation measures  and monitoring 
activity. 

 

2.2  Tourism 

1) Threats 

Mangrove forests have high potential for tourism as it can readily provide opportunities for people 
to enjoy greenery and its rich biodiversity. While tourism in mangrove forests should be encouraged, 
it  could have  adverse  impacts on mangrove  ecosystem,  if  conducted  in  an uncontrolled manner. 
Possible impacts of tourism include: 

 Disturbance of benthic organisms by  tourists  trampling over  their habitats  (e.g. burial of crab 
burrows) 

 Disturbance of sensitive wildlife by  inconsiderate behaviour of tourists  (e.g. chasing or scaring 
off birds) 

 Collecting of animals by tourists 

 Littering and defecation by tourists 

 

2) Protective measures 

In  order  to  promote  sustainable  tourism,  certain  facilities  and  rules  should  be  set  to  avoid  or 
minimize adverse impacts. Following are some recommended measures: 

 To  minimize  disturbance  to  benthic  habitat,  tourist  should  be  allowed  to  walk  only  along 
designated pathways. Boardwalks may be constructed for this purpose (see Figure 4). 

 Number  of  tourists  entering  the mangrove  forest  should  be  limited  to  prevent  unnecessary 
disturbance to wildlife. A no‐entry period may be established to allow recovery of animals. 

 Shouting or generating loud noise should be prohibited. 

 Collection of wildlife should be prohibited.  

 Littering should be strictly prohibited and should be taken back by the tourist. 

 Toilets should be installed at appropriate locations. 

 Signboards should be installed that shows the prohibition rules. 
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Figure 4  Boardwalk in QNR 

 

2.3  Waste dumping 

1) Threats 

Mangrove forests could end‐up as a convenient place for dumping wastes, as the dumped waste will 
be hid by the trees and not be as visible as dumping in open space. Waste dumped in the upstream 
area or sea may also end‐up in the mangrove forest by flood, current and tidal movement. Following 
are some potential adverse impacts of waste dumping: 

 Wastes can bury habitats of benthic organisms (e.g. crabs). 

 Animals could consume wastes by mistaking them as food. 

 Wastes  (e.g.  plastic  bag)  can  entangle  on  young mangrove  trees  and  consequently  bend  or 
uproot the stem by acting like a sail in windy condition (see Figure 5). 

 Wastes (e.g. plastic bag) can entangle or bury aerial roots and consequently hinder respiration 
of mangrove trees (see Figure 5). 

 Toxic pollutants such as PCBs can leak out from wastes (e.g. electrical products) and pollute the 
forest and kill animals. 

 Food waste could attract unwanted animals such as rats. 

   

Figure 5  Impacts of waste on mangrove forest 
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2) Protective measures 

Illegal waste dumping is a common occurrence among localities where their waste collection system 
is  inadequate or enforcement of proper waste disposal  is weak. Strengthening of  the  local waste 
management  is  hence  the  first  priority.  Following  are  some  additional measures  that  could  be 
implemented: 

 Implementation  of  education  and  awareness  campaigns  (e.g.  beach  clean)  to  reduce  illegal 
dumping.  

 Signboards  may  be  installed  at  mangrove  areas  that  are  prone  to  waste  dumping  (e.g. 
mangrove  areas  located  adjacent  to  roads).  Fences  and  surveillance  cameras  may  also  be 
installed if signboards are ineffective. 

 

2.4  Mangrove utilization 

1) Threats 

Mangrove  trees  have  been  utilized  by  local  people  as  building materials  (see  Figure  6),  animal 
fodder,  firewood  and  so on. While  these  activities  are now prohibited  in Oman,  they  are  still  an 
ongoing practice in some rural areas. If these activities continue on an unsustainable manner, it may 
threaten the existence of mangrove forest. 

 
Figure 6  Hut made from mangrove 

 

2) Protective measures 

Although  cutting or damaging of mangrove  tree  is prohibited,  it may be difficult  to enforce  such 
rules in rural areas due to their remote locations. The local people may also feel that they have the 
right to use mangroves, as such practices may have been conducted traditionally for many years. In 
such case, as a comprise solution, MECA may as an exception allow the use of mangrove, providing 
that it will be conducted in a sustainable manner. Following are some suggestions of sustainable use 
of mangrove: 

 Leaf  grazing may  be  allowed with mature  trees  that  grow  along  fringes  of  dense mangrove 
forest.  On  the  other  hand,  leaf  grazing  should  not  be  allowed  with  young  trees  or  where 
mangrove density is low. Also a “no‐grazing period” may be established to allow mangrove leaf 
regeneration. 

 Use of mangrove for building material and firewood may be allowed providing that only dead or 
near‐dead branches  (e.g. branches with no or very  few  leaves) are  selected. This may  in  fact 
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improve  the  condition of  the  forest,  as  it will enhance  aeration within  the  forest  and hence 
reduce risk of fungi growth. 

In any case, MECA should discuss thoroughly with the  local stakeholders about how to sustainably 
use mangrove, and develop a “mangrove management plan”. The management plan should include 
information such as: 

 Areas where mangrove utilization is allowed 

 Areas where mangrove utilization is strictly prohibited 

 Period when mangrove utilization is prohibited 

Where mangrove  utilization  is  strictly  prohibited,  fences  and  notice  signboards may  be  installed 
around the area to prevent people entering.   

 

2.5  Collection of fauna 

1) Threats 

Mangrove forests are known to provide habitat for various fauna including commercial fish and crab 
species.  Collecting  such  fauna  for  food  or  selling,  even  at  small  quantity, may  have  significant 
adverse impacts on mangrove ecosystem, especially in Oman where most forests are relatively small 
and hence have  limited carrying capacity of  fauna. Reduction of  fauna will also  result  in  less  food 
available for migratory birds. Mangrove forests also function as a nursery for young fishes and crabs, 
and collecting such fauna may result in reduction of local marine resource.  

 

2) Protective measures 

In principal, fauna collection should be prohibited at all mangrove forests for reasons stated above. 
An exception may be applied  to  relatively  large mangrove  forest and where  its  local population  is 
small enough that collection can be conducted on a sustainable basis. However, even  in such case, 
rules such as the following should be applied: 

 Catching of juvenile fish should be avoided by using nets with large mesh size. 

 A no‐fishing period should be applied to allow recovery of fish stock. 

 Only mature crabs should be caught. A size limit should be established for each species.  

In any case, MECA should discuss thoroughly with the  local stakeholders about how to sustainably 
use  the  fauna  resource,  and develop  a  “fauna management plan”.  The management plan  should 
include information such as: 

 Prohibited collection methods 

 Permitted mesh size 

 Size limit for all target species 

 No collection period 

 

2.6  Invasive species 

1) Threats 

Invasive  species may have  significant  impacts on  the mangrove ecosystem. For example, Prosopis 
juliflora  is  an  invasive plant  species  that has  colonized many  areas of Oman,  and  some  are  seen 
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along fringes of mangrove forest (see Figure 7). Since, Prosopis juliflora is known to be relatively salt 
tolerant,  they  could  possibly  invade  into  existing  mangrove  areas  if  conditions  become  more 
favorable for their growth. 

  
Figure 7  Example of invasive plant species 

 

During a recent fish survey at QNR, a tilapia species was collected, which are generally considered as 
an  invasive  species  (see  Figure  8).  They may  be  a  possible  threat  to  the  native  species  of QNR 
through  competition  for  food  and  nest  space. One  tilapia  species  (Oreochromis mossambicus)  is 
nominated as IUCN’s “100 of the World's Worst Invasive Alien Species”.  

 

Figure 8  Tilapia species caught in QNR 

 

2) Protective measures 

It  is  very hard  to  completely  remove  invasive  species once  they become established  in  the  area. 
Therefore,  it  is  important  to detect  invasive  species  in advance  through monitoring activities and 
implement  proactive measures  before  they  proliferate  to  irreversible  levels.  The  cause  of  such 
intrusion  of  invasive  species  should  also  be  investigated  and  measures  taken  to  prevent  any 
recurrences.  MECA  should  also  make  a  list  of  invasive  species  that  have  risk  of  intrusion  into 
mangrove areas. 

 

2.7  Overgrowth of algae 

1) Threats 

Some algae species  increase explosively when conditions are suitable (e.g. excess of nutrients) and 
can accumulate to form visible filamentous algae mats (see Figure 9). These algae mats, when they 
entangle on mangrove trees, can have a wide range of adverse effects (e.g. hindrance to mangrove 
respiration by smothering the aerial roots). Young mangrove seedlings are also vulnerable to algae, 
as  they  can  cover‐up  the  entire  seedling  including  the  leaves  (see  Figure  9).  This  can  hinder 
photosynthesis as well as stress the stem with its weight.  

Prosopis juliflora 
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Figure 9  Algae covering aerial root (left) and seedlings (right) 

 

2) Protective measures 

In order to minimize entanglement of algae on young seedlings, nets may be installed in front of the 
seedlings.  If  done  properly,  algae  should  entangle  onto  the  net  and  not  reach  the  seedlings. 
However, once algae are entangled onto the seedlings, the only option will be to remove by hand. 
Such work could be conducted as a part of environmental education by inviting local schools and/or 
relevant organizations. 

   

Figure 10  Examples of net installation 
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1. Objectives of environmental education

1.1 General objectives of environmental education

The objectives of environmental education are described in the Tbilisi Declaration (1977) adopted at
the intergovernmental meeting organized by UNESCO in 1977. Table 1 shows the objective of
environmental education endorsed by the Tbilisi Declaration.

Table 1 Objectives of environmental education endorsed by the Tbilisi Declaration
Category Objective

Awareness To help social groups and individuals acquire an awareness and sensitivity to the
total environment and its allied problems.

Knowledge To help social groups and individuals gain a variety of experience in, and acquire a
basic understanding of, the environment and its associated problems.

Attitudes To help social groups and individuals acquire a set of values and feelings of concern
for the environment and the motivation for actively participating in environmental
improvement and protection.

Skills To help social groups and individuals acquire the skills for identifying and solving
environmental problems.

Participation To provide social groups and individuals with an opportunity to be actively involved
at all levels in working toward resolution of environmental problems.

Source: Tbilisi Declaration, UNESCO, 1977

1.2 Setting of environmental education objective

The objective of the environmental education should be first determined by considering the
following points:

- Target group of environmental education

- What the target group should know?

- How much / deep target group should know?

Table 2 shows examples of some of the topics that could be covered for education programs of
mangrove ecosystem.

Table 2 Example topics for mangrove ecosystem education programs
No Topic Contents
1 Characteristics of

mangrove tree
What is mangrove?
Mangrove diversity
Mangrove distribution in Oman and the world
Characteristics of Avicennia marina
Adaptation to stressful environment (high salinity, low oxygen)
Reproduction of mangrove (viviparous seeds)

2 Characteristics of
mangrove ecosystem

Fish (e.g. main types, what they eat, many juvenile fish)
Crabs (e.g. main types, main habitats, what they eat)
Snails (e.g. main types, main habitats, what they eat)
Birds (e.g. residential and migratory birds, migratory route/season)
Other fauna (worms, insects, microorganisms)
Food chain of mangrove ecosystem
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No Topic Contents
3 Benefits of mangrove

ecosystem
Provides precious greenery
Nursery for various fauna
Feeding and resting area for birds
Coastline protection
Place for relaxation
Potential source of income for locals (e.g. ecotourism, honey production)
Water purification
CO2 fixation

4 Threats to mangrove
ecosystem

Animal grazing
Overgrowth of algae
Intrusion of invasive species
Coastal development (e.g. ports and roads)
Discharge of wastewater
Waste dumping

5 QEIC’s activities to protect
mangrove ecosystem

Plantation activity
Environmental education activity
Training activity
Monitoring activity

Prepared by JICA Expert Team

2. Preparation of environmental education materials

Education materials should be developed by considering the objective and characteristics of the
target groups. For example, the characteristics of mangrove ecosystem can be explained by a booklet
with illustrations. Games and quiz may be used then to obtain a further understating of the
ecosystem. Table 3 shows education materials prepared by the Project. A soft copy of the education
materials are included in attached CD Appendix 1.
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Table 3 Environmental education materials prepared by the Project
No Type Name Description
1 Brochure Basic procedure of mangrove

seedling transplantation
A brochure explaining the procedure of mangrove
transplantation

2 Importance of mangrove
ecosystem

A brochure introducing the importance of mangrove
ecosystem

3 Poster Food chain of mangrove
ecosystem

A poster explaining the mangrove food chain

4 Mangrove forest in Oman A poster showing the distribution of mangrove forests in
Oman

5 Mahut Island A poster explaining the characteristics of Mahut Island
6 Qurm Nature Reserve A poster explaining the characteristics of QNR
7 Khwar Sawadi A poster explaining the characteristics of khwar Sawadi
8 Game Mangrove quiz Quiz for learning about mangrove
9 Field bingo Bingo cards that can be used for field bingo activity

10 Card puzzle Puzzle for learning about mangrove animals
11 Field guide Animals of mangrove forest in

Oman
A field guide showing the common animals found in
mangrove forests in Oman

12 Booklet Do you know mangroves? An illustrative booklet for children explaining the
mangrove ecosystem

13 QEIC Learning Book A booklet for learning about mangrove ecosystem
14 Panels Introduction on mangrove

ecosystem
Panels explaining the mangrove ecosystem

15 Video Wonder trees in the sea A short video showing the tidal changes in mangrove
forest

16 Certificate My-tree certificate A certificate and field note used for mangrove
monitoring activities

Prepared by JICA Expert Team

Following are examples of some of the materials mentioned in the above table.

Mangrove quiz:

Questions related to mangroves and mangrove ecosystem will be asked, which is composed by
multiple choice, yes or no question, or open question. An example of the mangrove quiz is shown in
Figure 1.

Prepared by JICA Expert Team
Figure 1 Examples of mangrove quiz
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Field bingo:

The bingo card is prepared, including components of mangrove ecosystems, such as bird, fish, crab,
and shell. The bingo card will be used in the field, to identify the components described on the card.
An example of the bingo cards is shown in Figure 2.

Prepared by JICA Expert Team
Figure 2 Examples of field bingo
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3. Development of environmental education programs

3.1 Development of environmental education modules

In order to diversify the education programs, many types of modules should be developed by
considering the objective, target group and timing. Also consider the following characteristics in the
learning process:

- What I hear … I forget.

- What I see … I remember.

- What I do … I understand.

Therefore, it is important to incorporate participatory activities into the education program, so that
the participants can experience firsthand the mangrove ecosystem, such as wildlife observation and
mangrove plantation. Table 4 shows the environmental education modules developed through the
Project.

Table 4 Environmental education modules developed through the Project
No Module name Contents Objective Target group Timing
1 Nature game:

Role play
Teaching the relationship of
each component of mangrove
ecosystem through role play
using drawings of the
components.

Understanding
relationship of
components of
mangrove ecosystem

Students Throughout
the year

2 Nature game:
Searching cards

Searching cards and making a
sentence which describes
characteristics of mangrove.

Understanding
mangroves

Students Throughout
the year

3 Card puzzle Completing a photo of common
birds of mangrove forest by
combining pieces of the photo.

To learn common birds
of mangrove forest

Any target
group

Throughout
the year

4 Jigsaw puzzle Completing a drawing of
mangrove ecosystem by
combining jigsaw puzzle pieces.

To learn animals of
mangrove ecosystem

Any target
group

Throughout
the year

5 Field bingo Field bingo card including
mangrove, fish, crab, shrimp,
shell, and bird as components
of mangrove ecosystem.

To learn animals of
mangrove ecosystem

Any target
group

Except for
summer

6 Mangrove quiz Asking questions regarding
mangroves and mangrove
ecosystem.

Understanding
mangroves and
mangrove ecosystem

Any target
group

Throughout
the year

7 Bird watching Observing birds in mangrove
forest.

To learn common birds
of mangrove forest

Any target
group

Except for
summer

8 Fish catching Catching fish and other aquatic
fauna by using cage or seine
net.

To learn common
aquatic fauna of
mangrove forest

Students Throughout
the year

9 Mangrove
cultivation in
plastic bottle

Growing a mangrove seedling
by hydroponics using a plastic
bottle.

Understanding
mangrove growth
process

Any target
group

July – Sep.
(when
seeds are
available)

10 Drawing Drawing a painting of Understanding Students Except for
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No Module name Contents Objective Target group Timing
competition mangroves and mangrove

ecosystem.
mangroves and
mangrove ecosystem

summer

11 Introduction of
mangrove
ecosystem (1)

Explanation of mangroves and
mangrove ecosystem, and
observing them.

Understanding
mangroves and
mangrove ecosystem

Any target
group

Except for
summer

Introduction of
mangrove
ecosystem (2)

Introduction of mangrove
ecosystem and the benefits and
threats to the ecosystem.

To understand about
mangrove ecosystem
and the benefits and
threats.

Any target
group

Except for
summer

12 Introduction of
mangrove
nursery

Explanation of mangrove
nursery and important points of
seedling transplantation.

To learn how to plant
mangrove seedlings

Any target
group

Except for
summer

13 Mangrove
plantation

Planting mangrove seedlings
and monitoring their growth by
tagging.

To learn how to plant
mangrove seedlings

Any target
group

October -
April

14 Observation of
planted seedlings

Observing planted mangrove
seedlings at the planted site.

Understanding
mangroves

Any target
group

Except for
summer

15 Cleaning Cleaning the planted site, and
observing the planted
seedlings.

Maintaining growing
environment of
mangroves

Any target
group

Except for
summer

16 Mangrove
monitoring

Participants will select a
mangrove tree to monitor its
growth. Participants will receive
a certificate for their tree.

Enhancing awareness to
conserve mangrove
forest

Any target
group

Except for
summer

Prepared by JICA Expert Team

Details of each module should be recorded into an “Activity sheet”, which includes information such
as target group, goal of the module, required materials and time table. Table 5 shows the format of
the “Activity sheet”. The “Activity sheet” of each module in Table 4 is attached as Appendix 2.

Table 5 Format of “Activity sheet”
ITEM DESCRIPTION

Name of activity
Category of activity
Target group KG   Primary   Secondary General
Number
Time required
Time to implement
Place to implement Indoor     Outdoor
Required materials
Goal of the activity
Remarks

Time Activity Description Materials

Prepared by JICA Expert Team
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3.2 Formulation of environmental education program

An environmental education program can be formulated by selecting and combining the developed
modules. Modules should be selected by considering the objective, target group, season, time
limitation and so on. Figure 3 shows necessary steps to formulate an environmental education
program.

.

Prepared by JICA Expert Team
Figure 3 Steps to formulate an environmental education program

3.3 Evaluation of environmental education program

Evaluation of the program is important: 1) to identify the effects of the program and 2) to identify
good and bad points of the program. The evaluation results are then referred to improve or create
new programs. Evaluation may be conducted by obtaining feedback from the participants. There are
various evaluation methods such as: questionnaire, putting-a-sticker method and evaluation quiz.
Format for such evaluation method are attached in Appendix 3. Following are some of the main
questions that could be asked to the participants:

 What did you enjoy most about today’s activities?

 What did you learn during today's activities?

 What do you want to do to conserve the mangrove ecosystem?

 Your comments & suggestions for today’s activities

Internal evaluation is also important. Following are some questions that could be asked within the
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staffs:

 Today’s good and bad points

 Have we achieved the goal of the program (degree of achievement (%))

 How we can improve the program

3.4 Examples of environmental education program

Examples of environmental education program for different target groups (primary school, private
company, local community) are shown in Tables 6-8. An example environmental education program
for QNR is shown in Table 9.

Table 6 Example of environmental education program for primary schools
(conducted at school)

Time Activity Module
no.*

Required
materials Venue

09:00 – 09:10 Introduction of mangrove forest in
Oman 11 Poster Class room

09:10 – 09:40 Understanding mangrove ecosystem
through role play 1 Card Class room

09:40 – 10:00 Understanding animals of mangrove
ecosystem 3 Card puzzle Class room

10:00 – 10:15 Evaluation by participants Feedback sheet Class room
*: Details of the module are described in Table 4.
Prepared by JICA Expert Team

Table 7 Example of environmental education program for private companies
(conducted at QNR)

Time Activity Module
no.*

Required
materials Venue

09:00 – 09:10 Introduction of mangrove forests in
Oman 11 Poster Shade hall

09:10 – 09:20 Understanding food chain in mangrove
ecosystem 11 Poster

Brochure Shade hall

09:20 – 09:30 Visiting mangrove nursery 12 - Nursery
09:30 – 09:45 Observing mangrove forest 11 Photo list Boardwalk
09:45 – 10:15 Monitoring of mangrove 16 Tree measure Mangrove area
10:15 – 10:30 Evaluation by participants Feedback sheet Shade hall

*: Details of the module are described in Table 4.
Prepared by JICA Expert Team
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Table 8 Example of environmental education program for local community
(conducted at mangrove plantation site)

Time Activity Module
no.*

Required
materials Venue

09:00 – 09:15 Introduction of mangrove forests in
Oman 11 Poster Planting site

09:15 – 09:30 Understanding food chain in mangrove
ecosystem 11 Poster

Brochure Planting site

09:30 – 09:40 Planting mangrove seedlings 13 Brochure Planting site
09:40 – 09:50 Cleaning the planting site 15 - Planting site
09:50 – 10:00 Evaluation by participants Feedback sheet Planting site

*: Details of the module are described in Table 4.
Prepared by JICA Expert Team

Table 9 Example of environmental education program in QNR

Time Activity Module
no.*

Required
materials Venue

09:00 – 09:10 Introduction of mangrove forests in
Oman 11 Poster Shade hall

09:10 – 09:20 Understanding food chain in mangrove
ecosystem 11 Poster

Brochure Shade hall

09:20 – 09:30 Visiting mangrove nursery 12 - Nursery
09:30 – 09:45 Observing mangrove forest 11 Photo list Boardwalk

09:45 – 10:15 Bird watching 7 Photo list,
telescope Mudflat

10:15 – 10:30 Evaluation by participants Feedback sheet Shade hall
*: Details of the module are described in Table 4.
Prepared by JICA Expert Team

Record of environmental education programs conducted through the Project is attached in Appendix
4 as references for the development of education programs.
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1

Soft copies of the environmental education materials listed in the following table are stored in the
attached CD.

No Type Name Folder no.
in the CD

1 Brochure Basic procedure of mangrove seedling transplantation 1
2 Importance of mangrove ecosystem 2
3 Poster Food chain of mangrove ecosystem 3
4 Mangrove forest in Oman 4
5 Mahut Island 5
6 Qurm Nature Reserve 6
7 Khwar Sawadi 7
8 Game Mangrove quiz 8
9 Field bingo 9

10 Card puzzle 10
11 Field guide Animals of mangrove forest in Oman 11
12 Booklet Do you know mangroves? 12
13 QEIC Learning Book 13
14 Panels Introduction on mangrove ecosystem 14
15 Video Wonder trees in the sea 15
16 Certificate My-tree certificate 16
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1. Nature game: Role play game on mangrove ecosystem 
a) Activity sheet 

Activity sheet (Nature Game) 
ITEM DESCRIPTION 

Name of Activity Role Play Game on Mangrove Ecosystem 
Category of Activity Nature Game 
Target Group   KG    Primary    Secondary       High    University    General 
Number Up to 30 
Time required 30 minutes 
Time to implement Throughout the year 
Place to implement Indoor     Outdoor  
Materials used Cards: described components of mangrove ecosystem such as 

mangroves, fish, crab, bird, and etc. (refer to the photos below) 
Brochure: Importance of mangrove ecosystem (Use material No.2 in the 
attached CD) 

Goal of the Activity Learn about the mangroves and mangrove ecosystem through the 
nature game, especially relationship among the components. 

 

 

b) Timetable 

Timetable (Nature Game) 
Time Activity Description Materials 

09:00 – 09:05 Introduction of 
game method 

Providing a card to participants 
and explaining method of the 
game. 

Cards of mangrove 
ecosystem components 

09:05 – 09:20 Conducting role play 
game 

Explaining the relationship 
among the ecosystem 
components. 

- ditto - 

09:20 – 09:30 Reviewing Explaining the mangrove 
ecosystem based on the 
brochure. 

Brochure 

 
 
c) Photographs of the activity 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Sample of the cards Role play game with the cards 
 

Photographs of the activity (Nature Game) 
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2. Nature game: Searching cards 
a) Activity Sheet 

Activity sheet (Nature game) 
ITEM DESCRIPTION 
Name of Activity Searching cards on Mangrove Ecosystem 
Category of Activity Nature Game 
Target Group   KG    Primary    Secondary       High    University    General 
Number Up to 30 
Time required 30 minutes 
Time to implement Throughout the year 
Place to implement Indoor     Outdoor  
Materials used Cards: written a word to make a sentence which describes the 

characteristics of mangroves and mangrove ecosystem (refer to the 
photos below). 
Brochure: Importance of mangrove ecosystem (Use material No.2 in the 
attached CD) 

Goal of the Activity Learn about the mangroves and mangrove ecosystem through the 
nature game. 

   

 

b) Timetable 

Timetable (Nature game) 
Time Activity Description Materials 

09:00 – 09:05 Introduction of 
game method 

Explaining method of the game.  

09:05 – 09:20 Conducting 
searching cards 
game 

Searching cards in the field to 
make a sentence. 

Cards describing mangroves 
and mangrove ecosystem 

09:20 – 09:30 Reviewing Explaining the mangrove 
ecosystem based on the 
brochure. 

Brochure 

 

 

c) Photographs of the activity 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Searching cards and making a sentence Completed sentence with the cards 
 

Photographs of the activity (Nature game)  
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3. Card puzzle 
4.Jigsaw puzzle 

 

a) Activity sheet 

Activity sheet (Card puzzle) 
ITEM DESCRIPTION 
Name of Activity Card Puzzle 
Category of Activity Game 
Target Group    KG    Primary    Secondary       High    University    General 
Number Up to 30 
Time required 30 minutes 
Time to implement Throughout the year 
Place to implement Indoor     Outdoor  
Materials used Game: Photo cards of bird, fish, and crab in mangrove forests will be cut 

into 5 to 10 pieces (Use material No.10 in the attached CD). 
Goal of the Activity Learn about creatures in mangrove forests through playing the game. 
 
 
b) Timetable 

Timetable (Card puzzle) 

Time Activity Description Materials 
09:00 – 
09:05 

Introduction of 
game method 

Showing a photo card to 
participants and explaining 
method of the game. 

Game 

09:05 – 
09:20 

Playing the card 
puzzle game 

Completing a photo by 
combining each piece of the 
photo card. 

- ditto - 

09:20 – 
09:30 

Reviewing Explaining the name and 
characteristics of the creature 
shown on the photo card. 

- ditto - 

 
 
c) Photographs of the activity 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

A photo card cut in pieces A completed photo card 
 

Photographs of the activity (Card puzzle) 
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5. Field bingo 
a) Activity sheet 

Activity sheet (Field bingo) 
ITEM DESCRIPTION 
Name of Activity Field Bingo 
Category of Activity Game 
Target Group KG    Primary     Secondary     High    University    General 
Number Up to 30 
Time required 30 minutes to 1 hour 
Time to implement Throughout the year (except for summer season) 
Place to implement X  Indoor     Outdoor  
Materials used Game: Field bingo (Type 1, Type 2, and Type 3 (Use material No.9 in the 

attached CD)) 
Brochure: Importance of mangrove ecosystem (Use material No.2 in the 
attached CD) 

Goal of the Activity Learn about the mangroves and mangrove ecosystem by observation 
through conducting the field bingo game. 

 

 

b) Timetable 

Timetable (Field bingo) 

Time Activity Description Materials 
09:00 – 
09:10 

Introduction of game 
method 

Providing a field bingo card to 
participants and explaining 
method of the game. 

Game 

09:10 – 
09:40 

Conducting bingo 
game 

Try to find mangrove ecosystem 
components which are listed on 
the bingo card. 

- ditto - 

09:40 – 
09:50 

Reviewing Explaining the mangrove 
ecosystem based on the 
brochure. 

Brochure 

 
 
c) Photographs of the activity 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Example of the field bingo card Playing bingo game with the card 

 
Photographs of the activity (Field bingo)  
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6. Mangrove quiz 
a) Activity sheet 

Activity sheet (Mangrove quiz) 
ITEM DESCRIPTION 
Name of Activity Mangrove Quiz 
Category of Activity Quiz 
Target Group   KG    Primary    Secondary    High    University    General 
Number Up to 30 persons 
Time required 30 minutes 
Time to implement Throughout the year 
Place to implement Indoor     Outdoor  
Materials used Game: Mangrove quiz (Arabic and English version (Use material No.8 

in the attached CD)) 
Brochure: Importance of mangrove ecosystem (Use material No.2 in the 
attached CD) 

Goal of the Activity Learn about the mangroves and mangrove ecosystem through the 
quiz. 

 

 

b) Timetable 

Timetable (Mangrove quiz) 

Time Activity Description Materials 
09:00 – 
09:05 

Brief explanation of 
Mangrove quiz 

Explaining that the quiz 
covering mangroves and 
mangrove ecosystem. 

 

09:05 – 
09:20 

Conducting Mangrove 
Quiz 

Selecting any card (from No.1 
to No.10) and let participants 
answer the quiz. 

Game 

09:20 – 
09:30 

Reviewing Explaining the mangrove 
ecosystem based on the 
brochure. 

Brochure 

 
 
c) Photographs of the activity 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Mangrove quiz cards Participants answer the question 
 

Photographs of the activity (Mangrove quiz) 
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7. Bird watching 
a) Activity sheet 

Activity sheet (Bird watching) 
ITEM DESCRIPTION 
Name of Activity Bird watching 
Category of Activity Nature observation 
Target Group KG    Primary     Secondary     High    University    General 
Number Up to 30 
Time required 30 minutes to 1 hour 
Time to implement Throughout the year (except for summer season) 
Place to implement X  Indoor     Outdoor  
Materials used Field guide: Animals of mangrove forest in Oman (Use material No.11 in 

the attached CD) 
Binoculars, Telescopes 
Brochure: Importance of mangrove ecosystem (Use material No.2 in the 
attached CD) 

Goal of the Activity Learn about birds in the mangrove forest by observation in the field. 
 
 
b) Timetable of the activity 

Timetable (Bird watching) 

Time Activity Description Materials 
09:00 – 
09:10 

Introduction of the 
method of bird 
watching 

Providing the common birds list 
of participants and explaining 
the method. 

Field guide 

09:10 – 
09:40 

Conducting bird 
watching 

Watching birds at the tidal flat 
area, and checking the name of 
birds. 

Field guide 
Binoculars and telescopes 

09:40 – 
09:50 

Reviewing Explaining the mangrove 
ecosystem based on the 
brochure. 

Field guide 
Brochure 

 
 
c) Photographs of the activity 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Bird watching with a telescope      Searching a bird using the bird list 
 

Photographs of the activity (Bird watching) 
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8. Fish catching 
a) Activity sheet 

Activity sheet (Fish catching) 
ITEM DESCRIPTION 
Name of Activity Fish catching 
Category of Activity Nature observation 
Target Group    KG     Primary     Secondary    High    University    General 
Number Up to 30 
Time required 30 minutes 
Time to implement Throughout the year 
Place to implement X  Indoor     Outdoor  
Materials used Fish cage, food for fish (i.e. bread), seine net (optional) 

Field guide: Animals of mangrove forest in Oman (Use material No.11 in 
the attached CD) 

Goal of the Activity Knowing about aquatic fauna of mangrove forest 
 
 
b) Timetable 

Timetable (Fish catching) 

Time Activity Description Materials 
09:00 – 09:05 Introduction of the 

method 
Explaining the method. Fish cage and food for fish 

09:05 – 09:20 Catching fish by the 
cage 

Explaining the characteristics of 
fish caught in the cage. 

- ditto - 

09:20 – 09:30 Reviewing Explaining the mangrove 
ecosystem based on the photo 
list. 

Field guide 

 

 

c) Photographs of the activity 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Cage for catching fish Catching fish by the cage 
 

Photographs of the activity (Fish catching) 
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9. Mangrove cultivation in a plastic bottle 
a) Activity sheet 

Activity sheet (Mangrove cultivation) 
ITEM DESCRIPTION 
Name of Activity Mangrove cultivation in a plastic bottle 
Category of Activity Growing mangroves 
Target Group    KG     Primary     Secondary    High    University    General 
Number Up to 30 
Time required 30 minutes 
Time to implement July – September (when seeds are available) 
Place to implement   Indoor   X Outdoor  
Materials used Plastic bottle (1.5L) and seeds of mangrove 
Goal of the Activity Growing a mangrove seedling by hydroponics using a plastic bottle to know 

about mangroves. 
 
 
b) Timetable 

Timetable (Mangrove cultivation) 

Time Activity Description Materials 
09:00 – 09:05 Introduction of the 

method 
Explaining the method.  

09:05 – 09:20 Cutting plastic bottle Cut a plastic bottle as shown in 
the photo, and place a 
mangrove seed. 

Plastic bottle (1.5L) and 
seeds of mangrove 

09:20 – 09:30 How to grow 
mangrove 

Explaining important points to 
grow mangrove in plastic pot. 

 

 
 
c) Photographs of the activity 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Planting a mangrove seed in a bottle Growing a mangrove seedling in a bottle 
 

Photographs of the activity (Mangrove cultivation) 
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10. Drawing competition 
  not prepared 

 

11. Introduction of mangroves and mangrove ecosystem (1) 
a) Activity sheet 

  Activity sheet (Introduction of mangroves and mangrove ecosystem) 
ITEM DESCRIPTION 
Name of Activity Introduction of mangroves and mangrove ecosystem 
Category of Activity Nature observation 
Target Group    KG     Primary     Secondary    High    University    General 
Number Up to 30 
Time required 30 minutes 
Time to implement Except for summer 
Place to implement   Indoor     Outdoor  
Materials used Poster: Food chain in mangrove ecosystem (Use material No.3 in the 

attached CD) 
Brochure: Importance of mangrove ecosystem (Use material No.2 in 
the attached CD) 
Field guide: Animals of mangrove forest in Oman (Use material No.11 in 
the attached CD) 

Goal of the Activity Understanding mangroves and mangrove ecosystem. 
 
 
b) Timetable 

Timetable (Introduction of mangroves and mangrove ecosystem) 

Time Activity Description Materials 
09:00 – 09:10 Introduction of 

mangrove 
ecosystem 

Explaining mangroves and 
mangrove ecosystem 

Poster 
Brochure 

09:10 – 09:25 Observing mangrove 
forest 

Observing mangrove forest 
through board walk 

Field guide 

09:25 – 09:30 Reviewing Explaining the mangrove 
ecosystem based on the photo 
list. 

 

 
c) Photographs of the activity 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Explanation of the food chain               Observing mangrove forest through board walk 
Photographs of the activity (Introduction of mangroves and mangrove ecosystem) 
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11. Introduction of mangroves and mangrove ecosystem (2) 
a) Activity sheet 

Activity sheet (Introduction of mangroves and mangrove ecosystem) 
ITEM DESCRIPTION 
Name of Activity Introduction on mangrove ecosystem 
Category of Activity Lecture in the field at QNR 
Target Group KG    Primary    Secondary    High    University    General 
Number Preferably less than 20 participants 
Time required 45-60 minutes 
Time to implement Throughout the year 
Place to implement  X Indoor     Outdoor  
Materials used Panels: Introduction on mangrove ecosystem (Use material No.14 in the 

attached CD) 
Fish catching equipment  
Field guide: Animals of mangrove forest in Oman (Use material No.11 in 
the attached CD) 
Brochure: Importance of mangrove ecosystem (Use material No.2 in the 
attached CD) 
Video (optional): Wonder trees in the sea (Use material No.15 in the 
attached CD) 

Goal of the Activity To learn about the basics of mangrove and mangrove ecosystem 
 
 
b) Timetable 

Timetable (Introduction of mangroves and mangrove ecosystem) 

Time Activity Description Materials used 
15 minutes 
 
 

Explanation of 
mangrove tree  

Explain the following using panels at the 
shed or boardwalk 
- What is mangrove? 
- Adaptations to low oxygen conditions 
- Adaptation to high salinity 
- Reproduction methods 

Panels 1, 2, 3, 4 
of material No.14 in 
the attached CD 

15 minutes 
 
 
 

Explanation of 
mangrove 
ecosystem  

Explain the following using panels at the 
boardwalk 
- Common mangrove fauna (e.g. fish, 

crabs, birds and others) and their 
characteristics 

- Mangrove food chain 

Panels 5, 6, 7, 8, 9 
of material No.14 in 
the attached CD 

15 minutes 
 
 

Catching of fish (if 
high tide) 

Catch fish at the boardwalk using fish 
cage and show it with portable aquarium  

Fish cage, small hand 
net, bucket, 
aquarium 
Field guide 

15 minutes Explanation of 
benefits and 
threats to 
mangrove 
ecosystem 

Explain the following using panels at the 
shed 
- Why conserve the mangrove 

ecosystem 
- Threats to mangrove ecosystem 

Panels 10, 11 
of material No.14 in 
the attached CD 
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12. Introduction of mangrove nursery 
a) Activity sheet 

Activity sheet (introduction of mangroves nursery) 
ITEM DESCRIPTION 
Name of Activity Introduction of mangrove nursery 
Category of Activity Growing mangroves 
Target Group    KG     Primary     Secondary    High    University    General 
Number Up to 30 
Time required 30 minutes 
Time to implement Except for summer 
Place to implement X Indoor     Outdoor  
Materials used Poster: Mangrove forests in Oman (Use material No.4 in the attached 

CD) 
Posters: (Use material No.5-7 in the attached CD, optionally) 

Goal of the Activity Knowing how to plant mangrove seedlings. 
 

 

b) Timetable 

Time table (introduction of mangroves nursery) 

Time Activity Description Materials 
09:00 – 09:10 Introduction of 

mangrove forests in 
Oman 

Explaining mangrove forests in 
Oman 

Poster 

09:10 – 09:20 Observing mangrove 
nursery 

Observing mangrove nursery to 
understand how to grow 
mangrove seedling 

 
 
 

 
 

c) Photographs of the activity 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Explanation of mangrove forests in Oman Visiting the mangrove nursery at QNR 
 

Photographs of the activity (Introduction of mangroves nursery) 
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13. Mangrove plantation 
a) Activity Sheet 

  Activity sheet (Transplantation of mangrove seedlings) 
ITEM DESCRIPTION 
Name of Activity Transplantation of mangrove seedlings 
Category of Activity Growing mangroves 
Target Group    KG     Primary     Secondary    High    University    General 
Number Up to 30 
Time required 30 minutes 
Time to implement Except for summer 
Place to implement X Indoor     Outdoor  
Materials used Brochure: Basic procedure of mangrove seedling transplanting (Use 

material No.1 in the attached CD) 
Goal of the Activity Knowing how to plant mangrove seedlings. 
 
 
b) Timetable 

Timetable (Transplantation of mangrove seedlings) 

Time Activity Description Materials 
09:00 – 09:10 Introduction of 

transplantation 
method 

Explaining important points to 
be followed in transplanting 
mangrove seedlings 

Brochure 

09:10 – 09:20 Moving to 
transplanting site 

Moving to transplanting site 
with mangrove seedlings 
 

Mangrove seedlings 
 

09:20 – 09:30 Transplanting 
mangrove seedlings 

Transplanting mangrove 
seedlings at the site. 

Mangrove seedlings 
 

 
 
 
c) Photographs of the activity 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Delivering mangrove seedlings Transplanting mangrove seedlings 
 

Photographs of the activity (Transplantation of mangrove seedlings) 
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14. Observation of planted seedlings  
  not prepared 

 

15. Cleaning 
a) Activity sheet 

Activity sheet (Cleaning of mangrove plantation site) 

ITEM DESCRIPTION 
Name of Activity Cleaning of mangrove plantation site 
Category of Activity Nature conservation 
Target Group    KG     Primary     Secondary    High    University    General 
Number Up to 30 
Time required 30 minutes 
Time to implement Except for summer 
Place to implement X Indoor      Outdoor  
Materials used Plastic bags, plastic gloves 
Goal of the Activity Maintaining a growing environment of mangroves. 
 
 
b) Timetable 

Timetable (Cleaning of mangrove plantation site) 

Time Activity Description Materials 
09:00 – 09:05 Distributing plastic 

bags and groves 
Explaining the method. Plastic bags, plastic gloves 

09:05 – 09:20 Picking up garbage Picking up garbage at the 
planting site. 

- ditto - 

09:20 – 09:30 Reviewing a) Classifying the picked up 
garbage and examining from 
where do they come. 
b) Weighing the garbage for 
competition. 

 

 
 
c) Photographs of the activity 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Cleaning of mangrove forest at QNR Group photo after the cleaning activity 
 

Photographs of the activity (Cleaning of mangrove plantation site) 
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16. Mangrove monitoring 
a) Activity sheet 

Activity sheet (Mangrove monitoring) 

ITEM DESCRIPTION 
Name of Activity My-tree monitoring program 
Category of Activity Field work at QNR 
Target Group KG    Primary    Secondary    High    University    General 
Number Around 20 participants 
Time required 60 minutes 
Time to implement Throughout the year 
Place to implement  X Indoor     Outdoor  
Materials used Tree measure, tape measure, tree tag 

Field note and certificate (Use material No.16 in the attached CD) 
Goal of the Activity To learn the mangrove monitoring method as well as to follow-up 

growth status 
 

 

b) Timetable 

Timetable (Mangrove monitoring) 

Time Activity Description Materials used 
10 minutes 
 
 

Explanation of 
monitoring method  

- Explain how to measure tree height 
and trunk circumference.  

- Explain how to check tree health. 

Tree measure, tape 
measure, field 
note, tree tag 

15 minutes 
 
 

Selection of tree - Split the group into groups of three.  
- Each group will select a tree and name 

it. 

 

20 minutes 
 
 

Measure tree 
height and trunk 
circumference 

- Measure tree height and trunk 
circumference and fill in the field 
sheet. Also tag the tree. 

- Assess tree health and fill in the field 
sheet. 

 

15 minutes Issue my-tree 
certificate 

- Distribute certificate Certificate 
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Three types of feedback sheets are stored in the attached CD.

Feedback Sheet (1) : Questionnaire type
Feedback Sheet (2) : Sign board type
Feedback Sheet (3) : Quiz type
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1. Reports of the Environmental Education Program conducted with the Project 
1.1 Report of the Environment Education Program on the World Wetlands Day 2012 

An environment education program was carried out on the occasion of the World Wetlands 
Day by MECA with the participation of Ministry of Tourism on the 6

th
 February, 2012 at the QNR 

(Qurm Nature Reserve). More than 200 of students from different schools were invited to the 
event, consisting of Indian School, Philippine School, International School, and orphanage 
supported by the Ministry of Social Development. The event activities included lecture about 
mangroves and their ecosystem, observation of nursery and QNR (through board walk), 
transplanting mangrove seedlings, and nature games. The approximate timetable of the event 
was as follows; 

Time Activity Remarks 

08:30 Arriving at QNR（Indian & Philippine School）  

09:15 – 09:20 Opening Speech（Mr. Ali Kiyumi）  

09:20 - Lecture on mangroves and their ecosystem, 

observation of nursery and QNR. 

Dr. Ahmed, Mr. Bader, and Ms. Aida guided the 

students. 

09:50 Transplanting mangrove seedlings. Each student was provided a mangrove seedling, 

and each of them experienced the transplantation. 

10:30 Taking group photos.  

10:40 - Break Snacks, water, soft drinks were served. 

11:05 - Nature game (1):   Understanding mangrove 

ecosystem through card game. 

Conducted by Ms. Aida. 

11:35 – Nature game (2): Making a sentence by 

composing words written on pieces of board. 

 

Conducted by Ms. Aida. 

“Mangrove forests provide a nursery for lobsters, 

crabs and oysters.” 

11:50 – Coloring drawings. Wetland drawings prepared by the Ramsar Center. 

12:15 Closing.  

 
【【【【Comments on the Event】】】】 
� In spite of having big number of students in the event, the facilitators controlled the 

participants quite good manner, and the event was well-organized. 
� Two kinds of nature game were conducted, which were very interested and gave impressive 

impact to the participated students. 
� It would be necessary to evaluate impact of the event in some way, therefore a 

questionnaire was given to some of the participants. The result of the questionnaire survey is 
attached to this report as an annex. 

� After closing the event, workers collected containers of snack and drink which were littered 
by the participants. This kind of event is also good occasion to teach children not to litter 
rubbish but to put it in the wastebasket, in order to save our environment.  

� Similarly, polyethylene bags for seedlings were left at the transplanting site, which shall be 
collected by the participated students, not by workers. 
(Note: When they had another transplantation event at the QNR later, they asked to the 
participated students to collect the polyethylene bags in a garbage bag.) 

 
【【【【Photographs of the World Wetlands Day Event】】】】 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Opening speech by Mr. Ali Kiyumi       Philipino students at the mangrove nursery 
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Observing mangrove forest through board walk Delivering mangrove seedling to students 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

Transplanting mangrove seedlings Group photo at the transplanting site 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Nature game on mangrove ecosystem (1) Nature game on mangrove ecosystem (2) 

 

 
1.2 Questionnaire Survey on the World Wetlands Day Event 
a) Background of the survey 

On the occasion of the world wetlands day, MECA (Ministry of Environment and Climate 
Affairs) invited students of different schools in Muscat to an environment education program at 
the QNR (Qurm Nature Reserve) on February 6, 2012. The program included various activities for 
the students focusing on wetlands and mangrove ecosystem. A questionnaire survey was carried 
out to identify the impact of the event on the participated students. This brief report describes 
the result of the questionnaire survey. 
 

b) Respondents of the survey 
a) Name of the School: Philippine School, Muscat, Oman 
b) Total number of the respondents: 29 
c) Age: 

Age 15 16 17 18 TOTAL 

Number 8 18 2 1 29 
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d) Sex: 
Sex Female Male 

Number 13 15 

e) Nationality: 
Nationality Filipino Filipino-Indian Omani Iraqi Thai 

Number 23 3 1 1 1 

 
c) Results of the survey 
Q1.  Was the wetland day event interesting for you? 

Almost all of them answered “yes” to the question 1.  
Answer Yes No  Answer Yes No 

    Sex Female Male Female Male 

Number 28 1  Number 13 14 0 1 

 

The major reasons are mentioned with the number of answers as follows; 
- Because it was interesting. (It was fun / Planting plants was fun.) 7 
- Because it is my first time to plant mangrove. 5 
- Because I learned new things about mangroves. 5 
- Because we learned something about mangrove plantation. 5 
- Because I learned a lot. 5 
- Because I had learned some very valuable information. 1 

 
Q2.  Have you got something new from the event? 

Most of them got something new, namely 24 students (83%) answered “yes”. 
Answer Yes No  Answer Yes No 

    Sex Female Male Female Male 

Number 24 5  Number 13 11 0 4 

 

The major points which they got from the event are as follows;; 
- I learned about mangroves. 8 
- How to plant mangroves and how they live. 6 
- I learned new things and gained new experience. 4 
- I learned many things. 4 
- T-shirt & cap. 4 
- I learned that Qurm means Mangrove. 2 
- The kind of plant it was and the salt from water going to the leaves. 1 
- Maybe. 1 

 
Q3. Did you find anything to be modified in order to improve the event? 

Most of them seemed to be satisfied with the event, and 20 students (69%) answered “no”. 
Answer Yes No  Answer Yes No 

    Sex Female Male Female Male 

Number 8 20  Number 3 5 9 10 

 

According to their opinion, the points to be improved are as follows; 
- Provide boots next time. 3 
- It would have been better if we were providing with protective gloves. 1 
- If you don’t mind to modify the way / road. 1 
- Field trips to mangrove must be organized. 1 
- The lake on the nipa hut is not clean. 1 
- More workers to help expand the event. 1 
- Because the event was really organized so there’s no need for improvement. 1 

 
Q4. Do you want to do something to conserve wetland/mangrove ecosystem in Oman? 

Most of them want do something, and 23 students (79%) answered “yes”. 
Answer Yes No  Answer Yes No 

    Sex Female Male Female Male 

Number 23 6  Number 12 11 1 4 

 

The followings are the details which they want to do; 
- Plant more Mangroves. 7 
- I’d like to join other environment campaigns about mangrove ecosystem and others. 5 
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- I would like to help. 4 
- Conserve wetlands with the others. 3 
- Inform people about mangroves. 1 
- Preserve the water. 1 
- Because it was fun. 1 
- Because it also helps our nature to be balance. 1 
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2. Report on the Environment Education Program on the World Wetlands Day 2013 
 

An environment education program was carried out on the occasion of the World Wetlands 
Day on the 2

nd
 of February, 2013 at the QNR. Some 80 participants from different schools were 

invited to the event, consisting of Dorat Al Khaleeji school, orphanages supported by the Ministry 
of Social Development, and students of SQU. The event was observed by the minister of MECA, 
and the counselor and the secretary of the Japanese Embassy. The event activities included 
lecture about mangroves and mangrove ecosystem, observation of nursery and QNR through 
board walk, transplanting mangrove seedlings, cleaning the reserve, bird watching, and drawing 
& coloring. The approximate timetable of the event was as follows; 

Time Activity Remarks 

08:30 Arriving of participants to QNR  

09:15 – 09:20 Orientation of the today’s Program (Mr. Bader) 

Opening Speech (Dr. Ahmed Al Saidi) 

 

09:20 - Lecture on mangroves and their ecosystem, 

observation of nursery and QNR. 

Ms. Aziza and Mr. Bader guided the participants. 

09:50-10:30 Bird Watching Participated children were instructed by Mr. 

Waheed, Diwan’s wildlife biologist. 

10:30-11:00 Transplanting mangrove seedlings. 

Cleaning the nature reserve. 

Each student was provided a mangrove seedling, 

and each of them experienced the 

transplantation. 

11:00-11:30 Drawing and coloring pictures. Conducted by Ms. Aida and Ms. Aziza. 

11:30 - Break Snacks, water, soft drinks were served. 

11:45 Closing  

 
 
【【【【Notes on the Event】】】】 

� The number of the participants was around 80 which was smaller than the last year’s event, 
so the facilitators were able to control the participants in good manner, and the event was 
well-organized. 
 

� Bird watching was instructed by Mr. Waheed, Diwan wildlife biologist, and common birds list 
was prepared prior to the activity. In addition, purchased equipment (such as telescope and 
binoculars) was effectively used in the activity. Because of all these well-arrangement, the 
bird watching activity was successful, and the participants learned and enjoyed a lot. 

 
� Some of the education materials such as field bingo, mangrove quiz, and puzzle, were not 

used because of time shortage. The contents of program and their time allocation shall be 
discussed more carefully before conducting the event. 

 
� At the break, snacks and drinks were provided to the participants. Many of the children put 

rubbish in the wastebasket by themselves, which was good action to save our environment. 
 

【【【【Photographs of the World Wetlands Day Event】】】】 

 
 
 
 
 
 
 
 
 
 
 
 
 

 Opening speech by Dr. Ahmed Al Saidi  Explanation of mangrove nursery by Ms. Aziza 
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Observing mangrove forest through board walk Group photo at the mangrove forest 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Bird watching at the tidal flat (Ms. Aida) Explaining the activity to the Minister (Mr. Badar) 

 

 
 
 
 
 
 
 

ing mangrove seedlings 

 

 
 
 
 
 

Transplanting mangrove seedlings Cleaning the nature reserve 
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3. Environmental Education Programs for School Children at Duqm 

3.1 Environmental Education Program for at the Durf transplanting site 
Date: May 15, 2013 
Time: 8:30 - 9:30 am 
Target Group: School children of Al Shamukh school 
Number of Participants: 4 elementary school boys and 9 secondary school girls  
Persons in Charge: Bader, Aida, Aziza, and Koto 

 
� An environmental education program was conducted at Durf transplanting site with inviting 

school children of AsShamukh school. 
� The contents of the program were introduction of mangroves, transplanting of mangrove 

seedlings and bird watching. 
� A brochure of “Basic procedure of mangrove seedling transplanting” was delivered to the 

participated children, and important points of transplanting were explained to them. 
� The brochure with lots of illustrations was understandable for the school children, which was 

useful to them to conduct the transplanting in proper way. 
 
3.2 Environmental Education Program for at Al Shamukh school 

Date: May 16, 2013 
Time: 8:10 - 9:30 am 
Target Group: School children of Al Shamukh school 
Number of Participants: 20 boys and 35 girls 
Persons in Charge: Bader, Aida, Aziza, and Koto 

 
� An environmental education program was conducted at AsShamukh school, on the next day 

of the transplanting activity at Durf. 
� The contents of the program were explanation of mangroves and mangrove ecosystem (by 

using PPT presentation by Ms. Aida; 10 minutes), showing a mangrove movie prepared by 
MECA, and questions and answers about mangroves. 

� Reactions from the participants; Some of the school children said the program was 
interesting and informative. The brochure of transplanting procedure was easy to understand. 
It was the first time to know about mangroves, and it is necessary to plant more mangroves. 
Some of the students said more school visit is required. 
 

 
[ Durf transplanting site] 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 

 Environmental Education at Durf    Bird watching at Durf 
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 Holding a mangrove seedling as instructed  Transplantation at the Durf site 

 
[ As Shamukh School ] 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Presentation on mangrove by Ms. Aida Q&A on mangrove 
  
 
 
 
 
 
 
 
 
 
 
 
 
 

Presenting a memorial gift As Shamukh School 

 

  



Appendix 4 Record of environmental education programs conducted through the Project 

9 

4. Environmental Education Program for Al Bustan Palace Hotel Staff 

Date: November 11, 2013 (Monday) 
Time: 8:00 - 10:45 am 
Target Group: Staff of Al Bustan Palace Hotel 
Number of Participants: 11 
Persons in Charge: Bader, Harada, and Koto 
 

Time Activity Education Materials used 

08:10 am Arrival  

08:20 Explanation of Mangrove Forests in Oman Poster: Mangrove Forests in Oman 

08:30 Distributing brochure and photo sheet Brochure: Mangrove Ecosystem 
Photo sheet: Animals of Mangrove Forest in Oman 

08:40 Explanation of mangroves and mangrove 
ecosystem 

Poster: Food Chain in Mangrove Ecosystem, 

08:55 Observing Mangrove Nursery  

09:10 Observing Mangrove Forest through Board 
Walk 

 

09:20 Moving to Mangrove Planting Site  

09:30 Bird Watching Photo sheet: Animals of Mangrove Forest in Oman 

09:40 Cleaning  

09:52 Group Photo  

10:00 Transplanting Mangrove Seedlings  

10:15 Feedback Feedback sheet 

10:45 Leaving QNR  

 
Education Materials Used: 
1) Poster: Mangrove Forests in Oman 
2) Poster: Food Chain of Mangrove Ecosystem 
3) Mangroves in the Sultanate of Oman (MECA) 
4) Brochure: Importance of Mangrove Ecosystem 
5) Photo sheet: Animals of Mangrove Forest in Oman 
6) Feedback sheet (Questionnaire) 
 
 
4.1 Results of the Questionnaire Survey 
 
a) Please rate today’ activity. 

 Excellent Good OK Poor Very poor 

Activity 10 0 0 0 0 
Venue 9 1 0 0 0 
Staff 10 0 0 0 0 
Date 9 0 1 0 0 
Time 9 0 1 0 0 
 

b) Please describe the today’s activity in a simple word or sentence. 

Very informative 2 
First time to see / to plant mangrove 2 
Great time 2 
Unforgettable 1 
Interesting 1 
Beneficial 1 
Learning 1 
Presentation, walk the forest, visit the nursery, clean the forest, bird watching and  1 
Planting mangroves 

 
c) What was the most interesting for you? 

Bird watching 3 
Seeing different species (birds and crabs) 1 
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Transplanting mangrove tree 2 
Nursering / growing mangrove tree 2 
Presentation  2 
Knowing how mangrove grows 1 
A lot of activity 1 
The location in middle of big city. 1 
Enjoyed with family 1 

 
d) Did you find anything to be modified in order to improve the activity? 

No 9 
All is great / All great (2) 
Yes, Add more activities and venue of activity 1 

 
 
e) Do you want to attend this activity again in the future? 

Yes 10 
   on regular basis 
   for sure always 
   for sure 
   I like to get more information about this 
No 0 

 
 
f) Information on the participants 

Age 20s 30s 40s  Sex female male 

Number 3 5 2  Number 6 4 

 
Nationality Omani Sudanese Polish Slovakian Philipino Sri Lanka Korean 

Number 4 1 1 1 1 1 1 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Explanation of Mangrove Forests in Oman Distributing Brochure of Mangrove Ecosystem 
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Explanation of the Food Chain Visiting the Mangrove Nursery 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Observing Mangrove Forest    Bird Watching 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Group Photo after Cleaning Activity Feedback of the program 
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5. Environmental Education Program for 1
st

 Oman Cub Scouts 

Date: October 30, 2013 
Time: 16:30 - 18:00 
Target Group: Cub Scouts Children 
Number of Participants: around 30 
Persons in Charge: Bader, Harada, and Koto 

Based on the request from the 1st Oman Cub Scouts on September 28, 2013, an 
environmental education program on mangroves and mangrove ecosystem was prepared and 
conducted on October 30, 2013. The number of participants was around 30 cub scout children 
aged from 8 to 10, and around 15 teachers and parents of the participated children. The 
timetable of the program along with the education materials used is shown as below; 

Time Activity Education Materials used 

04:15 pm Arrival  

04:35 Taking attendance  

04:40 Explanation of mangroves and mangrove 
ecosystem 

Poster on food chain in mangrove 
ecosystem, 
Photo sheet of animals in mangrove forest 

04:50 Observing mangrove forest through board 
walk 

 

04:55 Fish catching Fish cage 

05:10 Field bingo game Field bingo card 

05:20 Nursery  

05:30 Feedback Feedback sheet and stickers 

05:40 Observing planting site of mangrove seedlings  

06:00 Leaving QNR  

 
Education Materials Used: 
1) Poster: Food Chain of Mangrove Ecosystem (for children) 
2) Photo sheet: Animals of Mangrove Forest in Oman 
3) Field Bingo Card 
4) Feedback board (for children) 
 
 

Based on the steps to prepare environmental education program, suitable program modules 
were selected according to the target group, objective, time and request from the participants. 
Then, the program was formulated with timetable and necessary education materials to be used. 
It was good opportunity to share the idea of these steps among Omani counterparts and 
Japanese experts. 

As one of the method of feedback for children, putting-a-sticker method was examined 
instead of the questionnaire method. Each participant placed a sticker to the most favorite 
activity among the program, and number of the stickers showed which activity they liked. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Welcoming the participants Explanation of the Food Chain  
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Explanation of animals in mangrove forest Observing mangrove forest with photo sheet 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fish catching Filling bingo card 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Observing mangrove nursery Feedback of the program 
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6. Environmental Education Program for HTC, Ministry of Manpower 

Date: November 11, 2013 (Monday) 
Time: 12:30 - 14:10 am 
Target Group: Female Students of HTC 
Number of Participants: 21 
Persons in Charge: Bader, Mohammed, Harada, and Koto 

 
Time Activity Education Materials used 

12:35 Arrival  

12:40 Explanation of Mangrove Forests in Oman Poster: Mangrove Forests in Oman 

12:50 Distributing brochure and photo sheet Brochure: Mangrove Ecosystem 
Photo sheet: Animals of Mangrove Forest in Oman 

13:00 Explanation of mangroves and mangrove 
ecosystem 

Poster: Food Chain in Mangrove Ecosystem, 

13:05 Explanation of equipment for soil & water 
monitoring 

 

13:10 Observing Mangrove Nursery  

13:25 Observing Mangrove Forest through Board 
Walk 

 

13:45 Feedback Feedback sheet 

13:55 Bird Watching Photo sheet: Animals of Mangrove Forest in Oman 

14:10 Leaving QNR  

 
Education Materials Used: 
1) Poster: Mangrove Forests in Oman 
2) Poster: Food Chain of Mangrove Ecosystem 
3) Mangroves in the Sultanate of Oman (MECA) 
4) Brochure: Importance of Mangrove Ecosystem 
5) Photo sheet: Animals of Mangrove Forest in Oman 
6) Feedback sheet (Questionnaire) 
 
6.1 Results of the Questionnaire Survey 
a) Please rate today’ activity. 

 Excellent Good OK Poor Very poor 

Activity 15 6 0 0 0 

Venue 11 6 2 0 0 

Staff 16 5 0 0 0 

Date 11 5 3 2 0 

Time 7 8 3 1 2 

 

b) Please describe the today’s activity in a simple word or sentence. 

Very interesting 5 
Interesting 4 
Excellent 4 
Perfect 1 
Nice 3 
Get new / good knowledge 3 
Useful and important 1 
Amazing 1 
Visit and mangrove 1 
Conserving mangrove, conserving Oman 1 
Fun day 1 
Fantastic 1 
No Answer 3 

 
c) What was the most interesting for you? 

Irrigation system (watering) 8 
Movement of sea water  
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The way of cultivation  
How drinking of mangrove  

Living things 5 
    Living things part 
    See the mangrove trees and the animals which there like birds 
    Birds, animals 
    Snails and crabs 
    Mollusks 
New information about mangroves 3 
The function of mangrove roots 3 
Mangrove & presentation 1 
The interactive session with staff especially with the head Mr. Baloushi. 1 
How they make the place for this type of plant 1 
 

d) Did you find anything to be modified in order to improve the activity? 

No 13 
    Everything they did 
Yes 8 
    More walking beds to be built 
    More facility for visiting 

 
e) Do you want to attend this activity again in the future? 

Yes 21 
    I would love to come close to nature and be a part of this experience 
    To stay more time.  

100% 
No 0 
 

 
f) Information on the participants 

Age 22 23 24 31 33  Sex female Male 

Number 15 3 1 1 1  Number 18 3 

 
Nationality Omani Indian 

Number 20 1 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Explanation of Mangrove Forests in Oman Distributing Brochure of Mangrove Ecosystem 
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Explanation of the Food Chain Equipment for Soil & Water Monitoring 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Visiting the Mangrove Nursery Observing Mangrove Forest  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Feedback of the program  Bird Watching 


	Cover
	Contents
	Technical Document 1 Training plan and materials
	Technical Document 2 Mangrove Monitoring Guideline
	Appendix 1Guidelines for Mangrove Health Assessment usingRemote Sensing
	Appendix 2Calibration method of portable water quality meter
	Appendix 3Analysis procedure of COD and inorganic nutrientsusing HACH DR890 portable colorimeter

	Technical Document 3 Mangrove Plantation Guideline
	Technical Document 4 Mangrove Protection Guideline
	Technical Document 5 Guideline for Development of EnvironmentalEducation Program



